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Opas SAS Enterprise Guiden kayttajalle
Timo Hurme

MTT, Palveluyksikk®, Menetel mapalvelut, M-talo, 31600 Jokioinen, timo.hurme@mitt.fi

Tiivistelma

SAS Enterprise Guide on tilastollinen ohjelmisto, joka vaatii toimiakseen myos tavallisen
SAS-ohjelmiston. Enterprise Guide on helppokayttdinen vaihtoehto SAS-ohjelmiston mo-
nipuolisten ominaisuuksien hyddyntamiseen.

Enterprise Guidella voidaan muokata valikkopohjaisesti tutkimusaineistoa, piirtéa kuvia,
laskea kuvailevia tunnuslukuja ja tehda tilastollisia analyyseja. Téssa oppaassa tutustutaan
Enterprise Guiden kayttoympéristéon, datojen késittelyyn seké aineiston alustavaan tar-
kasteluun muun muassa kuvien jatilastollisten tunnuslukujen avulla.

Opas on suunnattu 1&hinnd maa- ja elintarviketalousalan tutkijoille ja muulle tutkimusvéa
elle. Siitd on kuitenkin varmasti hyotya kaikille SAS Enterprise Guiden kayttgjille.

Avainsanat: SAS Enterprise Guide, tilastollinen ohjelmisto, kuvaileva tilastotiede, aineiston tar-
kastelu




Sisallysluettelo

N o010 1= (o J TSPV 7
Oppaassa KAYEttAVEL Jatal...........ccooereererieee e 7
Enterprise Guiden KayttOYMPANSIO ........coveveeieieereeie e 9
ENterprise GUIAEN ONJE.........coiiiiieiieie ettt nee s 11
QLI [0S o T= £ 1 Y4 o L S 13
ATNEISLON KEYTEOONOLEO......c.eiieeeieeie ettt 13
6.1 Kirjastoviitteen TUOMINEN .......ccooiiiiiiieee e s 13
6.2 Kirjastoviitteen asettaminen OletUKSEKSI ..........cocvveereeiecieecece e 16
6.3 AINeiston talleNNUSMUOLO ..........ooeiiiiiiiiieeee e 16
6.4 Aineiston syottdminen Enterprise GUIAESSA. .......ccovevvereereerieeeeseeresee s e eee e 17
6.5 Excel-tiedoston avaaminen Enterprise GUIJEeN..........cocvvereereeieneeneene s 18
6.6 Erikoismuuttujien sisdan lukeminen jaongelmatapaukset ..........cccccveeveeeenveeeenne. 22
6.7 SAS-datan avaaminen Enterprise GUIAEEN...........ccccveeiieiiieecie e 24
6.8 Datojen tallentaminen Enterprise GUIAESIA ...........ceceeeerierenenenereeeeeee e 24
6.9 Projektin tallentaminen ... e 25
Datan MUOKKAUS.........cuiiueeieiiisiee sttt sttt sre e se et e sseesteeneesneens 26
7.1 Datan muuttaminen MUOKKaUSEHaan ...........ccceverirenininine e 26
7.2 Muuttujien perusominai SUUKSIEN MEANTEY ..., 27
7.3 Muuttujan arvojen tulostusmuotojen eli formaattien kéyttaminen...................... 27
7.4 Datan MUOKKaUKSEN TYOKAUL...........eoerereeieieiese s 30
7.5 Muuttujien muunnokset ja uusien muuttujien tekeminen............ccccceeeeeveerneeeenne. 32
7.6  Muuttujien luokittelu jaluokkien yhdiStaminen...........ccocceeeveeeveeceseneese e 35
7.7 Muuttujan luominen aritmeettisella operaatiolla............cccceveeevvevecceciecece 38
7.8 MUULEUJI€N POISTAIMINEN ...ttt bbb 39
7.9 Muuttujien jarjestyksen vaihtaminen datassa...........ccccveveeeereeiecieeseese e, 39
7.10 Datan havaintorivien jJArjeStAMINEN ... 39
7.11 Osa-aineiston eli tiettyjen havaintorivien valitseminen...........cccocceveeceveeveeeenne. 40
7.12 Kahden tai useamman datan yhdiStAmiNeN...........ccoeveririeieienenese e 42
7.13 Datan KEANTAMINEN .....c.oiveieieiieieese et st nre s 45
7.14 Muuta datojen Kasittelyyn [HITYVEEL..........cooeririiieeeree e 47



8

10

11

Datan tarkastelu Graph-valikon kuvatyokaluilla.............cccovvrieieninininieene e 48
8.1 Sirontakuvio (Scatter PIOL)......cceceeiieiecie e 49
8.2 PylvasKUVIO (Bar Chart)........ccooiriiiiiiieeeeseres e 51
8.3 ViIVaKUVA (LINE PAOL).....uiieeceece ettt 54
8.4 Laatikko-janakuvio (BOXPIOL) ........cceriririnireeieiee e 58
8.5 Piirakkakuvio (Pi€ Chart)........cccvcceiieieeie et 61
8.6 Wizard-KUVatyOKaIUL............coiiuiriiiiiesie sttt 61
8.7 Kuvien tulostusmuoto jayleisasetuKSeL .........c.ccveveciee e 68

Datan tarkastelu Describe- ja Analyze-valikoiden tyokaluilla............ccccevevevenennenne. 70
0.1 Datan [IStAUKSEL .......coruerieriiiiesieieee et ae b e 70
9.2 Datan luonnehdinta -tyokalu (Characterize Data)...........ccooevereeieeieeienenesesenins 72
9.3 Jatkuvan muuttujan jakauman tarkastelU..........ccceoveveieeiecce e 73

9.3.1 Distribution ANalySiS -tyOKalU.........cceriririeieieese e 73
9.3.2 Summary StatistiCS -tyOKalU.......ccueiveiieircie e 75
9.3.3 Summary Tables -tyOKalU..........cccuriririririeeeree e 77
9.3.4 Tunnuslukujen taulukointi wizard-tyokaluilla.............cccooveveveeiecnee. 79
9.4 Kategorisen muuttujan jakauman tarkastelu ..o 83
9.5 Kahden muuttujan yhteyden tarkastelUu..........c.cccevveieeieiiccececece e 85
9.5.1 Kahden numeerisen muuttujan valinen yhteys...........ccoveeeienenenieneneniens 85
9.5.2 Kahden kategorisen muuttujan valinen yhteys..........cccccveveeeceveeviecceecveenne. 89

SAS-KOOTiN KAYTLEMINEN ...ttt 92
10.1 Koodin kirjoittaminen Enterprise Guidessatai tuominen muualta....................... 92
10.2 Koodin generoiminen Enterprise GUIOESSAL..........coererererenieeieieseese e 92
10.3 Koodin tallentaminen SAS-KooditiedOStOON .........cccceverereriniieiene s 93

Tulostuksen japrojektin NalliNtaa............ooeieiiiiience e 9
11,1 TUIOSIUSBSEIUKSEL ......eveiieiieieie et sttt e nreens 9

11.1.1 TUlOStUSKONEEEN VAIINEAL......eeieeeeeeiecieeeee e 9
11.2.2 TUIOSIUSEY YN VAIINEAL. ..ot e 94
11.1.3 MUUL tUIOSEUSBSELUKSEL .........oiveeeeeiesieeie et 96
11.2 Yksittéisen tulosteen hallintaja jatkOKaytto ............ccccoveveveeieeieciee e 97
11.2.1 Kohteen jatyylin vaihtaminen yksittéiselle tulosteelle..........cccooevineene. 97
11.2.2 Yksittéisen tulosteen tallentaminen tiedostoon ...........cceveeeeereneneniennenn 98
11.2.3 Tulosteen tai datan siirtdminen toiseen ohjelmaan...........c.ccoceeeieiiienee 98
11.2.4Vamiin kuvan mUuokKaamingn............cceeeerierenenenesesesee e 99
11.2.5 Selitetekstien ja formaattien lisédminen yksittéiselle tulostedlle ............. 100

5



11.2.6 Otsikoiden ja alaviitteiden muokkaaminen............ccccecceveeveecececsieceee 100

11.3 Yksittéisten tulosten kokoaminen Yhteen ..........cccoveviverineeieie e 101
11.3.1HTML dOKUMENLE ..ottt 101
11.3.2 SAS RAPOIE ..ottt 102

11.4 Projektin Nallinta...........ceouviiiiiecece et 103
11.4.1 Projektin PEruSIOIMINNOL ........ccceivirieresiereeieeeee e 103
11.4.2 Projektin pitdminen jarjeStyKSESSA .......ccevveevieiieciere e 104
11.4.3 TehtAVASOIMUIEN KASITELY ........ooorveceeceeeeeeeseeese et essseneesnea 106

11.5 Makromuuttujat (Parameters) .........ccceeeeieeieciee s 107
11.5.1 Makromuuttujien MEENTTEEIY .........cccorerirerireeeeee e 107
11.5.2 Makromuuttujien KEYHamIiNeN .........cccoece e 110

11.6 VITRELTANLEEL ...ttt e 115

12 KIFAIISUUS. ...ttt bbb 115



1 Johdanto

Tama opas on suunnattu ensisijaisesti maa- ja elintarviketalousalan tutkijoille ja muulle
tutkimushenkilokunnalle. Léhestymistapa on sellainen, etta materiaali soveltuu erityisesti
aloitteleville SAS Enterprise Guiden (EG) kayttgjille. Opas perustuu suureltaosin MTT:lla
lukuisia kertoja pidettyjen Enterprise Guide peruskurssien kurssimateriaaleihin. Opas on
kuitenkin varmasti kayttokelpoinen myts muilla aloilla toimiville SAS Enterprise Guiden
kayttgjille seka hieman kokeneemmille EG-kayttgjille.

SAS Enterprise Guide on valikkopohjainen hiirell& ohjattava SAS-ohjelmiston kayttoliit-
tym4, joka madaltaa SASin kayttoonottokynnysta. EG:ssa hiirelld tehtévét valinnat gene-
roivat taustalla SAS-koodia, joka suoritetaan automaattisesti perinteisessi SASissa. Tulok-
set palautuvat esitettdvaks Enterprise Guidessa ja niiden ulkoasu noudattaa viimeisinta
SAS-tekniikkaa. Niinpa Enterprise Guide e ole itsendinen ohjelma, vaan se vaatii toimiak-
seen myos perus-SASIn. Tassd oppaassa kaytetddn SAS Enterprise Guiden versiota 4.1
yhdessd SAS 9.1.3:n kanssa. Enterprise Guide toimii ainoastaan Windows-ymparistossa, ja
téssa oppaassa raj oitutaan tilanteeseen, jossa molemmat — EG ja tavallinen SAS — on asen-
nettu samalle paikalliselle tietokoneelle (local).

Enterprise Guidella voidaan muokata valikkopohjaisesti tutkimusaineistoa, piirtééa kuvia,
laskea kuvailevia tunnuslukuja seka tehda tilastollisia analyysejéa. Perinteinen SAS-kéytto
voidaan myos yhdistéé EG:n helppouteen, silla EG:ssa voidaan kéyttéa SAS-koodia. EG:n
vahvuutena on myos tulosteiden, kuten kuvien ja taulukoiden, helppo siirrettdvyys muihin
ohjelmiin, esimerkiksi Wordiin. Oppaassa keskitytéan datan kayttdonottoon ja muokkauk-
seen sekd datan havainnollistamiseen kuvien ja tunnuslukujen avulla. Lisdks kaydaan 1&pi
Enterprise Guiden kéyttdympéristda ja yleisia ominaisuuksia.

Muutamia Enterprise Guidessa kaytettyja englanninkielisia ilmauksia on syyta tésmentéa.
muuttujaa ja sen arvoja eli saraketta datamatriisissa. Myds sanat " Rows’ ja” Observations’
tarkoittavat keskendén samaa asiaa €li havaintoa (rivid) datamatriisissa. lImaukset "SAS
datatable” ja” SAS data set” puolestaan molemmat tarkoittavat SAS-dataa.

Vahlberg ym. (2006) seka Helenius ja Katgjisto (2005) ovat julkaisseet suomenkieliset
kirjat Enterprise Guiden versiosta 3.0. Slaughter ja Delwiche (2006) ovat julkaisseet eng-
lanninkielisen kirjan Enterprise Guiden versiosta 4.1. Nama kirjat ovat tdman oppaan paéa-
|&hteita.

2 Oppaassa kaytettavat datat

Kaikki kolme oppaassa kaytettéavaa aineistoa [Oytyvat internetista
(http://www.mtt.fi/mtts/pdf/eqdata/ EGdatat.zip). Aineistoja tarvitaan oppaan harjoitusteh-
tavia tehtdessd, mutta harjoitusmateriaalina voi vaihtoehtoisesti kdyttéd myos muita vas-
taavan tyyppisia aineistoja. Kaytettavat aineistot kannattaa tallentaa omalle tietokoneelle
esmerkikss kansioon CI\SAS\[EGKURS, jota kaytetddn oppaan esimerkkien tal-
lennuspaikkana.

Gomez-aineisto

Gomez-aineisto on Gomezin ja Gomezin (1984) kirjassa esitetty osaruutukokeen tulosai-
neisto. Kokeessa on tutkittu riisin satoa eri lgjikkeilla ja typpitasoilla. Paaruututekija on
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typpitaso, jonka luokat (kuusi typpitasoa) on arvottu padruutuihin satunnaistettujen taydel-
listen lohkojen koekaavion mukaisesti. Lohkoja kokeessa on kolme. Osaruututekijd on
riisilgjike, jonka luokat (nelja eri lgjiketta) on taydellisesti satunnaistettu osaruutuihin erik-
seen jokaisen pddruudun sisdlla. Aineisto on tallennettu Excelissa nimella GomezData.xls.
Aineistosta |Oytyvét seuraavat muuttujat:

. Variety (lgjike):
IR8
IR5
C4 63
Peta
. Nitrogen (typpi kg/ha):
0
60
90
120
150
180
. Rep (Iohko):
1
2
3
o Yield (sato kg/ha)

Viljelija 2006 -aineisto

Viljelija 2006 -aineisto perustuu keksittyyn kyselytutkimukseen, jossa 54 tilanomistgjalta
on kysytty erilaisia maatilaan jaitse viljelijaan liittyvia kysymyksia Aineisto on tallennettu
Excelissa nimella Viljelija2006.xls. Aineistosta l6ytyvét seuraavat muuttujat:

. id (havainnon tunnistenumero)
. nimi (viljelijan etunimi)
. sukup (viljelijén sukupuoli)
1="Mies’
2="Nainen”
peltoa (peltoa hallinnassa, ha)
nautoja (nautoja omistuksessa, kpl)
metsaa (metsda omistuksessa, ha)
tuotsuun (paétuotantosuunta)
1="Peltoviljely”
2="Kotielaimet”
paino (viljelijan paino, kg)
pituus (viljelijan pituus, cm)
ika (viljelijan ika vuosina)
tulot (viljelijan vuositulot euroina)
e ganmuk (tilan ajanmukaisuus)
1="Huippumoderni”
2="Ajan hermolla’
3="0OK”
4="V&han peréssd’
5=" Alkukantainen”



e tulevais (tilan tulevai suudennakymét)

1="Hyvat"
2="0K"
3="Huonot”

Eldinten painot -aineisto

Eldinten painot -aineisto on keksitty kokeellinen toistomittausaineisto. Kymmenen saman
pentueen kettua on heindkuussa tapahtuneen vieroituksen yhteydessa taydellisesti satun-
naistettu kahteen eri kasittelyryhmaan. Kettujen painon kehitysta on seurattu elokuusta
joulukuuhun neljdna eri gjankohtana. Aineisto on tallennettu SASissa nimelld Ketut-
Data.sas7bdat seka Excelissa nimella KetutData.xls. Aineistosta 10ytyvédt seuraavat

muuttujat:

e |D (ketun tunnistenumero)
e ryhma (kasittelyryhméd)
A

B
elokuu (ketun paino elokuun mittauksessa, kg)

syyskuu (ketun paino syyskuun mittauksessa, kg)
lokakuu (ketun paino lokakuun mittauksessa, kg)
joulukuu (ketun paino joulukuun mittauksessa, kg)

3 Enterprise Guiden kayttoymparisto

Avattaessa Enterprise Guide, perusndkyma on seuraavanlainen:

Code Data Describe  Graph  Analyze  Add-In - OLAP  Tooks  Window e
fog Project Designer  [3] Maximize Warkspace

File Edt Wiew

B-g-E|E&»2E X B

c.[x]| Eog Project Designer

T, Project
= i
Bes Process Flow [ Bog Process Flow /
~

Tehtavdista

Projektipuu (”,T?Sk
("Project Ex- List").
plorer”). Tydtila ("Workspace”),

jossa nékyy myos pro-

sessidiagrammi-valilehti

("Project Designer”).

"o Tehtavan tila-ikkuna (" Task Status’). ]

[ [Urknown] connected to localhost




Perusndkyma sisdltaa tyoétilan ("Workspace”), johon avautuvat kdyttdéon otettavat aineistot
jasuoritettujen tehtévien tulosteet. Ty6tilan hallitsevana osiona on prosessidiagrammi-vali-
lehti ("Project Designer”), joka palvelee samaa tarkoitusta kuin projektipuu. Molempiin
kertyy istunnon aikana tehdyisté tehtavisté jalki, joka voidaan myds tallentaa ja ottaa kéyt-
t60n uudessa istunnossa. Jalki eli EG-projektikokonaisuus sisdltéa erillisia kuvakkeita €l
solmuja (pd&asi assa tehtavasolmuja ja tulossolmuja) suoritetuista toimenpiteistd, joita paé-
see tarkastelemaan ja muokkaamaan tupla-klikkaamalla niitd. Hiiren oikealla painikkeella
saa listan kyseiseen kuvakkeeseen liittyvista jatkotoimenpiteistd. Oppaassa kdytetdan paé-
asiassa prosessidiagrammia projektin kasittelyyn. Edella mainittujen tehtéva- ja tulossol-
mujen lisdks Enterprise Guiden projekti pitéé sisalléédn muun muassa datoja, koodeja, |og-
tiedostoja ja muistiinpanoja toisiinsa linkitettyind. Projektia voi prosessidiagrammissa
my0s jakaa useammalle erilliselle vélilehdelle (Process Flows). Uusia vélilehtia saa valit-
semalla”File” ->"New” ->"Process Flow”.

Prosessidiagrammi, datat ja tulosteet ovat kukin omina vélilehtindéan tydtilassa. Useampi
vdlilehti saadaan samanaikaisesti ndkyviin painamalla hiiren oikealla painikkeella vélileh-
den otsakepalkkia ja valitsemalla "New Horizontal Tab Group” tai "New Vertica Tab
Group”. Huomaa, etté jos prosessidiagrammiin on tehty useampi vélilehti, niin ne ovat
alivélilehtind varsinaisen prosessidiagrammivaélilehden alla. Kétevin tapa |6ytaa prosessi-
diagrammi mahdollisten monien tulosteiden ja datojen joukosta, on klikata prosessidia-
grammin omaa tyokalurivin pikapainiketta” Project Designer”.

Perusndkyma sisaltéa myos Tehtéavan tila -ikkunan (" Task Status’), jossa nékyy suoritetta-
van tehtévan eteneminen.

Varsinaisia toimenpiteita voidaan tehda tehtavalistan (" Task List”) tai ylavalikoiden avulla.
Oletusasetuksilla tehtavélista on piilotettu oman pikalinkkinsa ale (ks. kuva edelld). Téssa
oppaassa tehtavét suoritetaan padasiassa ylavalikoiden kautta. Ylavalikoista [6ytyy seuraa-
viatoimintoja:

File: Tyypillinen "File’/” Tiedosto” -valikko, josta |0ytyy muun muassa tiedostojen
avaamiseen, tallentamiseen ja tulostamiseen liittyvia toimintoja.

Edit: Tyypillinen "Edit”/”Muokkaa’-valikko, josta 16ytyy muun muassa kopioi-,
leikkaa-, liité-, etsi- ja korvaa-toimintoja.

View: View-valikossa voidaan méaéritella nakyvissa olevat ikkunat ja tyokalurivit.

Code: Code-valikko liittyy lahinna perinteisen SAS-koodin k&ytt6on. Muun muassa

koodi-ikkunaan kirjoitettu SAS-koodi voidaan suorittaa tdman valikon kautta.
Kuitenkin myds tavalliset tehtéavasolmut voidaan suorittaa taalta.

Data: Tasta valikosta |0ytyvét aineiston muokkaamiseen liittyvét toiminnot. Taman
valikon tyokal uja kéydaan oppaassa |&pi tarkemmin.

Describe:  Téasta valikosta [6ytyy aineiston kuvailuun liittyvia toimintoja, kuten tunnus-
lukujen laskemista ja frekvenssitaulujen muodostamista. Témankin valikon
tyokal uihin paneudutaan oppaassa.

Graph: Valikosta |0ytyy aineiston graafiseen tarkasteluun liittyvié toimintoja, joihin
tutustutaan oppaassa tarkemmin.
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Analyze:  Analyze-valikossa ovat toiminnot, joiden avulla voidaan suorittaa aineiston
tilastollisia analyysg a.

Tools: Valikosta voidaan vaikuttaa moniin Enterprise Guiden yleisiin asetuksiin.
Help: Valikosta l6ytyy Enterprise Guiden Help eli ohje

Tulostusta tutkiessa saattaa tul ostusikkuna tuntua turhan pienelta. Tall6in voi kayttda”Ma-
ximize Workspace” -toimintoa, joka |6ytyy omana painikkeenaan tyokalurivilta. Sen avul-
la tulostusikkuna suurentuu |ahes koko ruudun kokoiseksi ja muut ikkunat menevét sivuun,
pikalinkkien taakse. Muita ikkunoita saa ké&tevasti nakyviin viemalla hiiren kohdeikkunan
pikalinkin paalle.

Y ksittéisen ikkunan voi myos siirtéé sivuun klikkaamalla x-symbolin vieressa olevaa nas-
ta-symbolia. Taloin ikkuna menee samanlaisen pikalinkin taakse kuin ”Maximize Works-
pace” -toiminnossa. Klikkaamalla nastan takaisin pystyasentoon ikkuna palautuu
ennalleen.

Ikkunoiden tai ikkunaryppéiden kokoa, muotoa ja paikkaa voi muokata tarttumalla niista
tai niiden reunasta kiinni ja venyttamalla tai siirtdmalla niitd. Ikkunoista voi siis muokata
juuri itselleen sopivat. Ohjelma tallentaa ikkunoiden jérjestyksen automaattisesti EG:n lo-
petuksen yhteydessd, joten jarjestys palautuu samanlaisena, kun EG kaynnistetdan seuraa-
van kerran. Ikkunat voi palauttaa alkuperéisille paikoilleen valitsemalla ” Tools” -> " Opti-
ons’ -> "Genera”-vdlilehdelta "Reset Docking Windows’. Yksittéisen suljetun ikkunan
saa palautettua " View” -valikosta. Prosessidiagrammin ja ty6tilan voi myds erottaa toisis-
taan eli muuttaa ndkyman samankaltaiseksi kuin Enterprise Guide 3.0:n oletusnakyma néi-
den osadlta. Tama onnistuu klikkaamalla hiiren oikeata painiketta prosessidiagrammiva-
lilehden otsakepalkin (" Project Designer”) paéllajavalitsemalla” Dockable’.

Tehtava: Avaa Enterprise Guide pikakuvakkeesta. Selaa valikoita, ikkunoita ja vélilehtia
saadakses alustavan kuvan Enterprise Guiden kayttdympéristosta. Harjoittele myos ikku-
noiden muokkausta. Lisdksi voit harjoitella” Reset Docking Windows’ -toiminnon kayttoa,
jos ikkunat menevét epgarjestykseen tai ovat edellisen kayttdjan jaljilta vadrassa jarjestyk-
Sessi.

4 Enterprise Guiden ohje

Enterprise Guiden ohje [6ytyy klikkaamalla "Help” -> " SAS Enterprise Guide Help”.
Samasta valikosta 16ytyy myos ” Getting Started Tutoria”, jossa kaydaén 18pi EG:n perus-
toimintoja. Sithen kannattaa tutustua itsendisesti. Varsinaisessa ohjeessa on eri kokonai-
suuksia jarjestettyina selkeiden otsikoiden ale, joten se on varsin kayttokelpoinen ja toi-
miva. Esimerkiks eri analyysityokaluihin 10ytyy apua klikkaamalla ohjeessa " Sisdllys’-
vdlilehdeltéd auki kansion " Running SAS Tasks’. Lisdks apua saa painamalla néppéi miston
F1-nappéinta Enterprise Guiden kdyton lomassa, jolloin EG avaa automaattisesti ohjeesta
sellaisen sivun, jokalliittyy sillé hetkella kéytdssa olevaan osaan EG:ta.
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My6s muokattaessa tehtévasolmua (tehtéavasolmujen muokkausta kasitelldédn oppaassa
my©hemmin) ohjeita on runsaasti tarjolla

Il Bar Chart for VILJ2006_MUOK X

Bar Chart
Task Roles
Appearance
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Enterprise Guiden ohjeen lisdksi on usein tarpeen kayttéd myos tavallisen SASin manuaa-
lia (I6ytyy internetist& http://support.sas.com/documentati on/onlinedoc/sas9doc.html).
Varsinainen SASin manuaali on nimittdin paljon tasmallisempi ja lagjempi yksityiskohtien
suhteen kuin Enterprise Guiden ohje. Lisétietoa tavallisen SASin manuaalin kéyttéamisesta
|6ytyy myos luvusta SAS-koodin kayttaminen.

Aiemmin tavallista SASia kéyttaneille EG:n hahmottamista saattaa helpottaa tieto Enter-
prise Guiden tytkalujen kayttamista SAS-proseduureista. " Task list” -ikkunan toisella va
lilehdella on kunkin tyokalun vieressa mainittu sen k&yttamat SA S-proseduurit.

5 Tiedostojen tyypit

Enterprise Guide tunnistaa automaattisesti erityyppisia tiedostoja. Enterprise Guideen voi-
daan avata aiemmin luotuja Enterprise Guide -projektitiedostoja, joita ovat *.epg-tiedostot
(EG versio 3 ja4) ja*.seg-tiedostot (EG versiot 1 ja 2). Avattaessa EG 4.1:een EG 3.0:ssa
tehty projektitiedosto, ohjelma kuitenkin huomauttaa, samasta tiedostotyypista huolimatta,
etta se on tehnyt projektitiedostoon tiettyja muutoksia, jotka lopullisesti hyvaksytaan tal-
lentamalla projekti EG 4.1:ssa Jos muutokset tallennetaan, projektitiedostoa el voi enda
kayttéd EG 3.0:ssa.

Enterprise Guideen voidaan avata erityyppisid datatiedostoja. EG:ssé& aukeavat muun mu-
assa SAS-datat (*.sas7bdat, *.sd7 ja*.sd2), Excel-datat (*.xls) sekéd monen muun tyyppiset
datatiedostot (*.dbf, *.txt, *.csv, *.asc, *.tab). Liséksi Enterprise Guideen voidaan avata
muun muassa SAS-kooditiedostoja (*.sas) sekd SAS-logitiedostoja (*.log). Taydellisen
listan Enterprise Guiden tunnistamista tiedostotyypeista nékee esimerkiks klikkaamalla:
"File” -> "Open” -> "Other” -> "Loca Computer” ja avaamalla tiedostotyyppilistan. Sa-
masta”File” -> " Open”-valikosta |6ytyy myds omat kohdat projektitiedostojen (” Project”),
datojen ("Data’) ja SAS-kooditiedostojen (" Code”) avaamiseen.

6 Aineiston kayttoonotto

6.1 Kirjastoviitteen luominen

Kirjastoviite on SAS-ohjelmiston kayttdma menettel ytapa, jossa avainsanalla viitataan tiet-
tyyn hakemistoon tai kansioon tietokoneella. Sité tarvitaan esimerkiksi, jos halutaan maari-
telld, mihin tietokoneen kansioon istunnon aikana luodut SAS-datat tallennetaan tai mista
kansioista aiemmin luodut SAS-datat otetaan kayttoon. SAS Enterprise Guiden versiossa
4.1 kirjastoviitteen luomiseen on olemassa kol me kaytttkel poista tapaa.

I stunnon ajan voimassa olevan kirjastoviitteen luominen

Kaks ensimmaéista tapaa tuottavat Kirjastoviitteen, joka on voimassa EG-istunnon ajan.
Kun Enterprise Guide tai projekti kaynnistetddn uudelleen, pitda kirjastoviite muistaa is-
tunnon aluks yhdistda uudelleen haluttuun hakemistoon suorittamalla kirjastoviitteen méaé-
ritteleva solmu uudelleen.

Ensimmainen tapa on luoda kirjastoviite kayttéen siihen tarkoitettua Enterprise Guiden

keavassa ikkunassa mééritel|aan vaihe kerrallaan kirjastoviite.
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Ensimmadisella sivulla annetaan kirjastoviitteelle nimi (esimerkiksi kir):

&' Library Wizard

106 Enter a name and an optional description far the librany. Jsas_

Kirjastoviitteelle annetaan nimi
M ame: / kohdassa” Name”.

KIR |

Deszcription:
| |
Mote:

Thiz library definitian will not be permanently stared with the SAS zerver. Ta

uze this library again in & future session, you will need ko rerun this task within
wour project. To create a permanent ibrary definition, use the Mew Library
wizard in 545 Enterprize Guide Explorer.

Erter the name of the library and a description of its contents.,

< Back [~ Eirizh [ Cancel H Help

Toisellasivullavalitaan palvelin (usein ainoa vaihtoehto on ”Local”):

&' Library Wizard

2 off Specifty the server for the library. Jsas_

Server

Drezcription

Uzer's lozal machine

Klikataan "Local” siniseksi.

[ ¢ Back ]B[ Mest » Finizh Cancel H Help

14



Kolmannella sivulla valitaan kansio, johon Kkirjastoviite Vviittaa, esimerkiksi
C\SAS\EGKURS ("Engine” puolestaan saa paasdantoisesti olla oletuksena oleva”Base”):

&' Library Wizard

3 ofb selectan engine and enter the information required to use it Jsa,s_
Engine:
BaSE w [] DEMS Connection
Bath:
C:heas\EGkurs

Tietokoneen kansio, johon kirjastoviitteen halutaan viit-
taavan, voidaan mééarittda kirjoittamalla kyseinen hake-
mistopolku kohtaan "Path” tai ”Browse’-painikkeen
kautta.

Specify the data engine and path af the brany.

[ ¢ Back ]EH Mest » ] [ Cancel ” Help ]

Loput sivut voi yleensa klikata ohi painamalla "Next” ja viimeisella sivulla valitaan " Fi-
nish”.

Toinen tapa luoda kirjastoviite, on tehda se SAS-koodin avulla. Koodieditorin saa avattua
klikkaamalla "File” -> "New” -> "Code’. Tassa koodi-ikkunassa voi méarittaa Kirjasto-
viitteen samoin kuin perus-SASissa, esimerkiksi:

LIBNAME kir ' c:\sas\egkurs'’;

Siina kir on kirjastoviitteen nimi ja yksinkertaisten lainausmerkkien sisdlla on hakemisto-
polku, jonka osoittamaan kansioon kirjastoviite viittaa. Koodin voi suorittaa muun muassa
klikkaamalla koodisolmua prosessidiagrammissa hiiren oikealla painikkeella ja valitse-
malla”Run Code On Local”.

Pysyvan kirjastoviitteen luominen

Pysyva kirjastoviite luodaan klikkaamalla ensin " Tools’ -> " SAS Enterprise Guide Ex-
plorer”. Aukeavassa ikkunassa valitaan "File” -> "New” -> "Library”. Sitten méaaritell88n
Kirjastoviite samoin kuin Assign Library -tyokalulla, mutta toisella sivulla laitetaan merkki
kohtaan ” Assign at Server Startup”.

Tehtava: Tee tietokoneelle kansio C:\SAS\EGKURS ja kopioi sinne tdhén oppaaseen liit-
tyvét datatiedostot (http://www.mtt.fi/mtts/pdf/egdate/ EGdatat.zip). Luo istunnon gan voi-
massa ol eva kirjastoviite nimelta kir, joka viittaa kansioon C:\SAS\EGKURS.
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6.2 Kirjastoviitteen asettaminen oletukseksi

Oletuskansio, johon eri tehtavasolmut ehdottavat datoja ja tulosteita tallennettavaksi, on
mahdollista vaihtaa. Se onnistuu klikkaamalla “Tools’ -> “Options’ -> “Tasks’ ->
“Qutput Library” ja vaihtamalla siella nékyvien kirjastoviitteiden jarjestysta. Jarjestysta
voi vaihtaa valitsemalla jonkin kirjastoviitteen aktiiviseks ja sirtamala sitd "Up”- tai
"Down”-painikkeilla. Kunkin projektin datat kannattaa tallentaa omaan kansioonsa. Yksi
hyva menettelytapa on kayttaa kaikissa projekteissa samannimisté kirjastoviitetta (esimer-
Kiks Kkir), mutta méaarittda aina projektin alussa kir-niminen viite osoittamaan kyseisen
projektin data-kansioon tietokoneella. Talldin kir-kirjastoviite voidaan méérittaé asetuk-
sissa ensisijaiseks kirjastoviitteeks ja seurauksena EG tarjoaa oletusarvoisesti datoja tal-

Tehtava: Aseta edellisessi tehtavassa luotu kirjastoviite kir oletuskirjastoviitteeks.

6.3 Aineiston tallennusmuoto

Aineiston pitéé olla tallennettuna sellaiseen muotoon, etté siiné eri tilastoyksikéiden ha-
vainnot ovat eri riveilla ja jokaisen muuttujan arvot omissa sarakkeissaan. Seuraavassa
muutama esimerkkiaineisto:

Esimerkki. Lehmédata:

LEHNIMI KAS TUOTOS
Mansikki  Perus 8600
Rebekka Perus 8450
Pokemon  Super 9100
Pikachu Perus 8700
MelC Perus 8750
MelB Super 8950
NylonBeat Super 9150
Rulu Super 8700
Viira Perus 8750
Ylva Super 8950

Esimerkki. Peltodata:

LAJKE LOHKO SATO
A 6500
5850
6250
5025
4520
5260
4520
3950
4310

Toistomittausaineistoksi kutsutaan dataa, jossa samaa ominaisuutta on mitattu useamman
kerran kokeen tai seurannan aikana samoilta tilastoyksikoilt. Toistomittausaineisto voi-
daan tallentaa kahdella eri tavalla ja tarvittaessa kéantéé muodosta toiseen Enterprise Gui-
dessa:

O0O0OWWwWwW > >
WNRFPWNE WN P
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Esimerkki. Elintarvikedata, toistomittaukset yhdessa sarakkeessa:

HENKILO KAS KK PAINO

Pekka TavPuuro 1 87.2

Pekka TavPuuro 2 87.1

Pekka TavPuuro 3 87.4

Paavo PuuroX 1 72.1

Paavo PuuroX 2 83.2

Paavo PuuroX 3 85.6

M atti TavPuuro 1 99.1

M atti TavPuuro 2 99.8

M atti TavPuuro 3 100.2

Antti PuuroX 1 78.1

Antti PuuroX 2 83.2

Antti PuuroX 3 86.5

Timo PuuroX 1 95.1

Timo PuuroX 2 103.2

Timo PuuroX 3 114.2

Keijo TavPuuro 1 104.2

Keijo TavPuuro 2 102.1

Keijo TavPuuro 3 99.2

Esimerkki. Elintarvikedata, toistomittaukset omissa sarakkei ssaan:
HENKILO KAS PAINO 1 PAINO_ 2 PAINO 3
Pekka TavPuuro 87.2 87.1 87.4
Paavo PuuroX 72.1 83.2 85.6
M atti TavPuuro  99.1 99.8 100.2
Antti PuuroX 78.1 83.2 86.5
Timo PuuroX 95.1 103.2 114.2
Keijo TavPuuro  104.2 102.1 99.2

Aineistoa tallennettaessa pitéa huomioida, ettéd muuttujien nimet saavat olla EG:ssa kor-
keintaan 32 merkin pituisia, mutta suositeltavaa olis pitdd nimet vieldkin lyhyempina
Monissa ohjelmissa, mukaan lukien SASin vanhemmat versiot, rgjana nimen pituudelle on
kahdeksan merkkia ja pidemmét nimet saattavat aiheuttaa yhteensopivuusongelmia. Muut-
tujien nimissa kannattaa kayttéa ainoastaan kirjaimia (ei skandinaavisia), numeroita ja al-
leviivausmerkkia (), e siis muita erikoismerkkeja eika valilyontgjd. Muuttujien nimia ei
mydskaan kannata al oittaa numeroilla.

6.4 Aineiston sydttdminen Enterprise Guidessa
Uuden datamatriisin avaaminen jatallentaminen

Aineisto voidaan muodostaa syéttamalla se data-matriisiin Enterprise Guidessa. Tama tapa
on hyvin samanlainen kuin datan sy6ttdminen ké&sin Excelissi. Uus data-matriisi saadaan
ruudulle valitsemalla ylareunan valikoista "File” -> "New” -> "Data”. Taloin aukeaa
kaksivaiheinen tyokalu, jonka ensimmaisessi vaiheessa annetaan muodostettavalle datalle
nimi “Name”-kohdassa ja valitaan tallennuksen kohdekansio kirjastoviitteen avulla” Loca
tion”-kohdassa. Klikkaamalla "Next” padastdan seuraavalle sivulle, jossa voidaan antaa
datamatriisin muuttujien nimet ja ominaisuudet. Lopuksi klikataan " Finish”.
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Datamatriisin muokkaaminen

Datamatriisin muokkaaminen selitetddn tarkemmin luvussa Datan muokkaus. Téassa kay-
daan lyhyesti 1&pi muutamat perusasiat, jotka liittyvét uuden datan luomiseen.

Jotta dataa paésee muokkaamaan, on datasta ensin poistettava kirjoitussuojaus. Tama teh-
daén datan ollessa padllimmai sena ty6tilassa klikkaamalla ” Data”’ ja poistamalla mahdolli-
nen valinta kohdasta ” Read-only”.

Sarakkeiden nimig, tyyppeja yms. paasee tassa vaiheessa muokkaamaan klikkaamalla sa-
rakkeen otsikkoa hiiren oikealla painikkeella ja valitsemalla ” Properties’. Uusia sarakkeita
voidaan luoda klikkaamalla hiiren oikealla painikkeella jotain sarakeotsikkoa ja valitse-
malla "Insert Column”. Riveihin kohdistuviin toimenpiteisiin péastdan kasiks klikkaa-
malla hiiren oikealla painikkeella tietyn rivin numeron kohdalla. Uusia riveja saa lisdtyksi
my6s painamalla Enter-ngppéintd, kun kohdistin on muokattavan datamatriisin viimeisell&
rivilla. Muuttujien jarjestystéa voi vaihtaa siten, etté valitaan jokin sarake aktiiviseksi, ote-
taan muuttujan nimesta kiinni painamalla hiiren vasen painike pohjaan ja raahataan sarake
eri kohtaan.

Datamatriisiin voi késin syottamisen lisaks myds tuoda dataa esimerkiksi Excelisté leike-
poydan kautta (" Copy”/”Kopioi” ja” Paste” /" Liit&").

Tehtava: Avaa Enterprise Guidessa uusi tyhja data-matriisi ja tallenna siihen seuraava ai-
neisto:

LAJKE KERR SATO
1 6500
2 5850
3 6250
1 5025
2 4520
3 5260
1 4520
2 3950

4310

Talenna aineisto pysyvdkss SAS-datatiedostoks kirjastoviittees osoittamaan kansioon
nimella peltodata.

OO0 wWwWwW> > >

w

6.5 Excel-tiedoston avaaminen Enterprise Guideen

Enterprise Guideen voidaan avata Excel-tiedostoja. Tama tapahtuu klikkaamalla ” File” ->
"Open” -> "Data” ja “Local Computer” (tai "File” -> "Import Data’) ja valitsemalla
haluttu tiedosto. Vaihtoehtoisesti Excel-tiedosto voidaan yksinkertaisesti raahata omalta
tietokoneelta EG:n prosessidiagrammi-véilehdelle. Tamén jadlkeen valitaan yks tai use-
ampi Excel-datan vdlilehti, joltatal joilta dataa halutaan tuoda Enterprise Guideen. Taman
jalkeen nakyviin tulee seuraava valintaruutu:
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Open Data

Options for Opening File "GomezDataxds"

Select one of the following bwo ways of opening the selected file,
Select thiz option if you want to view the file az iz

For data files, the data formatz will be automatically chozen for pouw, The data formats may not be
carrect if you want to perfarm analvziz againzt the file opened in this way.

Select thiz option if you want to open the file az a 545 data zet.

"r'ou may go through Import Data task multiple times, once for each file or sheet you selected, to zpecify
data farmatz. The result will Be one ar mare 5A5 data setz, suitable az data input for furthier analysiz.

[ ] Do not show this dialog again - always open file az iz,

Caticel

Ensimmainen vaihtoehto avaa "nékyman” Excel-dataan. Toinen vaihtoehto luo Excel-da-
tasta SAS-datan ja ottaa sen kayttoon EG:ssa. Erona vaihtoehtojen vdilla on, ettd EG pys-
tyy kéyttamadan SAS-dataksi muunnettua dataa monipuolisemmin. Jos alkuperaista Excel-
dataa muutetaan (Excelissd), muutos paivittyy EG:ssa olevaan Excel-ndkymaan automaat-
tisesti, kun dataa seuraavan kerran kaytetéén (kannattaa sulkea mahdollisesti auki oleva
datamatriisi EG:n tydtilasta ja klikata se uudelleen auki prosessidiagrammista). Jos taas
luodaan SAS-data, projektiin syntyy tuloksena sekd nakyma Excel-dataan etta ndkyma
luotuun SAS-dataan. SAS-dataa voidaan sek& muokata etté kdyttéd EG:ssa, mutta samalla
alkuperédinen Excel-data sdilyy muuttumattomana. Tassakin tapauksessa mahdolliset muu-
ala tehdyt muutokset Excel-dataan paivittyvdt samoin kuin edelld Excel-datandkymaan,
mutta jos halutaan tehda muutokset myds SAS-dataan, on gjettava uudelleen prosessidia
grammissa Excel-datandkymén ja SAS-datandkymén valissa oleva "Import Data’ -teht&
vasolmu. Jakimmainen vaihtoehto eli datan lukeminen SAS-dataksi on suositeltavampi,
koska se mahdollistaa aineiston monipuolisemman kdyton EG:ssa.
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Jos valitaan jakimmainen vaihtoehto, paadytdan seuraavaan nakymaan (valilehtia voi
vaihtaa ruudun vasemmassa reunassa olevasta listasta), jossa " Region to import” -vélileh-
dell& méaritetéddn datan lukeminen sisdan rivien osalta:

SCimportData M&éritet&n rivinumero, josta
Fegion to import | Region to import |Oytyvat muuttuj | en nl met
Colurmn Ophions '

Results Specify line to use as column headings: m
[¥] Impart entire file: 1\
Start importing data from line: Valltmn |Uettavak' lﬂ
S koko data tai
tepist gl sobss tolloing tartig-e tietyt rivit.

Stop importing data on line: 3:

"Preview” -ikkunan " Results’-vdlilehdelta voi esi-
katsella datan sisdanluvun lopputulosta ensim-
maisten rivien osalta Eskatseluikkunan voi
péivittéa painamalla” Refresh Results’.

[ Prewviews window Bun l [ Save ] [ Cancel J [ Help

Ready

Huomaa, etta EG j&ttda Excel-datasta huomioimatta otsikkorivit ja tyhjét rivit yms., joten
jos annat yll& rivien numeroita, aloita rivien laskeminen vasta siitéa kohtaa, missa varsinai-
nen data sarakeotsikoineen alkaa. ” Column Options’ -vélilendell& puolestaan tarkastellaan
jamuokataan siséan luettavia sarakkeita:

tulostus-
muodolla voidaan mé&éritella
muuttujan arvojen muotoilu

Column Properties:

tulosdatassa. Esimerkiksi 1 [EiGeneal

numeeriselta  muuttujalta Name ield

naytettavien  desimadien '\ i xes_
madran saa maaritettya for- Length 8

maatilla. Katso lisétietoa isplay format

luvusta Datan muokkaus. /Ead'i”_‘°'ma‘
niclude in output Yes

"Read-in”-formaattgja eli informaatteja kéyte- X
téép__kertomaa_\n EGlle, r_r)iten sen tule_e tulk_ita "Include in  output”
sisaan luettavien muuttujien arvot. Esimerkik- -kohdassa voi vdlita
s, tulklt_aank_q 1/1/2006 siten, efta merkl_qjo- muuttujan  jétettavaksi
hon ensimmainen Iukg on pdva ja toinen pois tul osdatasta.
kuukaus vai péinvastoin. Katso lisétietoa lu-
£ vusta Erikoismuuttujien sisdan lukeminen =
ClEr Jaongel matapauk%t Bun ] [ Save ] ’ Cancel J [ Help
Ready
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Paivamadramuuttujista ja muista erikoisemmista muuttujista kannattaa yleensa tarkistaa
Enterprise Guiden automaattisesti valitsemat informaatit ja formaatit, jotta tieto tulee var-
masti luettua siséén oikein ja esitettyd datamatriisissa ja sen myota tul ostei ssa mielekkaalla
tavalla Tavallisimmille paivamaaramuotoisille muuttujille Enterprise Guide 4.1 osaa valita
siséanlukuformaatit oikein, toisin kuin Enterprise Guiden edellinen versio. ”Results’-
vdlilehdella voidaan vaihtaa tuloksena syntyvan SAS-datan nimea ja Sijaintia. Alla on
muutettu datan nimed ja médritetty, ettd se tallennetaan kirjastoviitteen kir osoittamaan
kansioon:

&* Import Data

[ Region to import. Results

Colurnn Options :
~Save |ocation

Data: KIR.GOMEZ_DATA [on “Local”)

Browse...

| i |
[ Preview window Hun ] [ Save ] [ Cancel I [ Help ]
Feady

Lopuksi painetaan ”Run”, jolloin uusi data nékyy ruudussa:

File  Edit e Data Describe Graph Analyze Add-In  OLAP Tools iWindow Help
B3-S oL By X | = o |8, i BegProject Designer [75] Maximize Workspace B¢ Task Status

KIR.GOMEZ_DATAR (Import DataGa = _ © b [

Bag Fioject Designer | [2] petodat | (7] KIR.GOMEZ_DATAA (readonk) | ES

A variety |@ Mitogen |3 Rep @  Yied | ~
1 [RS8 | 0 1 4430
|2 [R5 0 1 3344
ER ] i 1 3464
|a_|Pets 1 1 4126
|5 |IRe [1 2 4478
6 _|IRs 0 2 5314
lz_|cd 83 0 2 2544
a 8 |Peta 0 H 2432
R.GOMEZ_ DATAA EE] i 3 3950
|10 |IR5 i 3 3660
111 |ca 63 0 3 3142
12 |Pats [ 3 4838
|13 |IRG 60 1 5418
14 |IRS 50 1 e502
15 |£4_63 60 1 4768
|16 |Peta 60 i 5132
117 |IRe 50 2 5166
18 |IR5 60 2 5858
|19 |cae3 60 2 E004
|20 | Pzt 50 2 4504
21 |IRs 60 3 B432
|22 |IRs 60 3 5586
23 |t 63 50 3 5556
24 |Pets 60 3 4652
|25 |IRe Ll 1 EO7E
26 |IR5 80 1 003
|27 |Ca 83 0 1 B244
|28 |Feta a0 1 4546
29 |IRa 80 2 5420
|30 |IFS 0 2 5127
|1 [caes Ll 2 5724
32 |Pats 80 2 5744
|33 | IR 0 3 6704
|34 |IR5 an 3 5642
35 |04_63 80 3 014
|36 |Pets Eli 3 4148
|37 |IRe 120 1 6452
38 |IRs 120 1 7133
|39 |C4.63 120 1 5732
|40 | Pzt 120 1 2774
41 |IRs 120 2 7056
|42 |IR5 120 2 =i

laara ra 1on > Lzl &

Task Statu [¢] Server |

Ready 13 [Urknown] connected to localhost
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Samalla prosessidiagrammiin muodostuvat datasolmut, jotka viittaavat Excel-datandky-
maan ja SAS-dataan. Samoin muodostuu tehtdvasolmu, joka sisdltéad SAS-datan muodos-
tamiseen liittyvat médrittelyt ("Import Data’ -tehtévasolmu). Prosessidiagrammi saadaan
nakyviin klikkaamalla auki ” Project Designer” -vdlilehti:

File Edt Wiew Code Dats Describe Graph  Analyze AddIn  OLAP  Tooks  Window  Help

B-5-% 5 Cafla X | o . - BogProject Designer  [] Maximize Workspace 5% Task Status

KIR.GOMEZ_DATAA (Import DatafGo = _ - |-

E t CHE] [ Beg Project Designer [ peltodat | [7] KIR GOMEZ_DATA (rsad-onl) %

T, Project ¢ 1
"B Beg PiECESHH | fog Process Flow |
-9 Jisws\gn Library - -
1 Last Submitted Code =
i )
£3 peltodat s
= & GomezDatads (Taulg) Library
=247 Import D.

=47 Import Data e
[£] Last Submitted Code:
5] Log &

[ KIRGOMEZ_DATAS peltodat

< By f-

GomezDala. Impoit KIRGOMEZ.
(Taullg) Data

E 1 < [x]|

Ready I [Unknown] connected to localhast

Excel-datanékymé&ssé otetaan automaattisesti alkuperdisen datan ensimmainen rivi sarake-
otsikoiksi. Jos téta ol etusta halutaan vaihtaa, se onnistuu " Tools” -> ”"Options’ -> "Data’ -
> " Performance”-vélilehdella

Tekstimuotoisen datan sisdan lukemiseen kuuluvat hyvin pitkélti samat vaivaiheet kuin
Excel-datan sisdan lukemiseen. Liséna sisdan luku -tyokalussa on ” Text Format” -valilehti,
jossa tehdaan tekstimuotoiseen dataan liittyvia erityismaarityksia.

Tehtava: Avaa kansiosta C:\SAS\EGKURS Excel-data nimeltd GomezData.xls ja muo-
dosta siitd pysyva SAS-data nimeltd gomez_data kirjastoviittees osoittamaan kansioon.

6.6 Erikoismuuttujien sisdén lukeminen ja ongelmatapaukset

Enterprise Guide pystyy yleensa tulkitsemaan erikoisiakin muuttujia automaattisesti oikein
lukiessaan aineistoa SAS-dataksi. Jotkin muuttujat aiheuttavat kuitenkin ongelmia, jotka
pystytéan kiertdmaéan kayttamalla siséénlukuformaatteja eli informaatteja.

Tyypilliset ongelmatilanteet, jotka voidaan ratkaista informaateilla, liittyvat péivamaérien
tai aikojen siséén lukuun. Ongelmien syyné on se, ettd pdivamaarét ja kellongjat voidaan
ilmoittaa hyvin monella tavalla ja siten ohjelmakin voi tulkita niitd eri tavoin. Informaat-
tien toimintaperiaatteena on, etté niiden avulla kerrotaan ohjelmalle, miten sen tulee tulkita
siséan luettavan datan muuttujien arvot. Samalla voidaan kayttéa myos tavallisia formaat-
teja eli tulostusmuotoja, joiden avulla puolestaan kerrotaan ohjelmalle, miten sen tulee

esittda sisdan lukemiensa muuttujien arvot.
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Datan sisddn luvun yhteydessa informaatit ja formaatit vaihdetaan yhdelle muuttujalle ker-
rallaan alla olevassa kuvassa esitetylla tavalla:

525 im : - [=]x]
4 "Import Data” -solmu, joka saadaan, kun |- | @ Valitaan "Column Options’ -

| luetaan data SAS-dataksi. —1 vdlilehdella muuttuja, jolle méérite- [—
qungcassF\nw Rl il i taan |nform%tt| .

[,

=P Asign Library [ 2
=] Last Subnited Code i

uuuuu

sta
ast Submited Code T E General

=] Log
] KIR.GOMEZ_DATAA
B8 erikoismuuttuiat.«ls Taul§)
" Import Data

Display farmat DATETIME 20,
Readin format DATETIME1S, E]

GomezDala o
aul a
: P Include in output es
ik oi: Import
ati ata
& Rei f ns
teqories: nformats: _

b) Menndn
i — 000 (e ] vaihtamaan

DEUDFDEw,

. |BEn c) Valitaan listasta [+ informaattia.
MNumeric Binary ENGDFMYw, . . X X
| sopiva informaatti ja
Dverall width il = Max 32 | | mOI tet ku| nka

Decimal places: 0 3: Min: 0 Max 17

monella merkilla tieto
date value [ddmmyy]
on tallennettu.
Input
W alue: 14245 I
[ 2
Lis#tietoainformaatista. - =

Tassa tapauksessa Enterprise Guide oli valinnut jo valmiiks tilanteeseen soveltuvan in-
formaatin DATETIME18 ja vastaavan tulostusformaatin. DATETIME kuitenkin pitéa si-
sdlldan tiedon sekd pdivamaarasta etta gjasta, kun taas alkuperaisessa datassa oli ainoastaan
paivamaaratieto. Olennainen tieto tulee luettua sisddn nainkin, mutta esimerkissa vaihde-
taan informaatiks tilanteeseen paremmin sopiva DDMMY'Y 10. Formaatin nimi kertoo etta
kaikkiaan kymmenella merkilla (dd.mm.yyyy). Vaihdettaessa informaattia vaihtuu myos
tulostusformaatti automaattisesti. Sité voidaan kuitenkin myds vaihtaa informaatin vaihtoa
vastaavalla tavalla kohdassa " Display format”. Yleisimpid informaatteja ovat edelld mai-
nitun DDMMY Yw.:n lisdkss muun muassa ANYDTDTEw. (lukee monia erilaisia péiva
médrd& ja pavamaarédaka -muotoisia muuttujia péavamaaring, DATETIMEw.
(paivamaéra-aika informaatti), FIN-alkuiset (suomalaisten omia informaatteja muutamaan
paivamadrd ja paivamaara-aikatilanteeseen, katso lisétietoa informaattien description-
kohdista). Lisétietoa informaateista 10ytyy SASin manuaalista ja Slaughterin ja Delwichen

(2006) kirjasta, josta l6ytyy muun muassa kattavampi lista yleisimmisté informaatei sta.

Datan siséén lukemiseen liittyvissd mahdollisissa ongelmatilanteissa saattaa auttaa jokin
Excelissa tehtéava toimenpide. Téllaisia toimenpiteita ovat sarakkeiden tyyppien méadrittely
niiden arvoja vastaaviksi, puuttuvien havaintojen jattaminen tyhjiksi (esimerkiksi pisteiden
sijaan), muuttujan tyypin kannalta virheellisten merkkien poistaminen niiden arvoista (esi-
merkiksi numeerisilla arvoilla vélilyontien, erikoismerkkien (esimerkiks >, <, =, %) ja
kirjaimien poistaminen) sek& muuttujien nimien méaérittely oikein eli [dhinna ilman eri-
koismerkkega ja valilyontejd. Joskus ongelmia saattaa aiheuttaa my6s tilanne, jossa muut-
tujalla on paljon perdkkaisia puuttuvia havaintoja tiedoston alusta lukien. Tall6in saattaa
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auttaa, kun tiedoston alkuun tehddan ylimaarainen rivi, jossa annetaan muuttujan tyypin
mukainen arvo jokaiseen soluun. Kun data on luettu siséén, tama yliméaréinen rivi poiste-
taan. Vaihtoehtoisesti jo siséan lukemisen yhteydessa voidaan méarittas, ettd havainnot
otetaan mukaan tul osdataan vasta toiseltarivilta alkaen eli poistetaan apurivi.

Sisddn lukemisen ongelmatilanteissa saattaa auttaa myos se, etté data tallennetaan Exce-
lissd esimerkiksi DBF 4 (ABASE V) eli *.dbf -muotoon. T&ll6in Excelin taustalle tekemét
maédrittelyt poistuvat ja data tallentuu yksinkertaisesti sellaisessa muodossa kuin se nakyy
ruudullakin. Kun data sitten luetaan sisédn Enterprise Guideen tassd dBA SE-muodossa,
onnistutaan kiertamaan monia ongelmia ylimédaraisten ja mahdollisesti sisddn lukua se-
koittavien muotoilujen havittya.

6.7 SAS-datan avaaminen Enterprise Guideen

SAS-data avataan Enterprise Guideen valitsemalla” File” ->” Open” -> " Data” -> " Local
Computer”, valitsemalla haluttu SAS-data ja klikkaamalla ” Avaa’. Vaihtoehtoisesti data
voidaan hakea tietysta kirjastoviitteen osoittamasta kansiosta, jolloin valitaan "File’ ->
"Open” ->"Data’ ->"SAS Servers’.

Tehtava: Avaa Enterprise Guideen SAS-data nimeltd KetutData.sas7bdat kansiosta
C:\SAS\EGKURS.

6.8 Datojen tallentaminen Enterprise Guidesta

Enterprise Guide -projektissa oleva data voidaan tallentaa tiedostoksi. Tama tapahtuu klik-
kaamalla dataa prosessidiagrammissa hiiren oikealla painikkeella ja valitsemalla ” Export”
-> "Export datan_nimi” ja”Local Computer”. Sen jadlkeen valitaan haluttu kansio tietoko-
neelta, tiedostotyyppi alasvetovalikosta ja annetaan tiedostolle nimi. Valittavia tiedosto-
tyyppegjd ovat muun muassa *.sas7bdat (SAS-data), *.xls (Excel-tiedosto), *.dbf (dBase-
tiedosto) ja *.txt (tekstitiedosto). Tavallisen ”Export”-vaihtoehdon liséksi valittavana on
my6s vaihtoehto ” Export datannimi As A Step In Project”. Taman vaihtoehdon avulla da-
tan tallentaminen tiedostoksi saadaan pysyvaks vaiheeks prosessidiagrammiin, jolloin se
voidaan toteuttaa rutiininomaisena vaiheena projektikokonaisuuden suorittamisen yhtey-
dessi

Datat voidaan tallentamisen lisaksi myds lahettda suoraan toiseen ohjelmaan. Tama onnis-
tuu klikkaamalla prosessidiagrammin datakuvaketta hiiren oikealla painikkeella ja valitse-
malla”Send To” -> "E-mail Recipient” tai "Microsoft Word” tai "Microsoft Excel”. ” E-
mail Recipient” -vaihtoehto toimii ainakin, jos sdhkdpostiohjelmana on Outlook Express.
Sita klikattaessa sahkdpostiohjelma avaa uuden viestin ja liittéa datan viestiin liitetiedos-
tona valitussa tiedostomuodossa. ”Microsoft Word” -vaihtoehto avaa Wordin ja sijoittaa
datan word-dokumenttiin taulukkona. ”Microsoft Excel” -vaihtoehto avaa datan Exceliin.
Vaihtoehtona on myds ”E-mail Recipient as a Step in Project”, jonka avulla sdhkdpostin
|ahetys saadaan pysyvéaksi osaksi projektikokonaisuutta. Ennen tédman vaihtoehdon kéayttoa
pitda madrittad sdhkopostiasetukset Enterprise Guideen.

Tehtava: Talenna jokin projektissa olevista SAS-datoista Excel-tiedostoks.
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6.9 Projektin tallentaminen

Enterprise Guidessa kaikki tyo tallennetaan projekteina. Projekti koostuu toisiinsa liitty-
vista datoista, toimenpiteistd, tulosteista, koodeista, logi-tiedostoista ja muistiinpanoista.
Tassa kohtaa on syyta mainita, ettd projektin sisdltéamét data-kuvakkeet elvét varsinaisesti
sisdla datoja, vaan ne ovat pikakuvakkeita varsinaisiin datoihin. Niinpa datat on tallennet-
tava kansioon tietokoneelle, jos ne halutaan saastéa EG-istunnon jalkeen. Ne eivét siis tal-
lennu projektin sisdlle. SAS-datojen tallentaminen tapahtuu méadrittelemald niiden
nimeamisen yhteydessa tietokoneella olevaan kansioon osoittava kirjastoviite (pysyvaan
kansioon osoittava kirjastoviite eli jokin muu kuin "Work”), jolloin EG tallentaa SAS-da-
tan pysyvasti kyseiseen kansioon. Jos data tallennetaan véliaikaisena SAS-datana
("Work™), Enterprise Guide varoittaa ohjelman sulkemisen yhteydessa siitd, etta projekti
sisdtéa valiakaisia datoja.

Prosessidiagrammiin muodostunut projektikokonaisuus voidaan tallentaa valitsemalla ” Fi-
le” -> "Save Project As’. Taman jalkeen tallentaminen samalla nimell&a onnistuu valit-
semalla”File” -> " Save projektin_nimi” tai painamalla ngppédimistosta CTRL+S.

Jos tallennettu projekti avataan toisella tietokoneella tai tiedostot siirretééan eri kansioon,
kirjastoviite pitdd muuttaa viittaamaan uuteen kansioon. Uudessa tilanteessa viittaukset
datojen sijainteihin pitdd muuttaa myds niille datoille, joihin e viitata kirjastoviitteella
vaan jotka on avattu suoraan kansiosta projektiin ("File” -> "Open” -> "Data’, esimerkiks
Excel-datat). Viittaus muutetaan klikkaamalla prosessidiagrammin datakuvaketta hiiren
oikealla painikkeellajavalitsemalla” Properties’ -> " Change”.

Tehtava: Talennaprojektisi nimella EGkurssi_projekti.
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7 Datan muokkaus

Data pitéa yleensa olla valittuna aktiiviseks, jotta sitd voidaan muokata tai muuten kasi-
tella eri tyokaluilla. Datan saa aktiiviseksi klikkaamalla data-kuvaketta prosessidiagram-
missa, jolloin se muuttuu siniseksi. Vaihtoehtoinen tapa tehda data aktiiviseksi, on valita se
tyokalurivin ” Active Data” -valikosta.

Tassa luvussa kaydaéan 18pi seuraavat Data-valikon tyokal ut:

Data | Describe  Graph  Analyze—#d) Data muokkaustilaan
p———

Muuttujien muunnokset

Filker and Query. ..
- B Muuttujien arvojen luokittelu & luokkien yh-

= Rows distaminen
1l Columns Muuttujien poistaminen
Rivien jarjestdminen
] j‘ append Table. .,
] Sort Data... Osa-aineiston muodostaminen
% Create Format, Datojen yhdistaminen rinnakkain
G Iranspose... Datojen yhdistaminen perékkain
tzd  Split Columns. ..
Formaattien muodostaminen
Bl Stack Columns.:

il

Random Sample. .. K&antaminen yhdesta sarakkeesta useaan

Rank...

RO

e

K&éntaminen useasta sarakkeesta yhteen
¥ Standardize Data...

e . - o ) .
Data Set Attributes Datan ominaisuuksien tulostaminen

ER Compare Data. o Datojen ja muuttujien vertailu
#  Delete Data Sets and Formats,, € Datojen ja Formaattien poistaminen

7.1 Datan muuttaminen muokkaustilaan

Ennen kuin dataa voidaan muokata suoraan datamatriisissa, sen tulee olla muokkaustilassa.
Datan voi muuttaa muokkaustilaan poistamalla mahdollisen valinnan ”Data” -valikon
"Read-only” -kohdasta. Datan pitéa olla nékyvissa tyétilassa, jotta ” Read-only”-valintaa
VoI muuttaa.

Tehtava: Otatydtilaan nakyviin SAS-data gomez_data ja poista siita kirjoitussuojaus.
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7.2 Muuttujien perusominaisuuksien maarittely

Muuttujien nimig, nimien selitysteksteja ja tyyppeja paasee muokkaamaan klikkaamalla
Enterprise Guiden datamatriisissa sarakkeen otsikkoa hiiren oikealla painikkeella ja valit-
semalla” Properties’. Tall6in aukeaa” General” -vélilehti. Kohdassa”Name” voidaan muut-
taa muuttujan nimed ja kohdassa "Label” antaa muuttujale pidempi selitysteksti. Se-
litysteksti e tule ndkyviin data-matriisiin, mutta se nékyy monissa tulosteissa. Kohdassa
"Type’ voidaan puolestaan maarittéd muuttuja joko numeeriseks tai merkkimuotoiseksi.
Numeeriset muuttujat voidaan jakaa viela kohdassa ” Group” tavallisiin numeerisiin (" Nu-
kaikilla muuttujatyypeilla on omia erityisa tyokaluja, joita muuttujiin voidaan soveltaa
(informaatteja, formaatteja ja funktioita). Lisaks kullakin muuttujatyypilla on datamatrii-
sissa erilainen tunnistesymboli, jonka avulla ndkee nopeasti minka tyyppinen muuttuja on
kyseessa. Yleensa muuttujilla kdytetdan joko merkkimuotoa (symboli punainen pyramidi)
tai tavallista numeerista muotoa (symboli sininen pallo).

Tehtava: Maaritd gomez_dataan suomenkieliset muuttujien nimet ja selitystekstit seuraa-
vasti:
Muuttujan nimi (Name):

- Variety -> lgjike

- Nitrogen -> typpi

- Rep->lohko
- Yield->sato

Selitysteksti (Label):
- lgike-> Riisilgike
- typpi -> Typpitaso (kg/ha)
- lohko -> Lohko
- sato -> Hehtaarisato (kg/ha)

7.3 Muuttujan arvojen tulostusmuotojen eli formaattien kaytta-
minen

Formaattien kayttssa on tilanteesta riippuen kaks tapaa. Joillakin muuttujilla voidaan
kéyttda Enterprise Guiden vamiita formaattegja. Niitd 10ytyy esmerkiksi useille ailka- ja
paivamaaramuuttujille. Monille muuttujille kayttgan taytyy kuitenkin itse maéritella eri
arvoihin liittyvét selitteet. Nain on, jos esimerkiksi halutaan suomenkieliset selitystekstit
arvoillel ="kissa ja2 ="koira .

Seuraavaks kadydaan 18pi, miten formaatti voidaan muodostaa ja miten itse muodostetun
tai valmiin formaatin voi yhdistaa johonkin muuttujaan.
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Formaatin luominen

Formaatteja paasee tekemaén klikkaamalla " Data” -> " Create Format”, minka jakeen
"Options’-vélilehdella méaritelldén formaatin nimi, tyyppi (ovatko arvot datassa merkki-
muotoisia vai numeerisia) jatallennuskohde:

“Dptions | Options
Define t . .
e Format name: Format t Val Itaan yhd'S'
o ; ype sere 1 ae
[lohkof : () Character — tetdanko for-
A " @ Humsiic maatti
/j Specify format width [ Specify fuzz factar merkkl mLIOtOi -
. | =] [E2 | | seen vai nu-
Formaatin nimi | meeriseen
e ranmEiee | muuttujsen.
Cean "fuzz factor”, the format considers it a
- match.
[Lacal _\;.
s - | Tassa kannattaa  yleensa
B ¥ kayttda valmista SASUSER-
Kirjastoviitettd, koska itse
luodut Kirjastoviitteet eivét
toimi  kunnolla formaattien
— _ kanssa. .
Specify whether you are creating a character format or [ floating-point storage,
| | a numeric format is applied with a fuzz factor,
.Y_ou vzt define & valid format.

Kun formaatti tallennetaan SASUSER-kirjastoviitteen avulla pysyvdan kansioon, se tal-
lentuu formaattitiedostoksi ja on aina kdytettévissd, koska SASUSER kirjastoviite yhdistyy
automaattisesti kun EG kaynnistetéan. Tiettyihin muuttujan arvoihin liittyvéat selitetekstit
méadritellaén " Define Formats® -vélilehdel 1&
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Create Format

1) "New Label” -painikkeesta
3) Kun yhddlle arvolle |- p;astaan méz'a'rittérgéén arvolle
on maitetty selitys | i 1 selitystekstia. Teksti- kirjoite-
teksti, uutta pé&dstéan ) [Corko taan kohtaan ” L abel”
méaarittamaan  klikkaa ekl :
malla uudelleen "New \

Label". Valm“t maant' | Mew Label J
telyt ndkyvét ylareunan Lok

listassa. :'_I;ohk-o I

" :;I:Is:;;:;tea:r;n%”IGHHD Type Walues

LI

[ Remaove Label

Discret w3 }
5. Repeat steps 1-4 for each iscrete

value label \
ﬁ Iz £, 3 L.

2) Arvo, johon sdlitysteksti yhdistetdan, paés-

tédn antamaan "New Range’ -painikkeesta.

"Type’-kohdassa voi valita selitystekstin méa-

ritettavaksi yksittaisen arvon sijaan arvovélille, | | Newhange || Remove fange
s Arvo tai arvovdli Kkirjoitetaan kohtaan "Va '

] ol | lues'.

. — - _ j ’ Cancel ] [ Help

o

Lopuksi formaatti luodaan valitsemalla” Run”. ” Save’-valinnan avulla voi tallentaa valin-
nat kuitenkaan viel& suorittamatta tehtvaa.

Formaatin yhdistdminen muuttujaan

Ensin tulee varmistaa etta data el ole "Read-only” -tilassa. Formaatit yhdistetéén muuttu-
jaan klikkaamalla hiiren oikealla painikkeella muuttujan nimeé ja valitsemalla ” Proper-

formaatit. Valmiit formaatit [6ytyvat muista kategorioista. Kun formaatti on valittu, paine-
taan "OK” ja muuttujien arvot muuttuvat data-matriisissa maaritetyn formaatin mukaisiksi.
Tyypillisia muuttujia, joille méaritetédn valmis formaatti, ovat erilaiset aika- ja paivamaa-
rémuuttujat. Kayttokelpoisia lahinna paivamaariin liittyvia formaatteja ovat muun muassa

laiset FIN-alkuiset formaatit (suomalaisille réétél ityja formaatteja).
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Vélilehdella " Formats’ voidaan myds maarittéa naytettavien desimaalien maéra numeeri-
sen muuttujan arvoille kayttden w.d-formaattia:

Eererel Formats
IFfarmats Lategories: Farmats:
Confirm Options | | None RETDOMY w. A
RSTOONTMw.d
Drate RSTDOPHw.
Tirne: RSTOOPNYw.d
D ate/Tirne RSTDOFMNw.d
Currency RSTDOFYYw.d
Uszer Defined RSTDOZPw.
&l SIZEKBw.d
SIZEKMGw.d
SIZEKwd
S5Mw.
LIM<EPOCHw.
v d o
Attributes . . .
Dvverall width: 8 =] Min 1 Max 32 Useilla fﬂfm?ate'”a voI-
Decimal places: 2 3: M0 Wax 7 daan i maarata formaa_tln
lisdks muuttujan arvoille
b ipti .. . .
e kentan leveys ja desimaa-
standard numeric format X e
lien méara
Example
Walue: 1231
Output: | | [T]2]3] [7]0]
1 v tore [F1]...
[ ]S ] [ Cancel ]

Tehtdva: Muodosta gomez_datan lohko-muuttujan arvoille 1, 2 ja 3 selitystekstit:

1="Lohko I"
2="Lohko II”
3="Lohko 11"

Luo formaatti ja yhdista se muuttujaan lohko. Tarkastele datamatriisista, onnistuiko seli-
tystekstien lisd8minen muuttujan arvoille.

7.4 Datan muokkauksen tydkalut

Enterprise Guidessa ensisijainen aineiston muokkaustytkalu on Query Builder, joka on
erédnlainen kyselytyokalu ("kysely”-sana tulee SQL-ohjelmointikielestd, koska Query
Builder kayttdd SASin PROC SQL:&4). Kysely-sanalla viitataan siihen, etté tyokalun avul-
la tehdéén dataan kysely ja tuloksena saadaan uusi muokattu data. Naiden kyselyjen avulla
voidaan muodostaa osa-aineistoja, luoda uusia muuttujia seka jérjestda ja yhdistaa aineisto-
ja. Query Builderilla tehdédén siis tavallista datan muokkausta. Kaikkea datan muokkausta
e kuitenkaan pystytd tekemddn Query Builderilla, vaan tarvitaan my6s muita Data-
valikosta |6ytyvia tyokaluja. Monet asiat voidaan kuitenkin tehda sekd Query Builderilla
ettajollakin vaihtoehtoisella tavalla.

Kun muokataan olemassa olevaa dataa (uusien muuttujien tekeminen, muuttujien poista-

minen, havaintorivien lisddminen ja poistaminen sekd& muuttujien uudelleennimeaminen),
kannattaa yleensa kayttda Query Builderia. Query Builderin vahvuutena on, ettd alkuperai-
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nen data sdilyy koskemattomana ja tuloksena syntyy uusi muokattu data (samoin voi tehda
tavallisessa SASissa). Tall6in datan muokkauksesta jda myds dokumentti EG-projektiin ja
muokkauksia voi tarkastella Query-tehtavasolmusta jalkikéateen.

Enterprise Guidessa voidaan kayttéa my6s niin sanottuja datamatriisin perustoimintoja
sarakkeita ja rivgja voidaan liséta ja poistaa samaan tapaan kuin Excelissg, €li kohdista-
malla toimenpiteet suoraan datamatriisiin jonkin tyokalun sijasta Nama toiminnot ovat
suoraviivaisempia ja helppokayttisempia kuin Query Builder, mutta niiden kanssa pitéa
olla varovainen, koska muutokset kohdistuvat suoraan alkuperdiseen dataan ja muutoksista
e j&a projektiin dokumenttia. Niinpa ndiden kéytdssa on sama vaara kuin Excelissg, eli
dataa saattaa vahingossa havitad ("Edit” -> "Undo” -toimintokaan ei auta). Myos téysin
oikein tehdyissa datan muunnoksissa dokumentointi j&a perustoimintoja kaytettédessa kayt-
massa uutta dataa Enterprise Guidessa tai luomassa tallennuspohjaa. Jos kuitenkin halutaan
kayttd& niin sanottuja perustoimintoja datan muokkaukseen, kannattaa ehdottomasti ottaa
datasta varmuuskopio ennen muokkausta. Varmuuskopiointi onnistuu esimerkiksi klik-
kaamalla datakuvaketta hiiren oikealla napillaja valitsemalla” Export”.

Dataa paastéan muokkaamaan Query Builderilla valitsemalla ensin muokattava data aktii-
viseks prosessidiagrammista (klikataan hiirella siniseks) ja klikkaamalla” Data” -> " Fil-
ter and Query”, jolloin aukeaa seuraava nakyma:

# Query for KIR.GOMEZ_DATAA - Query Builder X
(Ee e Huery for KIR GOMEZ_DATAA Qutput name: KIF:. Query_for KIR_GOMEZ_DATAS,

[ Computed Columnz  [55 Parameters | Walidate - [} Preview [#] Options @

||‘jAddIables... < Delste By Join. | FelectData | Fiker Data | Sort Data

= EE GOMEZ_DATAA Calumn MHame Input Surmary
A ke [ Riisiajice ] i lajike [Risiajke] GOMEZ_DATAA lajke
{2 typri [ Typpitaso (kaha) ) i typpi (Typpitasa (kgshal]  GOMEZ_DATAA byppi
@ lohko [ Lohka) i@ lohka [Lohke) GOMEZ_DATAA lohko

@ sato [ Hehtaarisato (kathal ) @ sato (Hehtaarisato [kg/.. GOMEZ_DATAML sato

Summary groups

[ Automatically select groups Edit Groups..

Mo groups selected

[ 5elect distinct rows only

Bun l[ Sawe and Cloze l[ Cancel l[ Help ]

31



Query Builderista |6ytyy muun muassa seuraavaa:

Select Data -vélilehti Lopputuloksena syntyvaan dataan mukaan tulevat muuttujat.
Tassa voidaan myos tehda tiettyja muuttujiin liittyvia toimenpi-
teitd. Useimmiten "Tools” -> "Options’” -> "Query” -valikosta
kannattaa tehda valinta” Automatically add columns from input
tables to result set of query”, jotta tulosdataan saadaan akupe-
réi sesta datasta lahtokohtai sesti kaikki muuttujat mukaan.

Filter Data -vélilehti Muodostetaan osa-aineistoja eli valitaan jonkin tai joidenkin
ehtojen mukaan tietyt rivit mukaan dataan.

Sort Data -valilehti Aineiston rivien jarjestdminen jonkin tai joidenkin muuttujien
arvojen mukaiseen jarjestykseen.

Computed Columns Uusien muuttujien tekeminen vanhoista muuttujista luokittele-
mallatai funktioiden tai aritmeettisten operaatioiden avulla.

Join Kahden tai useamman aineiston yhdistdminen rinnakkain
siten, ettéd samoille riveille el tilastoyksikdille tulee muuttujia
useista aineistoista.

Query Builderissa luotu kysely dataan suoritetaan valitsemalla "Run”, mutta sitd ennen
kannattaa yleensa antaa tuloksena syntyvélle SAS-datalle nimi klikkaamalla oikeassa yl&
kulmassa olevaa ” Change”-valintaa. Valitsemalla ” Save and Close” voi talentaa kyselyn
suorittamatta sitéd. Tulosdataa voi myds esikatsella ennen kyselyn suorittamista painamalla
"Preview”.

Tehtava: Tutki data-valikkoa ja avaa Query Builder (gomez_data aktiivisena). Tarkastele
Query Builderia.

7.5 Muuttujien muunnokset ja uusien muuttujien tekeminen

Muuttujien muunnoksia voi tehda Expression Editorin avulla. Téhan tyokaluun paéstééan
kasiks Query Builderin kautta siten, etta valitaan muokattava data aktiiviseks ja klikataan
"Data”’ -> "Filter and Query” ja valitaan Query Builderista " Computed Columns’ ->
"New” -> "Build Expression”. Expression Editorissa voidaan tehda uusia muuttujia seka
tavallisten laskutoimitusten avulla etté kéyttamalla valmiita funktioita. Nakyma Expression
Editorissa on seuraava:
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£5 Advanced Expression Editor @

Eupression tewt:

Expression Editorin tydtila, jossa muo- Pikapainikkeet (mm.

dostetaan uusi muuttuja perusl askutoimitukset)
()LL) femeJ{on Jivor ) (= JCe L e J0=J0=) Lo e LoD
[ LClear Expression ] [ Add to E xpression ]

Data ¥ unclions

\ﬁsfai'lﬁée variables: Wariable values:
= Ei GOMEZ_DATAA Varable Names  Varable Labels

A lailke A lajke Rislajike

@ topri {23 typpi Typpitaso (kg/ha)
@ lohko @ lokk Lok

& seto okko ohkio

zato Hehtaarizata [karha)
/ Get More Yalues

Tastd voidaan siirtéa datassa olevia muuttujia
kéaytettéavaks tyotilassa.

[ (]S ] ’ Cancel ] ’ Help ]

A

Klikkaamalla valilehted ” Functions’ saadaan oikeaan reunaan nékyviin kéytettavissa ole-
vat valmiit funktiot, joita voidaan siirtéa tyotilaan:

£ Advanced Expression Editor

Ewpreszsion tbest:

CJECI0AE] Leno]Cor o ) =)0 L =0 0= Mol OB
[ Clear Expreszion l [ Add to Expression ]
[rata m

Categories; Functions:

All Funchions » ABS A
Aggregate T AlRY 0
Arithmetic ARCOS

Bitwize Logical Operations ARSIN

Character ATaN

Character String Matching B ATTRC

Conditional ATTRM

[rata Cluality [requires SAS /DRLALITY) ANG A}

Date and Time ANG {Digtinct}

DBCS BAMD

Descriptive Statistics ~ BETAIMY w

[ 1] ] [ Cancel ] [ Help l
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Muuttujien nimig, valmiita funktioita seka vélilehtien yldpuolella olevia pikapainikkeita
kayttamalla voidaan vanhoja muuttujia muuntamalla tehdéa uusia muuttujia. Muunnoksen
voi my0s kirjoittaa suoraan ylareunan tyétilaan, jos tiedetdan kaytettavien funktioiden ja
muuttujien nimet. Kun muuttujan nimi haetaan listasta, se tulee ty6tilaan muodossa, jossa
muuttujan nimen edessa on myds datan nimi. Datan nimi e kuitenkaan ole valttaméton, jos
muuttujan nimi Kirjoitetaan ty6tilaan kasin listasta hakemisen sijaan. Alla on esimerkkeja
muutamista muunnoksi sta:

L ogaritmimuunnos. LOG(sato)

Muuttujan arvot muunnetaan (luonnolliselle) logaritmiasteikolle siten, ettd haetaan ensin
LOG-funktio funktiolistasta ja lisétéén se tydtilaan ("Add to Expression”). Seuraavaksi
poistetaan tydtilassa LOG-funktiosta kaikki ylimaérainen (eli "<numValue>") sulkujen
sisdltéjalisdtéén sen paikalle sato-muuttuja (valitaan ” Data’ -véilehdelta ja klikataan ” Add
to Expression” tai kirjoitetaan suoraan sulkujen sisélle ” sato”).

Neliojuurimuunnos: SQRT (sato)
Funktio ja muuttujan nimi haetaan listoilta samoin kuin edellisessa esimerkissa.
Aritmeettinen muunnos (esim. sato tonneissa): sato/1000

Muuttujan nimi voidaan taas hakea listalta, jakolaskuoperaattori 10ytyy pikapainikkeista ja
luku 1000 syotetédn kasin.

Lopuksi painetaan OK, jolloin palataan Computed Columns -ikkunaan, jossa voidaan antaa
tuloksena syntyvélle uudelle muuttujalle nimi valitsemalla " Calculationl” (tai vastaava
listalla oleva uuden muuttujan nimi) ja klikkaamalla " Rename”. Taman jalkeen painetaan
"Close”. Lopuks painetaan ”Run”. Query Builderista jé& myds oma tehtévakuvake proses-
sidiagrammiin, josta muunnoksia paasee halutessaan myéhemmin muokkaamaan. Query
Builder luo tuloksena aina uuden datan, johon muunnosten avulla luodut muuttujat on li-
sétty. Jos halutaan itse valita tuloksena syntyvan datan nimi ja kohde, johon se tallennetaan
(kirjastoviite), sen voi tehda Query Builderissi klikkaamalla oikeassa yldkulmassa olevaa
"Change’-valintaa, jossa ” Save in:” -kohdassa voi valita kirjastoviitteen ja ”File name:” -
kohdassa tuloksena syntyvan SA S-datan nimen.

Jos mydhemmin halutaan palata muokkaamaan muuttujan méadrittelyd, se onnistuu klik-
kaamalla prosessidiagrammista auki tehtévasolmu, jossa méarittelyt on tehty, klikkaamalla
”Computed Columns’, valitsemalla listasta muuttuja, jonka méaarittelya halutaan muokata,
javalitsemalla” Edit”. Kun muokkaus on tehty, pitéd tehtéavasolmu suorittaa uudelleen va-
litsemalla Query Builderin pddnakymassa” Run”.

Tehtava: Tee gomez_dataan uudet muuttujat tsato (sato tonneina) ja sqrt_sato (sadon ne-
liGjuuri). Kayta tahan Query Builderia. Anna tulosdatalle nimeksi gomez_muok.
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7.6 Muuttujien luokittelu ja luokkien yhdistaminen

Jatkuvien muuttujien arvojen luokittelu ja kategoristen muuttujien luokkien yhdistaminen
voidaan my0s tehda Query Builderin avulla. Molemmat tehddan kayttden samanlaista tek-
niikkaa. Seuraavassa esitetéan, kuinka jatkuvan muuttujan arvot saa luokitetuksi.

Ensin avataan Query Builder ("Data” -> "Filter and Query”) aktiiviselle datalle. Liik-
keelle |8hdetdén aivan samoin kuin muunnoksissa eli ensin valitaan ” Computed Columns’
-> "New”, mutta sitten valitaankin "Recode a Column” ja aukeavasta listasta muuttuja,
joka luokitellaan. Seurauksena aukeaa ” Recode Column” -ikkuna, jossa muuttujan luokit-
telu méaritelldan. Klikkaamalla " Add” saadaan lisdttya yhden luokan méérittely kokonai-

Suuteen:

£ Specify a Replacement Valitaan "Replace a
range”.
Replace Valueg| Feplace a Rangs Nuoli-painikkeista saa-
daan nakyviin lista al-
[/] Set a lawer limit Voidaan méaarit- kuperdisen  muuttujan
4000 taa kuhunkin E]A/ arvoista
luokkaan kuulu-
Set an upper limit; V:en . a;VOJQn /
ar arga - .
8832 yrras. A (] Huomaa, ettd numeerisen
tai molemmat. :
muuttujan  puuttuvat  arvot
With Hhis el koodataan pisteelld.  Sen
o Téssaméritetdan uusi arvo. avullavol asettaa esimerkiks
virheellisen mittauksen puut-
Tip: Mizsing walues are represented by a period. \ tuvaksi. Merkkimuotoisella
|| muuttujalla puuttuvat jate-
téan tyhjiksi.
]S ] [ Cancel ] [ Help Lﬂ yh
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Kun kaikki luokat on méaritelty, nakyy kokonaisuus ” Recode Column” -ikkunassa:

' Recode Column - GOMEZ_DATAA.sato Tuloksena syntyvéle uudelle
muuttujalle voidaan antaa nimi

Mew column name: zato ” ”
kohdassa” New column name”.
Replacements: Al
Replace With
1380...3999 1]
4000...8832 1
Tassd voidaan maérittaa kaik-
ki ehtoihin sopimattomat ar-
vot esimerkiks puuttuviksi
havainnoiksi. Alla méaérite-
Other values . .
taan puuttuva tieto korvatta-
Replace all ather values with: vaks luvulla, joka varmasti
() The curent value erottuu todellisista arvoista
() A mizzing value
(%) Thiz value: 9995995999

Tulosmuuttujan tyypiksi voi-
daan valita muu kuin 18ht6-
() Character () Mumeriz | muuttujan tyyppi.

[ k. H Cancel ” Help ]J

Lopuksi painetaan ”OK”, ”Close” ja” Run Query”.

M ew colummn type

L uokittelumuuttujan luokkien yhdistaminen voidaan tehda aivan samalla tavalla kuin jat-
kuvan muuttujan arvojen luokittaminen, mutta yl& ja alargjoiks tulee vain alkuperéisen
luokkamuuttujan arvoja. Vaihtoehtoisesti voidaan kayttda toimintoa ” Replace”, jolla voi-
daan korvata yks arvo kerrallaan toisella arvolla. Pelkkda ” Replace”-toimintoa kayttéen
gomez_datassa voidaan yhdistda lgjikkeet IR5 ja IR8 yhdeks lgjikkeeks IR (”Replace
Values’ -kohtaan on péasty samoin kuin edell& jatkuvan muuttujan arvoja luokitel taessa):
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i Specify a Replacement Té&ssa voidaan samalla méaritella mo-

lemmat IR5 ja IR8 korvattavaks IR:Il&
Foplace Vales | Replace a Range Arvot voi joko hakea listasta Klikkaa-
IRS . . . .
IR& malla "Get Values’ tai kirjoittaa itse.
Muista, eftd viitattaessa merkkimuotoi-
seen arvoon pieni kirjain ja iso kirjain

P ovat eri asia.
Wwiith thiz value:
IR

Tip: Mizzing values are represented by an empty string.

I 0k ]’ Cancel ]’ Help

A
Lopuksi " Recode Column” -ikkuna néyttaa seuraavalta:

# Recode Column - GOMEZ_DATAA. lajike X
Mew column name: ik zyphd
Replacements: S
Replace With
IRG IF
IRg IR
Other values

Feplace all other values with:

() The curent value

- Korvataan muut lgjikkeet nykyisel-
© & missing value |4 arvollaan, koska muiden lgjik-
O This value: keiden nimet eivéat muutu.

Mew column type

() Character ) Mumeric

| ok || cace |[ Hep |

Lopuksi painetaan ”OK”, "Close” ja” Run Query”.

Luokkien yhdistamista voi tehda myos ”Expression Editorin® ("Computed Columns® ->
"New” ->"Build Expression”) avulla kayttden Case-When-rakennetta (funktiolistassa CA-
SE {short}). Rakenteen kayttéd voi harjoitella essmerkiksi seuraavien tehtévien yhtey-
dessa. Lisdtietoa aiheesta |6ytyy muun muassa kirjasta VVahlberg ym. (2006).

Jos muuttujan méarittelya halutaan palata muokkaamaan myoéhemmin, se onnistuu klik-
kaamalla prosessidiagrammista auki tehtévasolmu, jossa méarittely on tehty, klikkaamalla
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”Computed Columns’, valitsemalla listasta muuttuja, jonka méaarittelya halutaan muokata,
javalitsemalla” Edit”. Kun muokkaus on tehty, tehtdvasolmu pitda suorittaa uudelleen va-
litsemalla Query Builderin pddnakymassa” Run”.

Tehtava: Tee gomez_dataan uus sato-muuttuja, joka saa arvot 1 ja 2 seuraavasti:

1 ="ale 4000 kg/ha"
2 ="4000 kg/hatai enemman”

Tehtava: Tee gomez_dataan lgjike-muuttujasta uusi muuttuja lgj_tyyppi, jossa lajikkeet
Saavat seuraavat arvot:

IR5 -> IR
IR8 -> IR

C4 63->C4 63
Peta -> Peta

7.7 Muuttujan luominen aritmeettisella operaatiolla

Toisinaan on tarpeen luoda muuttuja, jonka arvo on osalle riveista samatai kaikille riveille
yhteinen vakio. Esimerkkina tilanne, jossa kaikilla riveilla on sato-muuttujan keskiarvo.
Tallaisen vakion luominen onnistuu Query Builderin (" Data” -> "Filter and Query”)
"Select Data’ -vélilendella. Klikkaamalla Query Builderissa ”Select Data’ -vélilehdelta
solua, joka on ” Summary” -sarakkeen ja satomuuttujan rivin risteyskohdassa, saadaan né-
kyviin seuraava valikko:

&£ Query for GOMEZ_MUOK - Query Builder,

Query name: Query for GOMEZ_MUOK Qutput name: KIR.GOMEZ_MUDKZ

[ Computed Calumns 3 Parameters @ Yalidate - [ Preview [#] Optians -

‘ 4 Add Tables... X Delete  EgJoin. | SelectData | Fiker Data | Sort Data

= EEE GOMEZ_MUOK Coalurmn Mame Input Summary
£ Naike [ Riisilsiike £y Laijike (Riisilaiike) GOMEZ_MUOK.lajke
{2 teppi [ Typpitaso [kasha) ) @ typpi [Typpitaso (kgshall  GOMEZ_MUOK. typpi
{2 lohka [ Lohko ] (@ lohko [Lohke) BOMEZ_MUDK.lokko
%raml @ sato GOMEZ_MUDK. sato NONE v
S @@ lngsatn GOMEZ_MUOK. logsato MOME V-
%fﬂiﬂ”ﬂ; @) sataiok GOMEZ_MUDK. satoluck | SUIM
ey A lejikeyhd GOMEZ_MUDK.lajkeyhd 4G
COUNT
FREQ
Jos valitaan esimerkiks "MEAN”, sato-muuttujan / M s a4
tilalle tulee sarake, jonka arvona on kaikilla riveilla

satomuuttujan keskiarvo. Taldin akuperdinen sato-
muuttuja haviaé tul osdatasta, mutta se voidaan raahata
takaisin tulosdatan muuttujalistaan vasemmalla ole-

vasta lahtodatan muuttujalistasta.

Jos esimerkiksi keskiarvot halutaan ryhmittéin, niin /
ryhmittelevd muuttuja tai muuttujat voidaan valita
klikkaamalla” Edit Groups’.

Bum N REL and Cloze ][ Cancel l[ Help ]

Tehtava: Tee gomez_dataan uusi muuttuja, jonka arvot ovat lohkokohtaisia satokeskiar-
voja. Ota my0s alkuperdinen satomuuttuja mukaan tul osdataan.

38



7.8 Muuttujien poistaminen

Muuttujien poistaminen kannattaa tehda Query Builderin (" Data” -> " Filter and Query”)
avulla seuraavasti: valitaan " Select Data” -vélilehdella muuttuja ensin aktiiviseks ja sitten
pai netaan oikeassa reunassa olevaa X -painiketta.

Tehtava: Poista edellisissi tehtévissa tehdyt luokka-muuttujat ja satokeskiarvomuuttuja.

7.9 Muuttujien jarjestyksen vaihtaminen datassa

Muuttujien jarjestyksen vaihtaminen onnistuu myés Query Builderin (" Data” -> " Filter
and Query”) "Select Data’ -valilehdella. Muuttujan paikkaa voi vaihtaa listassa ja siten
my0s tulosdatassa klikkaamalla muuttuja aktiiviseks ja painamalla oikeassa reunassa ole-
viavalintapainikkeita, joissa nuolet osoittavat aasjaylos.

Tehtdva: Harjoittele muuttujien jarjestyksen vaihtamista kayttéen edellisen tehtévan tul ok-
sena Saatua dataa.

7.10 Datan havaintorivien jarjestaminen

Datamatriisin selaamista ja asioiden hahmottamista helpottaa usein, jos havaintorivit jar-
jestetdan jonkin muuttujan arvojen mukaan esimerkiksi suuruusjérjestykseen tai aakkos-
jarjestykseen. Havaintojen jarjestdminen e ole Enterprise Guidessa kuitenkaan yhta
tarkeda kuin perus-SASissa, koska EG osaa padasiassa jarjestéa datan automaattisesti, jos
jokin tehtéva sitd vaatii. Kuitenkin esimerkiksi ”Line Plot” -kuvissa eli viivakuvissa taytyy
itse jarjestda aineisto vaaka-aksdlille tulevan muuttujan mukaan, jotta viivat kulkisivat jat-
kumona vasemmalta oikealle (asiasta liséé kappal eessa Viivakuva (L ine Plot)).

Jérjestdminen voidaan tehda EG:ssa joko Query Builderin avulla tai kayttden tyokalua
"Data’ -> "Sort Data’. Tassa kaytetddn kuitenkin Query Builderia, koska silloin voidaan
yhdistda yhteen kyselyyn useita datan muokkaustoimenpiteitd. ” Sort Data’ -tydkalussa on
kuitenkin ominaisuuksia, joita Query Builderin vastaavasta el 10ydy, joten siihenkin kan-
nattaa tutustua.

Query Builderissa uusi kysely saadaan auki valitsemalla ” Data” -> " Filter and Query”.
Jos taas halutaan muokata jo olemassa olevaa kyselyd, se onnistuu tupla-klikkaamalla pro-
sessidiagrammissa olevaa " Query” -tehtéavasolmua. Jérjestaminen tehdéén siten, etta va
semmalla olevasta muuttujalistasta raahataan ” Sort Data” -vélilehdelle se muuttuja tai ne
muuttujat, joiden mukaan jarjestéminen tehddan. Taman jalkeen valitaan ” Sort Direction” -
kohdasta joko ”"Ascending” tai "Descending”, riippuen halutaanko nouseva vai laskeva
rivien jarjestaminen. Muuttujien jarjestys " Sort Data’ -vdlilehdella méarittelee muuttujien
priorisoinnin jarjestdmisen yhteydessa. Rivit laitetaan ensin jarjestykseen ensmmaisen
muuttujan arvojen mukaan ja sitten ensimmaisen muuttujan kunkin arvon sisélléa toisen
muuttujan arvojen mukaan.

Tehtava: Jarjesta edellisessa tehtévassa kadytetyn aineiston rivit suuruusrjestykseen suu-

rimmasta pienimpaédn sadon mukaan. Tee jérjestaminen muokkaamalla edellisessa tehté
véassa luotua tehtavasol mua.
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7.11 Osa-aineiston eli tiettyjen havaintorivien valitseminen

Data taytyy usein jakaa osiin, kuten esimerkiks silloin, kun halutaan valita mukaan ana-
lyysiin vain tietty osaryhmé koko datasta. Osittaminen voidaan toteuttaa méarittamalla
tietty havaintojen valintaehto Query Builderissa. My6s useissa mythemmin |8pikaytavissa
aineistoa kuvien tai tunnuslukujen avulla havainnollistavissa EG:n tyokaluissa voidaan
maéaritella " Group analysis by” -muuttuja tai vastaava, jonka avulla saadaan tehdyks tar-
kastelut erikseen muuttujan kunkin luokan maérittelemélle osaryhmélle.

Havaintorivien poistaminen kannattaa Enterprise Guidessa tehda kayttéen Query Builderia
("Data” -> "Filter and Query”), koska tal6in muutoksista j8a jalki, josta voidaan seu-
rata, mitd muutoksia on tehty, ja tarvittaessa palata alkuperaiseen dataan. Dataa karsitaan
Query Builderin "Filter Data” -vdilehdella Tama tapahtuu raahaamalla muuttuja, johon
karsintaehto halutaan kohdistaa, vasemman reunan laatikosta " Filter Data” -ikkunaan. Tél-
|6in aukeaa seuraava ehdon asettamisikkuna:

"Operator’-kohdan valintaikkunasta
|6ytyy erilaisia ehto-operaattoreita. Alasvetovalikon
T, \ T OO T kautta pmm ka_

Operator; Mot equal to S|kS| mUUttujien. ni-
miin ja arvoihin,

joita voidaan kayttaa

"Value’-kohdassa

[

Walle: T aawvett
/

"Value’-kohtaan voi kirjoittaa muut-
tujan arvon, johon ehto kohdistuu.

Filter definitian - ] ..
WILJZ006.rimi <> Taaveti «——| Merkkimuotoiseen arvoon vii-

tattaessa arvon pitéd olla " Filter
definition” -ikkunassa yksinker-
taisten lainausmerkkien sisdll,

[v] E alues in quotes joten merkkimuotoisilla muut-

m\ tujilla kannattaa yleensa pitéa
ruksi valintaruudussa " Enclose
valuesin quotes’.

I T TT - ]
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Kun klikataan " OK”, ehtolause tulee nakyviin "Filter Data’ -vélilehdelle:

€ Query for KIR.¥ILJ2006 - Query Builder g|
Query name: Query for KIRWILIZ006 Output name: KIR.Querny_for_KIR_YILJI2006 LChange...
i Computed Cobmns (5 Paral - ENtolauseessa méaéritell&8n, etta pidetddn ne ha- -
vainnot, joissaviljelijan nimi ei ole " Taavetti”.
| E Add Tables..
E EE Vluzuus TTET T T 8 ==

i id(id] BALTZO0E, rimi <> ™7 agvefl”
A, v [ i )
@ sukup [ sukup) Ehtolauseen voi madritella vasemmalta rashaa- ;

peltoa [ peltoa ) . .. . . .
%nautoia[nautoia] misen sijasta myos klikkaamalla oikeassa reu- x

@) metsss [metsaa) nassa olevaa painiketta. Vaihtoehtoina on ”"New

@ tuotsuun [ tuotsuun |

&@ paino (paino Filter” (sama kuin edella l&pikayty) ja "New
@ pituus [ pituus ] Advanced Filter” (Expression Editorissa méarit-
@ ka[ika]

@ tulat [ tulat ] tely)

@ aianmuk [ sianmuk )
{2 tulevais [ hlevais )

Filter the summarized data M aarltel tya ehtOI ausetta
padsee muokkaamaan valit-
semalla sen  aktiiviseksi
"Filter Data’ -ikkunasta ja
klikkaamalla oikean reunan |
painiketta.

[ Bun l[ Sawe and Cloze l[ Cancel l[ Help ]

Havaintojen suodatuksessa voidaan myds kayttéd useampaa kuin yhtd muuttujaa. Talldin
tarvitaan AND (ja) tai OR (tai) -ehtoja tai molempia. Voidaan esimerkiksi méaritellg, etta
poistetaan sellaiset henkil6t datasta, jotka ovat Jokioisista ja tydskentelevdat MTT:ssa tai
vaihtoehtoisesti voidaan poistaa henkil6t, jotka ovat Jokioisista tai tyoskentelevét
MTT:ssd. Jos ylla olevaan ikkunaan méaéritetddn useampi ehto, ohjelma yhdistda ehdot
misoperaattori (AND tai OR). Tama onnistuu klikkaamalla ” Combine Filters’ -painiketta,
jolloin aukeaa seuraava ikkuna:

41



& Filter Combination

P-ep

WILJ2008.... WILJZ00E....
<» "Taave... =1

Klikkaamalla ”AND”-kohdassa saa-
daan esiin valikko, josta voidaan vaih-
taa ehto " OR”-ehdoksi.

P

Meww Filter

< >
WILI2006. nirni <> T aavett' AND WILI2006. sukup =1

[ (] H Cancel H Help ]

A

Tehtava: Ota kayttéon aineisto Viljelija2006.xIs omalle valilehdelleen prosessidiagram-
miin. Tee Siitd ensin kirjastoviitteen kir osoittamaan kansioon pysyva SAS-data nimelta
vilj2006. Muokkaa dataa poistamalla poikkeava havainto nimelta Taavetti ja tallenna tu-
losdata pysyvana SA S-datana nimella vilj2006_muok.

Tehtava: Tehdadan vilj2006_muok-aineistosta kolme erillista osa-aineistoa, jotka tallenne-
taan myochempaa kayttoa varten erillisind SA S-datatiedostoina. Tee ensin kysely, jossa otat
vilj2006_muok-aineistosta mukaan muuttujat id, nimi, sukup, paino, pituus ja ika, ja tal-
lenna data kirjastoviitteen kir osoittamaan kansioon nimella vilj_tiedot (ks. luku M uuttu-
jien poistaminen). Tee uusi kysely vilj2006_muok dataan ja ota tuloksena syntyvaan
uuteen dataan mukaan muuttujat id, peltoa, nautoja, metsaa, tuotsuun, tulot, ganmuk ja
tulevais, ja tallenna data kir-kirjastoviitteen osoittamaan kansioon nimella tila_tiedot. Va-
litse nyt aktiiviseks datavilj _tiedot jajaa se kahdeks erilliseksi dataks siten, ettd ensim-
maiseen tulevat naiset (sukup = 2) ja toiseen miehet (sukup = 1). Tee datoista pysyvia ja
annaniille nimiksi vilj_nainen javilj_mies.

7.12 Kahden tai useamman datan yhdistaminen

Usein tutkimusaineistot on syysta tai toisesta tallennettu monena erillisend datana, mutta
esimerkiksi tilastollista kasittelya varten ne pitéd saada yhdistettya. Enssmmainen mahdol-
linen tilanne on sellainen, jossa yhdistettavissa datoissa on samat muuttujat, mutta havain-
not ovat jakautuneet erillisiin tiedostoihin. Tal6in datat yhdistetdan perékkain. Rinnakkain
sen sijaan yhdistetdan, kun useammassa eri datassa on havaintoja samoiltatilastoyksikoilta,
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mutta eri muuttujista. Talléin yhdistetdan siten, etté eri datojen saman tilastoyksikén ha-
vainnot tulevat yhdistetyssa datassa samalleriville.

Datojen yhdistaminen perakkéain
Datoja voidaan Enterprise Guidessa yhdistéd perakkéin valitsemalla ensin ensimmainen

yhdistettava data aktiiviseksi prosessidiagrammissa ja klikkaamalla " Data” -> " Append
Table”, jolloin aukeaa seuraava valintaruutu:

& Append Table
76 | Tables
Rezults
T ables ta §|_:||?end =
. Table Mame File Location
| WILJ_MIES KIRWILI_MIES
1+
Klikkaamalla ”Add Table’ ja vaitsemalla " Pro-
ject” péasee valitsemaan toisen samassa projek- '
tissa jo olevan datan, jossa on liséa rivga
lisattévaks ensimmaiseen dataan.
'.I._-ists t-he ta-bll;_,s .t.l:uat WI" be concatenate-d-, in lt.l:ua orcllle-r in wll";ic-h-t-hey wiiiullae concatenateci. -L.Ilse tli;is area toullau.i.llc.ll tlllna d-esli.redulist of- ta.l.n-les.
el el
[] Preview Code Bun ] [ Save ] [ Cancel ] [ Help
Ready

"Results’-vélilehdella voi puolestaan klikkaamalla” Browse” méaaritelld, minkd nimisend ja
mihin kansioon lopullinen tulosdata tallennetaan. Lopuksi painetaan ”Run”, kun yhdistet-
tévét datat on valittu ylla olevaan ruutuun.

Tehtdva: Yhdistd aiemmin muodostetut datat vilj _nainen ja vilj_mies perakkain (takaisin
yhteen) jatallenna yhdistetty data nimellavilj_molemmat.
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Datojen yhdistaminen rinnakkain

Datojen yhdistéminen rinnakkain voidaan tehda Query Builderilla. Valitaan ensimmainen
data aktiiviseks ja klikataan " Data” -> "Filter and Query”. Taman jakeen painetaan
"Join”-valintapainiketta, jolloin aukeaa "Tables and Joins’” -ikkuna. Ikkunassa voidaan
lisdta toinen data painamalla” Add Tables’, jolloin EG kysyy datan sijaintia. Jos toinenkin
data on jo mukana projektissa, voidaan klikata " Project” ja valita kyseinen data. Taloin
ohjelma yhdistéa datat ja nakyma on seuraava:

Tables and Joins

[ Close  F% Add Tables... 4P Join Order [ Options =

id -—@- id

nimi peloa

sukup nautoja
paino metsaa
pituus huotzuun
ika tulok

ajanmuk,
tulery aiz

Jos molemmissa datoissa on samanniminen sarake, niin EG yhdistéa da-
tat automaattisesti riveittéin sen mukaan (1D yll&). Jos taas samaa tarkoit-
yhdysviivan sarakkeiden vélille. Se onnistuu ottamalla ensimmaisessa
datassa muuttujan nimesta hiirella kiinni ja vetdmalla sen toisen péélle.
Jos datat yhdistetéan useamman kuin yhden muuttujan perusteella (esi-
merkiks vuosi- ja kuukausitieto), ainoastaan ensimmainen muuttujapari
yhdistyy automaattisesti ja muut joutuu yhdistdmaan kasityona.

Oletuksena yhdistamisessa syntyvaan dataan otetaan mukaan vain sellaiset rivit, jotka |Gy-

kaamalla hiiren oikealla painikkeella edellisessd kuvassa ndkyvan yhdistamisviivan paélla
javalitsemalla”Modify Join”. Tall6in aukeaa seuraava ikkuna:

Modify Join 1) Vain molemmista datoista |0ytyvét
_ yhdistdmisessd  kaytetyn muuttujan

Jolit Ep tasot otetaan mukaan tul osdataan.

(%) M atching rows only [ Inner Jain |

O &l rows from the left table [ Left Join ] ¢ 2) Vasemmanpuoleisesta datasta ote-

_ _ _ taan kaikki rivit ja oikeanpuoleisesta
() All rowes from the right table [ Right Join |

vain siihen yhteensopivat.
0 All rawes From bath tables [ Full Duter Jain |

3) Oikeanpuoleisesta datasta otetaan

@ kaikki rivit ja vasemmanpuoleisesta
Bt baby

Left table and calumn: vain siihen yhteensopivat.

WILJ_MOLEMMAT id s w | |TILA . .
4) Molemmista datoista otetaan mu-

C kaan kaikki rivit.




Lopuksi valitaan "OK”, "Close” ja”Run”, jolloin datat yhdistyvét. Vaihtoehtoisesti yhdis-
tamisessa voidaan 18hted liikkeelle klikkaamalla ensin ” Add Tables’, jolloin haetaan ensin
toinen data, jota ollaan yhdistamasss, ja vasta taman jalkeen klikataan " Join”, josta p&as-
téén tarkastelemaan ja muokkaamaan datojen automaattista yhdistamista

Tehtava: Yhdista rinnakkain edellisen tehtavan tuloksena syntynyt vilj_molemmat seka
aikaisemmassa tehtévassa luotu tila_tiedot. Tee lopputuloksena pysyva SAS-data nimelta
vilj06_takaisin.

7.13 Datan kaantaminen

Dataa voidaan k&antéa kahteen suuntaan. Ensinndkin voidaan yhdistéd usean sarakkeen
tiedot yhteen sarakkeeseen, jolloin yleensa myds luodaan uusi muuttuja, joka ilmaisee mis-
sa sarakkeessa tieto oli alun perin. Toisaalta voidaan menna vastakkaiseen suuntaan eli
jakaa yhden sarakkeen tieto useaan sarakkeeseen. Téallaisia aineiston kaanto tilanteita tulee
usein vastaan muun muassa silloin, kun samalta tilastoyksikolta (esimerkiksi el&imeltd) on
mitattu sama ominaisuus monena eri gankohtana.

Useasta sar akkeesta yhteen sar akkeeseen

Usean eri sarakkeen tiedot voidaan yhdistda samaan sarakkeeseen valitsemalla aktiiviseksi
muokattava data ja klikkaamalla ” Data” -> " Stack Columns’. K&nnossa kaytettavét ja
mukaan otettavat muuttujat nimetéén " Task roles’ -vélilehdella:

&, Stack Columns for KETUTDATA

Task Roles
Column Maming . ;
Rresuls V:'ab'e“’ 1o 2551 Tgkc'ﬁm — " Columns to stack” -
@b @ eloku kohdassa nimet&n
Sopme . i ne muuttuja, jotka
@ ssku @ﬁéﬁ oukks yhdistetddn yhdeksi
@ lokakuu oo K uudeksi muuttujaksi.
@ joululn @ whma
"Group analysis by” -kohdassa
téaytyy nimetd ainakin se muut-
tuja tal muuttujat, joka tai jotka
identifioivat tilastoyksikot al-
< kuperdisessi datassa.  Lisiksi
siind voidaan nimetd muut
muuttujat, joiden halutaan siir-
3N B tyvan kaannettyyn dataan.
e i
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Vélilehdella " Column naming” puolestaan mééritelldan k&dnnon tuloksena syntyvien uu-
sien muuttujien nimet:

#; Stack Columns for, KETUTDATA
TokFide | Column Naming Tassa maaritellaan kaannon tuloksena
usean erillisen muuttujan arvoista
Choose the names and labels for the Syntyneen UUden muuttUj an nimi.

optional.

" Label”-kohdassa voidaan mééritella
New value / muuttujan nimen selitysteksti.

MName:

Calumn Marning
Resultz

paino

g7 T ] Téss pudlesaen méitaléen sen
kuukausi uuden muuttujan nimi, joka il-
maisee, mistd alkuperdisesta
Description column, from the source column label. muuttuj aga m| kakl n ha.va' nto on

MName: Label: e
WalueD ezcription The label of the colu peral an.

The zelection pane enables you ta choose different sets of options for the task.
O B
[ fn [ swe ) [ cowe J[_ren ]

Liséks ”Results’-vdilehdella voidaan méaritelld, mink& nimisend ja mihin kansioon uusi
k&annetty data tallennetaan.

Tehtdva: Avaa SAS-data nimelta K etutData.sas7bdat ja kdanna se siten, etta muuttujien
elokuu, syyskuu, lokakuu ja joulukuu tiedot siirtyvét samaan sarakkeeseen. Nimeéa uudet
muuttujat siten, etté kaikkien kuukausien painot sisiltdva sarake on nimeltéan "paino” ja
alkuperdisten kuukausimuuttujien nimet sisdltava sarake on nimeltéén ”kuukaus”. Muo-
dosta pysyva SAS-data nimelta ketut_kaan kansioon C:\SAS\EGKURS.
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Y hdesta sar akkeesta useaan sar akkeeseen

Y hdesté sarakkeesta useaan aineisto voidaan kdantda valitsemalla se aktiiviseks ja klik-
kaamalla” Data” ->" Split Columns’, jolloin aukeaa seuraava vélilehti:

% Split Columns for KETUT_KAAN @

Task Roles

Results

Yariables to assign:

M arne

kohtaan tulee muuttuja,

Taszk roles:

Calurr ta split [Limit: 1)

whma sort order;
Azcending -

@lD @ pa.ino ~ .
@ tohma | & E;Iu:uﬁ:;t‘l:;ar colurnn_[Limit; 1] Sort by variables
gt.urka;s' i i Walue label column (Limit: 1)
@ alueLiesciption i Group analysis by . . .
&P paino @ o Vaue identifier co-
h ¢
"Column  to  split' - o lumn”  -kohtaan tulee

muuttuja, jonka kustakin

arvosta tulee kéénnetys-

jonka arvot jaetaan use- ; . .
sd datassa uusi muuttuja.

ampaan sarakkeeseen.

"Group anaysis by’ -
kohtaan tulee muuttu-
ja, jonka kullekin ar-
volle tulee ka&annet-
tyyn dataan oma rivi,
sekd muut muuttujat,
joiden halutaan siirty-
van tul osdataan.

The zelechon pane enables pou to choose
s o

J J

fave Cahicel Help

"Results’-vélilehdella voi valita tuloksena syntyvan kéannetyn datan nimen ja sijainnin.
Painamalla lopuksi ”Run” suoritetaan datan kaanto.

Tehtava: Kaanna edellisessa tehtdvassa muodostettu ketut _kaan takaisin alkuperéiseen
muotoonsa siten, ettd kunkin ketun havainnot ovat yhdellarivilla ja eri kuukausien paino-
havainnot ovat omina sarakkeinaan. Tallenna syntyva SAS-data nimella ketut_takaisin.

7.14 Muuta datojen kasittelyyn liittyvaa

"Data” -valikossa on myos tyokalu " Data Set Attributes’. Taman tyokalun avulla saa-
daan erilaista tietoa aktiivisesta datasta. Esimerkiksi suuren datan muuttujien ominai suuk-
sista saa katevasti yhteenvedon. Kahta dataa voidaan puolestaan vertailla Data-valikon
tyokalulla " Compare Data’. Tassd tyokalussa valitaan kaks dataa ja ohjelma vertaa,
ovatko datat tésméalleen samat. Tyodkalulle voi olla kayttoa esimerkiksi silloin, kun projek-
tissa on paljon eri versioita samoista datoista ja kdyttgalta on paassyt unohtumaan, miten
datat eroavat toisistaan. Toisaalta tyokalun avulla voidaan vertailla myds kahta yksittéista
muuttujaa, jotka ovat perdisin joko samasta datastatai kahdesta eri datasta. Jos tietokoneel -
le on kertynyt paljon pysyvia SAS-datoja, niité padsee katevasti poistamaan Data-valikon
tyokalulla " Delete Data Sets and Formats’. Tyokalulla voi valita kirjastoviitteen osoit-
taman kansion ja sitten sielta poistettavaksi datoja seka formaattitiedostoja. Esimerkiksi
SASUSER-kirjastoviitteen osoittamaan kansioon saattaa helposti kertyd turhia datoja.
Kannattaa kuitenkin olla varovainen, ettei vahingossa poistatarpeellisia datoja.
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8 Datan tarkastelu Graph-valikon kuvatyodkaluilla

Yks SAS Enterprise Guiden vahvuuksista perinteiseen SASiin verrattuna on kuvien piir-
tamisen helppous. Kuvat ovat katevid apuvalineitd, kun halutaan hahmottaa muuttujien
jakaumien ominaispiirteitéa seka tarkastella muuttujien vélisia yhteyksid. Kuvia piirrettd-
essa muuttujien tyyppi on olennainen. Muuttujat voidaan jakaa kategorisiin ja numeerisiin
muuttujiin. Kategoristen muuttujien arvot ovat luokkia. Kategoriset muuttujat voidaan
edelleen jakaa laatueroasteikollisiin ja jérjestysasteikollisiin muuttujiin. Laatueroasteikolli-
sen muuttujan luokkia ei voida laittaa jérjestykseen (esim. vérit), kun taas jarjestysas-
teikollisilla muuttujilla luokkien jarjestyksen méédrédva sdantd on olemassa (esim. likert-
asteikko). Numeerisilla muuttujilla puolestaan kukin tilastoyksikké saa méaéréa kuvaavan
numeerisen arvon (esim. pituus ja paino). Numeeriset muuttujat voidaan myos edelleen
jakaa valimatka- ja suhdeasteikon seka absoluuttisen asteitkon muuttujiin.

Seuraavassa kdydaan 1dpi muutamia usein tarvittavia kuvia. Kuvien piirtdminen on Enter-
prise Guidessa varsin helppoa, kunhan ensin oppii perusasiat. ” Graph”-valikosta |6ytyvia
kuvatyokaluja kannattaa siis kdyda my0s itsendisesti [8pi. Myohemmin esiteltavissi datan
kuvailu -tyokaluissa on myds mahdollista tuottaa varsinaisen tulostuksen lisdks sivutuot-
teena osittain samoja kuvia.

Téassa luvussa kaydaan | 8pi seuraavat ” Graph” -valikosta | oytyvat tyokal ut:

Graph | Analyze add-In ¢

Wizards < ¥ Wizard-kuvatyokal ut
Pylvaskuviot
Piirakkakuviot
Viivakuvat ja sirontakuviot
Sirontakuviot

A

Il Bar Chart...

A

@ Pie Chart...

#~ Line Plak, ..

A

“A

Scatker Plok.,,

S AreaPlot,..
%4 Bar-Line Chart...
%*  Bubble Plat, ..

l'?.

Conuk Chark, ..

Py

Conkour Plak, ..

o
HH

Box Plat... L aatikko-jana-kuviot

H_4
H

[Map b
“y Radar Chart...

o5 Surface Plat...
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8.1 Sirontakuvio (Scatter Plot)

Sirontakuvioks kutsutaan kuvaa, jolla tarkastellaan kahden, yleensd numeerisen, muuttu-
jan yhteyttd. Kuvio muodostetaan piirtamalla koordinaatistoon havaintoparit (x;, y;), jossa
Xi on vaaka-akselimuuttujan arvo jay; pystyakselimuuttujan arvo tilastoyksikéllai. Siron-
takuvion piirtamiseen |0ytyy tyokalu ” Graph”-valikosta.

Kéytettava data valitaan ensin aktiiviseksi klikkaamalla se siniseksi prosessidiagrammissa
jasitten valitaan " Graph” -> " Scatter Plot”. " Scatter Plot” -vélilehdelta valitaan tavalli-
sen sirontakuvion piirtdmiseksi "2D Scatter Plot”. "Task Roles’ -védlilehdella valitaan
muuttujat, joiden arvoista sirontakuvio piirretdan:

Scatter, Plot for VILJ2006_MUOK E|
Seatter Plat Task Roles
Y — Columng to assign: Task roles: sukup sort order:
Plats Narme 8 Horizontal (Limit: 1) Astending v
:::rsp::wacﬁ?csks gﬁmi @ %ﬁ?imt 1) Paino on valittu

General i@ pituus :
k. _ -
Harizontal A 8?;“;2 @] Yertical (Right] (DM 1) x-akselille.
Wertical Axis . 8 Group charts by
“ertical Right dwiz 8 ;1?;2': @ sukup

Huarizontal Major Ticks Pituus on Va“ttu

Werlical Major Ticks 2 tuotsuun .

Vertical Right Major Ticks | | @ paina y-akselille.

Horizontal Minor Ticks @) pinus

Wertical Minor Ticks @ ik

Wertical Right Minor Ticks @ tulat PI | rret%n kuvat
Reference Lines @ ajanmuk, . R

General Feferencef A &JkUDUOI Ittain

Horendllees | Tagty listasta valitaan (sukup)

ertical Lines

Hurizontal Lines (R kaytetta\/at muuttUj at

peaend sirtamalla ne eri "roo-
Tites leihin” listan vieressa < 2
olevien nuolien avulla.
Run ” Save ] ’ Cancel ] [ Help
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"Plots’-vélilehdella voidaan muokata kuvan ulkoasua:

Scatter Plot for YILJ2006_MUOK

Seatter Plat Appearance » Plots

Task Roles
Appearance

’hl

Interpalations

Aues and Ticks
General
Horzontal &xis
Wertical Az
Wertical Right Ax

Viivan  asetukset
(esimerkiks  reg-
ressiosuoralle).

Line

/ Style:

Width [pisels):

Calar:

Soid v 2

[rata point marker
Type: Symbal:

H W

Height [paints):

X

Outline

Calor:

-

Color:

Harizantal b ajor
Wertical Major Ticks
Wertical Right Major Ticks
Harizontal Minor Ticks
Wertical Minor Ticks
Wertical Right Minor Ticks

Reference Lines
General Reference Lines
Haorzantal Lines
Wertical Lines
Harizantal Lines [Rig

Legend

Chart Area

Titlex

e =] -

|Special vl |F'aw

[] Break the plot line at missing values.

Havaintopisteen sym-
bolin asetukset.

Bun Save Cancel Help

I J { J {

Kuvan asetuksia voi vaihtaa RTF- ja HTML-tulosteissa myds valmiista kuvasta siten, etta
painetaan hiiren oikeata painiketta kuvan padalla ja valitaan ” Graph Properties’. Aukeavasta
valikosta padstéan editoimaan kuvaa. " Interpolations’-védlilehdella voidaan valita esimer-
kiksi regressiosuora sovitettavaksi pisteparveen:

X

Scatter Plot for YILJ2006_MUOK

Appearance > Interpolations

lﬁ
Tésta voidaan valita
mm. pelkka sirontaku-
vio ("Scatter”) tai si-
rontakuvio ja regres-
somali  ("Regressi-
on”).

Scatter Plot
Task Roles
Appearance
Platz
Interpolations
Axes and Ticl
General
Harizonts
Wertical &
Wertical B
Harizonts
Wertical
Wertical B
Harizonts
Wertical
Wertical B
Reference Lines
General Reference Lines
Harizontal Lines
Yertical Lines
Horizontal Lines [Right Axiz)
Legend
Chart Area
Titlex

Interpolation method:

Regression “

Wpel

| Linear
T =Py + X

[ Force regression line through ori:n\

[ Display confidence limits

]

Regressiomallin

tyypin  vainta
("Linear” = reg-
ressiosuora).

Corfidence level:

The selection pane enables you to choose different sets of options for the task.

Bun Save Cancel Help

I J { J {
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Akselien pituudet voi médritella oletusarvoista poikkeaviksi "Horizontal ja Vertical Mgjor
Ticks’ -vdlilehdilla valitsemalla ol etuksena olevan ” Automatic” vaihtoehdon sijasta ” Spe-
cify”. Lisaks eri vdlilehdilla voidaan tehda muun muassa akseleihin, referenssiviivoihin
seka kuvan otsikoihin ja kokoon liittyvia méarityksid. Lopuks valitaan "Run”, jolloin si-
rontakuvio tulostuu ol etustul ostusmuodossa:

& SAS Enterprise Guide - EG41_kurssi_Project

Fie Edt Wew Code Data Describe Graph  Analyze Add-In OLAP  Tools  Window  Help

S-F-%| 5 EBE X > L. :ung]E(tDEslgnEr [] Masimize Workspace 52 Task Status

peltodat (Process Flow)

E o[x]| Teg Project Designer | 48 HTHIL-Scatter Plot
[ Listing - Compare Data -~
{8 HTML - Compare Data Scatter Plot
£ VILIZ008_MUDK
s Distribule
i) Ei]mil Recipient pituus
og
; Vilelis 2006 2104
B Vieliz2008.2ls (taull )
= 2" Import Data
2] Last Submitted Code

Log i
%Ig KIRVILIZ006 zll
3 KIRVILIZ008
5 Duery for KIRYILI2006
=] Last Submitted Code

=] Log 1904
[E3 vILI2008_MUDK
F} VILI2008_MUOK
=l Scatter Plot
] Last Submitted Code

=™ 180 e
{8 HTML - Scatter Plot —
5 Quenw far VILJZ008_MUDK —
2] Last Submitted Code
[£] Loa 170
[E viLI_TIEDOT
5 Quen! for VILIZ00E_MUOK
=] Last Submitted Code
=] Lea
[E] TiLa_TiEDOT 160 ; ; ; : : :
3 VILI_TIEDOT
27 Query forVILI_TIEDOT 50 B0 70 a0 a0 100 1o 120 130
=] Last Submitted Code paino
Z] Lea
R vILI_MIES
B Quen forVILYTIEDDT Generated by the SAS System (Local, XP_PRO) on 12.2.-07 at 2:36 PM
2] Last Submitted Code
2] Log
[EL VILI_NAINEN
3 vILI_MIES Scatter Plot
= [ Append Table
] Last Submitted Code

o ituus
[ VILI_MOLEMMAT P

3 VILI_NAINEN ‘\EDW

[55 VILI_MOLEMMAT
[5} TIs_TiEDOT

5 Duer for VILJ_MOLEMMAT - -
7

2] Last Submited Code L <[]

] Log Task. Status Queue Server

[ Duery_for VILI_MOLEMMAT

< >

Ready [ [Urknown] cornected to localhost

Jos halutaan piirtéa sirontakuvio, jossa pisteet on merkitty eri vérilla tai symbolilla jonkin
ryhmittelevdn muuttujan luokkien mukaisesti, se voidaan tehda "Line Plot” -tyokalulla
Valitaan "Graph” -> "Line Plot” ja avautuvala “Line Plot”-vdlilehdella "Multiple line
plots by group column”. “Task Roles’ -vdlilehdella ryhman maéarédva muuttuja laitetaan
kohtaan “Group” ja“Interpolations’-vélilehdella kohdassa ” Interpolation method” valitaan
joko " Scatter” tal "Regression” (kummallekin ryhmaélle erikseen).

Tehtava: Kaytd projektissa olevaa muokattua Viljelijd 2006 -dataa nimelta
vilj2006_muok. Piirrd sirontakuvio, jossa on x-akselilla viljelijan paino ja y-akselilla vil-
jelijan pituus. Piirré kuvat sukupuolittain ja lisda viela painon ja pituuden yhteytta havain-
nollistavat regressiosuorat seka naisten etta miesten kuviin. Muokkaa kuvista mieleisesi
jalkikéasittelemalla valmiita kuvia.

8.2 Pylvaskuvio (Bar Chart)

Pylvaskuvio on yleinen kategorisen muuttujan frekvenssijakauman havainnollistamistapa.
Muuttujan kullekin luokalle (esimerkiksi sukupuolimuuttujalla miehille ja naisille) piirre-
téén oma pylvas, jonka pituus kuvaa luokan esiintymisten maaréa aineistossa tai prosent-
esimerkiks jonkin muuttujan keskiarvoa toisen muuttujan eri luokissa. Pylvéskuvio voi-
daan piirtda valitsemalla kaytettdva data aktiiviseks eli klikkaamalla datakuvake siniseksi
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prosessidiagrammissa ja vaitsemalla ” Graph” -> "Bar Chart”. Taléin aukeaa pallim-
maiseksi ”Bar Chart” -ruutu, josta voidaan valita kuvan tyyppi:

il Bar Chart for VILJ2006_MUOK

Bar Chart
Task Roles
Appearance
Bars
Options
Axes and Ticks
General
Horizontal Auis
Wertical Axis
Wertical Major Ticks
Wertical Minor Ticks
Reference Lines
Harizontal Lines
Chart &rea
Advanced
Titles

Bar Chart

hall

Simple Wertical Bar

il

Stacked Wertical Bar

Interleave Vertical Bar

=

Grouped Colored
Wertical Bar

=

Grouped Colored
Wertical Groups

e
m

R
3D Grouped Colored 30 Grouped Yertical

Yertical Bars Colored Groups

:._ | g [
Grouped/Stacked Horizontal Color Bars Grouped Colored

Harizantal Bar Harizankal Bar

The zelection pane enables you ta chooze different sets of options far the tazk.

Grouped/Stacked
ertical Bar

Vertical Colored Bars

Grouped Vertical 30 Grouped/Stacked
Bars

Wertical Bars

Simple Horizontal Bar - Grouped Horizontal Bar Stacked Horizontal Bar

ul

Grouped Colored
Haorizontal Groups

I

Cancel Help

The "Column to chart” role must have a variable azsigned to it.

Samoin kuin sirontakuvion yhteydessd muuttujille annetaan “roolit” valilehdella " Task

Roles’:

il Bar Chart for VILJ2006_M/I0OK

Bar Chart
Tazk Roles
Appearance
Bars
Optionz
Awes and Ticks
General
Horizontal &Axis
Wertical Agis
Yertical Major Ticks
Wertical Minor Ticks
Reference Lines
Haorizontal Lines
Chart &rea
Adwanced
Titles

"Column to Chart”

Tas
-, -Kohtaan siirretadn _
al . - A Task noles:
N muu'[tUJa, Jonka e HE Column ta chart [Limit;
. . Py @ Sukup
%‘); avol lle pllrnr“etaan Y& Sumof (Limit 1)
@ erilliset py|vaat M Group charts by
2 e
@ nautaja
@ metzaa
@tuotsuun
@ paino
git Jos halutaan kokonaan
& et erilliset  pylvaskuviot
@ ajanmuk joillekin  osaryhmille,
@tulevais

ryhmittelevd muuttuja
maarétéddn  kohdassa
" Group charts by”.

The selection pane enables you to chooze different sets of options for the task.

Jos jokin muu Kkuin
"Column to Chart”
-muuttuja pitda sisil-
|&an tiedon pylvéiden
pituuksista, kyseisen
muuttujan nimi tulee
kohtaan ” Sum of”. Jos
taas " Column to chart”
-muuttuja pitda sisil-
|&&n kaiken tarvittavan
tiedon, tdma kohta
jétetdan tyhjaksi.

"Sum of” -kohtaan voi
tulla my6s esimerkiksi
muuttuja, jonka arvo
ta arvoista laskettava
keskiarvo maaraa pyl-
vaan pituuden.

Bun ] [ Save

71 Cancel I Help

J
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"Bars’-vélilehdella voidaan tehda seuraavia maarityksia

il Bar Chart for VILJ2006_MUOK X
Bar Chart Appearance > Bars
Tazk Roles
AIJIJEEIE‘“CB Bar appearance Specify number of bars
ars
Options (®) Color Hurnber
Auez and Ticks O Testure One bar for each
Gemeral unigue data value
Horizontal Axis - () Enter number of bars \
el All bars uze the same color g
Wertical Major Tick; O Specify the b e s ean L .
Wertical Minor Ticks wvalues M aa.rltetaa.n, etta mUUttUj an
Reference Lines jokaiselle arvolle tulee oma

Pylvéaiden véri pylvas (saadaan poistettua

& Kkuviointi turhat pisteet x-akselilta
numeerisen muuttujan tapa
uksessa).

Enables pou to specify how many bars appear in the chart.
[ Bun ] [ Save ] [ Cahicel ] [ Help ]

”Options’-vélilehden kohdassa ”2D” voidaan méarittéa kuva kaksiulotteiseksi oletuksena
olevan kolmiulotteisuuden sijaan. " Advanced”-vélilendella puolestaan voidaan valita pyl-
vaan pituuden laskentatapa (" Statistic used to calculate bar”). Jos ” Sum of” -muuttujaa ei
ole médritetty, pylvaét voivat edustaa muun muassa kunkin luokan esiintymisten méaaraa
tal prosenttiosuutta aineistossa. Jos taas kaytetdan " Sum of” -muuttujaa, pylvaét voidaan
madritella joko keskiarvopylvadiks tai summapylvéiksi. "Display error bars’ -kohdassa
puolestaan voidaan liséta prosentti- tai keskiarvopylvéille luottamusvalipalkit. Luottamus-
valien maardaminen riippuu tutkimusasetelmasta. Téasté saadaan keskiarvojen luottamus-
valit asetelmalle, jossa kaikki havainnot ovat toisistaan riippumattomia ja perdisin
normaalijakaumasta. Prosenttiosuuksien luottamusvélgd puolestaan voi kayttda suurten
otosten tilanteessa, jossa kaikkien havaintojen riippumattomuusoletus on voimassa. Kan-
nattaa siis varmistaa, ettd aineisto perustuu siihen tutkimusasetelmaan, johon EG:n esitté&
maét luottamusvélit soveltuvat kaytettaviksi.

Muilta vélilehdilta |0ytyy erilaisia kuvan ulkoasuun vaikuttavia asetuksia (muun muassa
otsikoihin, akseleihin, referenssiviivoihin ja kuvan kokoon liittyvia maarityksid). Esimer-
kiks prosenttiluvut pylvaiden péélle saadaan ”Appearance’ -> ”Advanced’-vélilehdella
tekemalla valinta” Additional statistical value to show next to bar”.
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Vamista kuvaa padsee tassakin tapauksessa muokkaamaan RTF- ja HTML-tulostusten
yhteydessa klikkaamalla kuvaa hiiren oikealla painikkeella ja valitsemalla " Graph proper-
ties’:

Fremuency
;-‘-l -
40 Chat Type b
[t iy Cipbonis.
Srvle Ediboi .
TEE=s E
3] —
Saias 5,
Copw
Prink.
Al Viges ¥
g - =] L |
..-...
10—

sukuip

Ganarared by ife 545 Speiem (Local, XF_PROG) on 132-007 ar 2:65 P

Kannattaa huomioida, ettda muokattaessa yllamainitulla tavalla valmista kuvaa, muutokset
eivét tallennu projektin mukana. Muokattu kuva kannattaa siis joko tallentaa omaksi kuva-
tiedostokseen (valitsemalla yll&a olevassa kuvassa nékyvasta valikosta ” Save As’) tai kopi-
oida leikepdydan kautta talteen esimerkiksi Wordiin (valitsemalla ylla olevassa kuvassa
nékyvastéa valikosta” Copy”).

Tehtava: Piirrd kummallekin sukupuolelle pylvaskuvio Viljelija 2006 -aineistosta
(vilj2006_muok) siten, etta pylvaiden pituudet kuvaavat miesten ja naisten keskipituutta
aineistossa.

8.3 Viivakuva (Line Plot)

Viivakuva on koordinaatistoon piirrettdva kuva, jossa osa havainnoista yhdistetéén toi-
siinsaviivalla. Pienilla kokedllisilla aineistoilla viivakuva on usein kéteva esitystapa muut-
tujien arvojen tarkasteluun kaikilla koeyksikdilla. Kuva voidaan piirtéa esimerkiks siten,
etta x-akselilla ovat toistotekijan (esimerkiks vuoden) arvot ja saman tilastoyksikon ha-
vainnot yli toistotekijan tasojen yhdistetéan viivalla. Tilastoyksikét tai niiden muodostamat
ryhmét voidaan erottaa toisistaan erilaisella viivatyypilld, symbolillatai piirtamallaryhmil-
le omat kuvat.

Jotta viivat kulkisivat pisteiden |gpi x-akselin arvojen mukaisessa jarjestyksessa vasem-
malta oikedlle, aineisto taytyy jarjestda ennen kuvan piirtdmista x-akselin muuttujan mu-
kaan suuruugjérjestykseen, ellei se ole valmiiks jérjestyksessa. X-akselin arvojen tulee
my0s olla sellaisia, etta ohjelma ymmartaa niiden oikean jarjestyksen (jonkin s88nnén mu-
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kaisesti), muuten ohjelma sijoittaa arvot akselille epaloogiseen jarjestykseen. Merkkimuo-
toiset arvot ovat usein ongelmallisia, koska ohjelma e osaa jérjestaa niitd muuten kuin
aakkogjarjestykseen. Tasta syysta arvot on usein syyta koodata uudelleen numeerisiksi, kun
niita kaytetédan viivakuvan x-akselilla. Koodaaminen voidaan tehdéa samalla tavalla Query
Builderissa kuin muuttujien luokittelu ja luokkien yhdistdminen. Query Builderissa vali-
taan siis " Computed Columns’ -> "New” -> "Recode a Column”, jossa voidaan tehda seu-
raavan ikkunan mukainen maéarittely:

# Recode Column - KETUT_KAAN.kuukausi X
Mew column name: kLauk,_ram
Replacements: Al
Replace With
elakuu a
oLk L 12
lok.akuu 10
aypzkuu 9
Other values

Replace all ather values with:

Rl vl e Tulosmuuttuja on méaritelty nu-

() Thiz walue: meeriseksi.
Mew colummn ype
(") Character (%) Mumeric
[ k. ] [ Cancel ] [ Help ]

A

Query Builderin tuloksena saatavan datan kuuk_num-muuttujaa voidaan nyt kéyttéa viiva-
kuvan x-akselin muuttujana.

Viivakuva voidaan piirtda valitsemalla kéytettava data aktiiviseks ja klikkaamalla
"Graph” ->"Line Plot”. Kéytettava kuvatyyppi valitaan "Line Plot” -valilehdella. Nama
kuvatyypit antavat pohjan kuvan muokkaukselle, mutta erilaisten asetus-valintojen avulla
kahden eri pohjan avulla saatetaan péatya samaan lopputul okseen.
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Esimerkiks seuraavassa valittavalla kuvatyypillé voidaan tehda my6s ” Standard Deviation

Plot” -tyyppinen kuva:

Line Plot for KETUT_NUM

Line Plat
Task Roles
Appearance
Plots
|rterpalation:
Axes and Ticks
General
Horizontal Auis
Wertical Axis
Horizontal Major Ticks
Yertical Major Ticks
Harizantal Minor Ticks
Wertical Minor Ticks
Reference Lines
General Feference Lines
Horizontal Lines
Yertical Lines
Legend
Chart &rea
Titles

Regression Line

M

Multiple vertical column
line plotg using overlay

group column

tultiple line plots by

Line Plot

° _I—JL

Line Plot Spline Plat Meedle Plat Step Plat

r
"
i I/i\l W
¥ /\/\/
Scatter Plot with Smooth Plot Standard Deviation Plot Lagrange Interpolation

Plot

symbolilla.

appear on the same araph.

Select the type of line plat that you want ta create.
Multiple line plotz by group column creates a separate plot for each distinet walue of the group vanable. All of the plats

Valitaan "Multiple line plots
by group column”, jolloin
saadaan muuttujille  kayt-
téon “Group”-rooli, jonka
avulla osaryhmid voidaan
esittéd samassa kuvassa eri

Cancel

I

Help

The "Group" role must have a varable azsigned to it.

"Task Roles” -vélilehdella maaritell&dn muuttujien tehtavat:

Line Plot for KETUT_NUM

Task Roles

[ Line Plat -
— _ "Horizontal” -
Appearance Columns to assign: Task roles:
Plots MName f@ Haorizontal [Limit:R/ kOhtmn tUIee X-
o @ W Lickin akselin muuttuja.
Axes and Ticks @whma |8 Wertical (Limit: 1)
General . {i paino
Horizontal Axiz @kuukaug iz (g Group [Limit 1]
Vertical Asis @Va.lueDescnptmn @ D ”V t a]" k ht
Horizontal Major Ticks @palno /’f@ Group charts by ertic -KO mn
Wertical Major Ticks @ huukioum tUI ee y'aksel n
Harizantal Minor Ticks H
Wertical Minor Ticks / mUUttuJ a
Reference Lin[ » .
Generaip| | Group”-kohtaan lai-
Hezonid) tefaan  se  muuttuja,
Lgend | jokaidentifioi viivoilla "Group charts by” -kohdassa
Chart &rea

vois méarittdd  muuttujan,
jonka jokaiselle tasolle tai
luokalle piirretéan erillinen

yhdistettavdt  pisteet
(esim. ID-numero).
Tata valintaa e 106ydy

Titles

kaikista "Line Plot” - <01 kuva
védlilehden  kuvatyy-
peista
Bun ” Save ] ’ Cancel ] [ Help ]
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"Plots’-vdlilehdella voi méaritella viivatyypin, viivan paksuuden ja vérin erikseen kullekin
" Group”-muuttujan tasolle. Siind voi siis esimerkiksi maérdta samaa kasittelya saaneiden
tilastoyksikoiden profiilit piirrettéviksi samanlaisellaviivalla:

Line Plot for KETUT_NUM
[ Line Plot | Appearance > Plots
Tazk Roles
Appearance :
:I'Z Line Outline
Interpolations 3 Shyle: ‘width [piselz) Calar: Colar:
Awes and Ticks 4
General a [soid  ~| I2 3: - =
i e L '
Lo
bl i TR 10 Tupe: Symbol: Height [paints): Color:

“ertical Major Ticks :-Special v.: :.Star v.: m il
Wertical Right Major Ticks d I | & !
Harizontal Minor Ticks
Yertical Minor Ticks
“ertical Right Minor Ticks

Reference Lines [] Break the plat line at missig values.
General Reference Lines
Harizontal Lines

L N Voidaan myos korostaa tiettya
orizontal Lines [Fight Awxis) . . s . . .
Legend tilastoyksikkoa, esimerkiksi
s R kéyttamall& erilaista symbolia
[Enables wou to control the appearance of the plot for the selected variable. [f you are creating a line plot or & Al

twa-dimensional scatter plot, the warisbles in the list are the variables that you assigned to the Vertical and Vertical
[Right) rolez, If pou are creating a bar-line chart, the vanables in the list are the varables that pou assigned to the Line  «

T T |

Muut valinnat ovat samankaltaisia kuin muidenkin kuvien yhteydess, €eli niilla voidaan
muun muassa vaihtaa tai muokata kuvien otsikoita, referenssiviivoja, akseleiden asetuksia
seka viivojen selitteiden ja kuvan koon asetuksia. Tuloksena syntyy néill&a asetuksilla seu-
raava kuva

paino
16

14
12 -
10

kuuk_num

D—1 —2 —3 —4 —5 E &7 g —o9 10
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"Interpolations’-valilehdella olisi voitu yksittédisia havaintoja esittdvén viivakuvan sijaan
vaihtaa piirrettévaks esimerkiks keskiarvojen profiilikuvan (eli ” Standard Deviation Plot”
-tyyppisen kuvan) valitsemalla” STD”:

Line Plot for. KETUT_NLUM

Plats
Interpalations
Anes and Ticks

Wertical Aris

“ertical Right Axiz

Hornzontal Major Ticks

Wertical Majar Ticks

wertical Right Major Ticks

Horizontal Minor Ticks

Wertical Minor Ticks

wertical Right Minar Ticks
Feference Lines

General Reference Lines

Harizantal Lines

Yertical Lines

Honzontal Lines [Right Axiz)

| Appearance > Interpolations

Line Plat
Task Roles
Appearance Ia 7 Interpolation method;

v
General g
Horizontal &xis
i of the mean

ez uzing 4 pooled estimate

[] Connect the min and max ¥ values using bars, nat lines

Keskiarvojen profiilikuvaa piirrettdessa
"Group”-muuttujaksi olisi edella valittu
se ryhmittelevd muuttuja (t&ssa ryhma-
muuttuja), jonka luokkien keskiarvot

Legend
 Crathes kuvassa hal utaan esittza. Talloin kyseisen
M muuttujan luokat tulevat nakyviin tahan
ikkunaan.
[ Bun H Save ] [ Cancel ] ’ Help

Tehtava: Ota projektista kayttoon kaannetty kettudata ketut_kaan. Tee ensin Query Buil-
derissa uusi muuttuja, joka sisdltdd kuukausitiedon numeerisena. Tallenna data nimella
ketut_num. Piirra kuva, jossa x-aksdlilla on kuukausi ja y-akselilla ketun paino. Y hdista
kunkin ketun toistomittaukset yli kuukausien viivalla ja erota eri kasittelya saaneet ketut
toisistaan erilaisellaviivalla

Tehtava: Kéyta samaa dataa kuin edellisessa tehtévassa ja piirrd kuva, jossa on viivala
yhdistetty samaa kasittelya saaneiden kettujen keskimaéraiset painot eri gjankohtina (yksi
viiva kummallekin kasittelylle). Piirr& kuvaan myds keskihajonnan pituiset janat kuhunkin
aikapi steeseen kummallekin kasittelylle.

8.4 Laatikko-janakuvio (Boxplot)

L aatikko-janakuvio soveltuu numeerisen muuttujan jakauman havainnollistamiseen. Kuvi-
osta saa nopealla silmayksel 1a késityksen monista jakauman piirteista.
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Enterprise Guidessa piirretdan boxplot klikkaamalla” Graph” -> " Boxplot” ja valitsemal-
la”Box Plot” -vélilendeltd”Box Plot” jasitten " Task Roles™:

" Box Plot for VILJ2006_MUOK

[ Box Plat | Task Roles

Taszk Roles
Appearance Columng to assign: Task roles:
Box Plat | Mame | '&F Horizontal [Limit; 1]
Aues and Ticks =y | 5 @ sukup
” . " . |6 Wertical [Limit:
Vertical” -muuttuja on se muut- @ s

tuja, jonka arvojen jakaumaa gm L

boxplotilla kuvataan.

Wemcal Hight Faor Ticks . j ” H0r| Zontal "

Haorizontal Minar Ticks @ paino . . .

“ertical Minar Ticks g pituus muuttUJ akS| Val 1taan

Wertical Right Minor Ticks ika i i i _

Reference Lines @ tuliat mUUttuja’ Jon!’(a erl Iu?

General Reference Lines @ ajanmuk kl SSsa Veftl Cal =

Huorizontal Lines tuley i H H

Wertical Lines @ R muut:.tUJ an i J akaumaa

Horizontal Lines [Right Axiz) ha\/al nn0| | | get%n bOXp‘
i TR lotin avulla. EG:ssé t&

" ma pitda maarittéa.

| The selection pane enables vou to choose different sets of options far the task.

] ’ Cancel ] [

|

Save Help

I Box Plat
Tazk Roles

Appearance : . ;
LH [] Draw line between median points

L
it d Tick H
KEE::BH:C ) ? é ﬁ Draw tops and bottoms on the whiskers
Huarizontal &zis ]
Vertical Sxis . [[] Specify colars

Tassa valitaan janojen

Wertical Right Asis . [PTTET
padtepisteen madraava

Harizantal Major Ticks

Wertical Major Ticks YT
“ertical Right Major Ticks wihisker length percentie; I ag(usaanto
Huorizontal Minar Ticks i "
Yertical Minar Ticks |+ 1.5 timez the interquartile range v;
“ertical Right Minor Ticks 17 i

Reference Lines Outliers
General Reference Lines Type: Symbol: Height:
Huarizontal Lines e — — —
Yertical Lines | Special ] | Dot B [t =
Harizantal Lines [Right Axiz)

Chart Area

Titles

Tassa tehddan poikkeavia havaintoja kuvaa-
vien symbolien asetukset. Huomaa, etta ole-
tussymbolina on "none’, jolloin poikkeavia
havaintoja el tule kuvaan lainkaan.

L - - |

& box to the most extreme point within 1.5

Cancel ] [

Help
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Muilla valilehdilla tehtavat valinnat koskevat muun muassa kuvan akseleiden, referenssi-
viivojen, otsikoiden ja koon asetuksia. Tulostus ndytt&a valituilla asetuksilla seuraavalta:

pituus
2104 : . : . :
/ " Poikkeava havainto” eli havainto, joka
w poikkeaa yl& ta alakvartiilista yli 1.5
300 kertaa kvartiilivalin pituuden verran.
1904 Janat piirretdan sithen suurimpaan (tai
pienimpaan) havaintoon asti, joka ei
kuitenkaan ole riittavan suuri (tai pieni)
180 — ollakseen poikkeava havainto.
] Kvartiilit:
1 - Yiskvartiili
. - Mediaani >
- Alakvartiili
160 —_—
~ Kvartiilivalin pituus
150 : :
1 2

SukLp

Y11a olevassa boxplot-kuvassa on erikoista se, ettéa ohjelma piirtda eri sukupuolten kuviot
kuvan darilaidoille. Tama sdlittyy silla, ettd Boxplot-tydkalu on padasiassa tarkoitettu sel-
laisiin tilanteisiin, joissa ryhmi& on selvasti enemman kuin kaksi, jolloin yksittéiset kuvat
jakautuvat tasaisemmin kokonaiskuvaan. Yks keino kiertda taméa ongelma on maarittéa x-
akseli esimerkiks vdille 0-3, jolloin arvot 1 ja 2 tulevat keskemmalle kuvaa. Taman voi
tehda Boxpl ot-tyokalun " Horizontal Major Ticks’ -valilehden ” Specify”-valinnalla.

EG:ss& my0s jotkut muut tyokal ut tuottavat boxplot-kuvia. Kuten téssakin nahtiin, boxplot-
kuvien piirtémisessa voidaan kayttéé erilaisia séantdja. Kannattaa siis aina varmistaa, milla
periaatteilla k&yttamas tai tulkitsemasi boxplot-kuva on piirretty.

Tehtava: Piirra paédtuotantosuunnittain tulojen jakaumia havainnollistavat boxplot-kuvat

Viljelija 2006 -aineistosta (vilj2006_muok). Voit my0s tarkastella muiden numeeristen
muuttujien jakaumia.
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8.5 Piirakkakuvio (Pie Chart)

My6s piirakkakuvion avulla voidaan havainnollistaa kategorisen muuttujan jakaumaa.
Niinpa piirakkakuvion tekeminen toimii hyvin pitkéle samoilla periaatteilla kuin pylvés-
kuvion tekeminen. Ensin valitaan ” Graph” -> " Pie Chart” jasitten valitaan " Task Roles’
-vélilehdella muuttujien roolit: essmerkiksi ”Column to chart” voi olla sukupuoli ja " Ad-
vanced”-vélilehdella voidaan valita esitetdankd kuvassa frekvenssgja vai prosenttiosuuksia.
Tulostus ndyttéd kol miul ottei sena seuraavalta:

1.0 - o
79.25%

20
20.75%

8.6 Wizard-kuvatyokalut

Wizardien tarkoituksena on tarjota vaihtoehtoinen tapa tiettyjen tyokalujen kayttamiseks.
Tassa esiteltavissa wizardeissa on yhteista se, ettd niilla pystyy tekeméan tarkeimmat ta-
vallisilla tyokaluillakin tehtavat maarittelyt, mutta osa asioista jaa wizardien ulkopuolelle.
Niinpé tavalliset kuvatyokalut ovat usein kayttokelpoisempia, kun halutaan kayttéa kuva-
tyokalun ominai suuksia mahdollisimman monipuolisesti. Wizard-kuvatyokalut voivat puo-
lestaan olla kayttokelpoisia esimerkiks sellaisissa tilanteissa, joissa kuvia kaytetdan
listen kuvatytkalujen logiikkaa selkedmpana. Lisdks wizardista on mahdollista siirtya
tavalliseen vastaavaan tyokaluun. Tama onnistuu klikkaamalla méariteltya wizard-teht&-
vasolmua prosessidiagrammissa hiiren oikealla painikkeella ja valitsemalla " Open In Ad-
vanced View”. Tall6in wizardissa tehdyt méaritykset ndytetdan tavallisessa tytkalussa ja

Toimintatapa wizardeissa on sellainen, etta ensin valitaan prosessidiagrammista kaytettava
data aktiiviseks ja sitten kaynnistetdan wizard-tyokalu. Wizardissa méaérittelyt on jaettu
useammalle sivulle, joiden |8pi edetddn jarjestyksessd, ja lopuks valitaan "Finish”. Seu-
raavassa esitellaén lyhyesti EG:sté |0ytyvét wizard-kuvatyokal ut.
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Wizard-tyokalu pylvaskuvil

le

Pylvaskuvien tekoon suunniteltu Wizard saadaan avattua klikkaamalla ” Graph” -> " Wi-
zards’ ->"Bar Chart”. Tal6in aukeaa wizardin ensimmainen sivu:

[ 1y Bar Chart for YILJ2006_MUDK El
1ofd  Verity Data )Sas_
The Bar Chart *izard helps you create vertical or horizontal bar chartg, in bwo or three dimenzions, with options for grouped or stacked bars.
rtve o Ensmmaisella sivulla nakyy aktiivi-
L seksi valittu data. Jos téssé nakyy vasré
Ubay: KR data, tulee sulkea wizard, valita oikea
Datasst  VILIZ0DE_MUDK data aktiiviseksi prosessidiagrammista
jaaoittaa uudelleen.
Seuraavalle sivulle péé
see painamalla” Next”.
Mext » ] ’ Finish ] [ Cancel ] ’ Help ]
Toisella sivulla méaritel laén muuttujien roolit:
- Il Bar Chart for ¥ILJ2006_MUDK @
2ofd Assign variables to roles Pakolllsa maarltyksa ovat
_ "Bars’ ja ”Bar height’. |
i — "Bars’-kohdassa méritel-
| |&&n muuttuja, jonka jokai-
Bars: (i sk -
L @z E selle tasolle tulee oma
T|_|_l EBar height: {H) [Percentage) - pylvas "Bar he ght”
-kohdassa valitaan, miten
DT_EEBID oty ~ pylvaan pituus méaréytyy.
]]1!}. [C] Depth: i@ ]
e DStk by @ "Bars’- ja "Bar height” -kohtien ja-
o T ) jessa olevien painikkeiden avulla
Al Oty voidaan tehda naihin kohtiin liittyvia |,
»Optiona”-kohdan dlla lisdmaarityksid. Esimerkiksi "Bars’-
olevien  vaihtoehtojen kohdassa numeerisilla muuttujilla
avulla pylvéita voidaan kannattaa usein valita muuttujan tyy-
ryhmitella e tavoin piks téssa "Discrete”, jotta kuvan x-
kaan.
[ < Back ] [ Mext > l [ Einish ] ’ Cancel ] ’ Help ]
A
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Kolmannella sivulla méaritelléan ulkoasuun liittyvia asioita:

il Bar Chart for VILJ2006_MUOK

3 of4

Specify appearance

Colars

Bar color:

Labels

30 chart /

Caolor bars by

Data labels:

Lines and ticks

[ Uze reference lines

Tick marks

K olmiulottei suus

3

HSas.

Sample chart:

| [l bars the same]

Pylvéiden varit

| Percentage

Aiz Labels ‘-

Selitykset pylvéiden
paihin (esimerkiks pro-
sentit)

{Percentage)
]
- 50.00%
S 3333%
v| 1667%
T 2 3
sukup

| <Back | [ Nes> || Finish

|[ cancel |[ hHep |

Viimeisellasivullavoi vield méaritella kuvien otsikoita ja alaviitteita

il Bar Chart for, VILJ2006_MUDK

4 of4 Provide atitle and footnote Jsas.
Graph: Bar Chart
Fonthote:

Generated by the SA5 System [&_SASSERVERNAME, §5YS5CPL) on %3YSFUNCIDATE(], EURDFDES) at
#5YSFUNCITIMED, TIMEAMPME)

Einizh

[
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Lopuksi painetaan " Finish”, jolloin valmis kuva tulee samalla tavalla osaksi projektia kuin
tavallisilla kuvatyokal uilla.

Tehtava: Piirrd wizard-tyokalua kayttéen pylvaskuvio, jonka avulla havainnollistetaan
sukupuolimuuttujan frekvenssijakaumaa.

Wizard-tyokalu viivakuville

Viivakuvissa wizard noudattaa samoja toi mintaperiaatteita kuin pylvaskuvissa. Viivakuvan
wizardin heikkoutena verrattuna tavalliseen viivakuvatydkaluun on, etta sen avulla kuvaan
el pysty méaérittelemdan ryhmittelevdd muuttujaa, jonka avulla samaan kuvaan saataisiin
eri ryhmia kuvaavia erilaisia viivoja. Wizard-tyokalu viivakuville avataan valitsemalla
ensin data aktiiviseks prosessidiagrammista ja klikkaamalla ” Graph” -> "Wizards’ ->
"LinePlot” . Tal6in aukeaa ensimmaéinen sivu:

Line Plot for KETUT_NUM

10f8  Werity Data ‘lsas’

The Line Plot "Wizard helps pou create bwo-dimensional line plots, with options for markers and line interpolations,

Active data

545 server. Local
Librany: KIR
Data zet; FETUT_MLIM

Samoin kuin pylvaskuvalla, tasta voi tar-
kistaa onko oikea data kaytossa. Jos data
on oikea, painetaan " Next”.

Mest » H Finizh ” Cancel H Help ]
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Seuraavalla sivulla méaritelld8n muuttujien roolit:

Line Plot for KETUT_NUM

2ofs Aszsignwvariables to roles lsas’
o "Horizontal” eli x-akselin ja "Ver-

l,——\/r Horizantal: @kuuk num tica” eli y-akse“n mUUttujien mad I
i - — ritykset ovat pakollisia. I
" Wertical: @lpaino -
. Liséks kohdassa "Chart by” voi- ——
e daan méaritella, ettd jonkin muuttu- —@
=) Mchart by L jan tasoille piirretéén erilliset kuvat. g

Kohdassa ”Summarize for each
distinct horizontal value” voidaan
madrédtd, etta kuvaan piirretédén y-
muuttujan arvojen sSijasta listasta |g 7
valittavan tunnusluvun arvot, jotka
on laskettu erikseen kullekin x-
muuttujan arvolle.

[ Summatize for each distinct horizontal valus

Finizh

’ < Back ]l MNest » H ” Cancel

Kolmannella sivulla méaritetdin viivakuvan asetuksia:

Line Plot for KETUT_NUM ” .y
Interpolation” -kohdassa

3of5  Line Plotoptions madritetédn kuvan tyypp| .
Viivakuvan ("Line”) lisdks ||
Iiteie / vaihtoehtoina ovat muun
ype: . .
_ . : muassa sirontakuvio (" Scat-
Llne 1| E ter”), SrontakUVIO Ja regr&_
e somali ("Regression”) ja
Style: wiidth [pisels] Calor keskihgjontakuva ("STD”).
Sold v =] | pefeutcomr \ | Kuhunkin kuvatyyppiin
_ liittyvét lisaméaritykset saa
Data point marker Val |ttua kohdasta ” Deta”” )
Symbol; Height [points]: Color;
Circle v.: 10 Eﬁ , Drefault colar ] )
2 3 % EE
Myds viivojen ("Line’) ja symbolien - ——
("Data point marker”) ulkoasuun voi
vaikuttaa.
< Back MNest » Finizh Cancel Help
J [ J J{ J f]ﬁl
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Neljannella sivulla on vield muutama kuvan ulkoasua koskeva lisaméaritys:

Line Plot for KETUT_NUM

4 ofh Specify appearance Jsaa
Sample chart;
Appearance ptions Tadla sivulla voidaan valita kayte- paino L
[¥] Use reference lines taanko I’efel’el‘l$IVIIVO]a (”USG refe' 18 5]
] Tick marks rence lines’) ja asteikon jakoviivoja 16 ®
("Tick marks’). Akseleiden sdlitys- 1
tekstit voi myds vaihtaa ("Axis La E" ol
bels’). ‘ o
B-—@
4
2 1 1 1 1 f 1 1
(IR el
kuuk_num
o
[ ¢ Back ]l Mest » H Finizh ” Cancel H Help ]

Viimeisella sivulla voi vield vaihtaa kuvien otsikoita ja alaviitteitd. Sivu on tasmalleen
samanlainen kuin pylvaskuvion wizard-tyokalun yhteydessi. Kuva saadaan vamiiks pai-
namallalopuks "Finish”.

Tehtava: Ota projektista kayttoon kaannetty kettudata nimeltd ketut_num, johon on tehty
numeerinen kuukausimuuttuja (ks. luku Viivakuva (Line Plot)). Piirra wizard-tyokalulla
viivakuva, jossa x-aksdlilla on kuukaus ja y-akselilla ketun paino. Y hdista kunkin ketun
toistomittaukset yli kuukausien viivalla.

Wizard-tyokalu piirakkakuvioille

Piirakkakuvioiden wizard-tyokalussa |ahdetéan liikkeelle samalla tavalla kuin muissa wi-
zard-tyokaluissa €li valitaan data aktiiviseks prosessidiagrammissajaklikataan ” Graph” -
> "Wizards’ -> "Pie Chart”. Ensimmaéinen ikkuna on sama kuin muissa wizard-tyoka-
luissa, eli siitéa voi tarkistaa, onko kdyttssa oikea data. Toisella sivulla méaritetéén muuttu-
jienroolit:
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# Pie Chart for VILJ2006_MUOK

set tehddén kohdissa

204 Assignvariables to roles
Required
» — 1
Q) Slice: | @ sukup v [a
{30 Slice size: .E. [Percentage) v
Optional
%% [ Group by: @

@ [ 5tack by:
@ ] Chart bw:

@

Liséks piirakkakuvioita voidaan ryhmitella
jonkin muun muuttujan arvojen mukaan
erillisks kuvioikss samaan kuvaan, eri
kuviin tai eri kerroksiin. Tama voidaan
tehda ” Optional” -otsikon alla olevista koh-
dista.

"Slice” ja "Slice size’.
" Slice”-kohdassa maéri-
tellédn muuttuja, jonka
kullekin luokalle tulee
oma sektori piirakkaan.
"Slice size” -kohdassa
médritellaén, miten sek-
torin suuruus méaaraytyy.
Lisdasetuksiin  paasee
tassakin  vaikuttamaan
kohtien jaljessa olevista
painikkeista.

Vattdmattomét  asetuk-

[ < Back ][ Nest = H

Einizh ][ Cahicel ][ Help

Kolmannella sivulla voidaan vaikuttaa piirakkakuvion ulkoasuun:

# Pie Chart for VILJ2006_MUOK

3of4

Specify appearance

30 chart

Colors

Schemes

Labels
[ Legend:

[¥] Slice name:

[ Percentage:

Data value:

Tala sivulla voidaan vaikuttaa kolmiulottei suu-
teen, varimaailmaan seké tekstien ja numeroiden
sijoitteluun kuviossa.

Sample chart:

:.Spring w .

:.Dutside v

:.Dutside V|

(Cemos ) [ |

Einizh ][ Cahicel ][ Help

]

Neljannella sivulla voidaan vaikuttaa kuvan otsikkoon ja alaviitteeseen samoin kuin muissa

wizard-tyokaluissa. Lopuksi painetaan ”Finish”, jakuvaon vamis.
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Tehtava: Piirrd wizard-tyokalua kayttéaen piirakkakuvio, jonka avulla havainnollistetaan
sukupuolimuuttujan frekvenssijakaumaa.

8.7 Kuvien tulostusmuoto ja yleisasetukset

Kuvien asetukset muokataan pddasiassa kuvien madrittelyn yhteydessd. Kuvia voidaan
kuitenkin muokata myos jalkikateen, jolloin paastéan osittain vaikuttamaan sellaisiin asioi-
hin, joita el kuvaa méariteltdessa saa muokattua. Jos kuva on tulostettu HTML- tai RTF-
kohteeseen, sité voidaan muokata klikkaamalla kuvan paalla hiiren oikealla painikkeella ja
valitsemalla ” Graph Properties’. Tall6in aukeaa valikko, josta pdastdan vaihtamaan kuvan
asetuksia. Kannattaa kuitenkin huomioida, etta muokattaessa valmista kuvaa téla tavalla,
muutokset elvét tallennu projektin mukana. Muokattu kuva kannattaa siis joko tallentaa
omaksi kuvatiedostokseen (hiiren oikealla painikkeella aukeavasta valikosta” Save As’) tai
kopioida leikepdydan kautta talteen esimerkikss Wordiin (hiiren oikealla painikkeella au-
keavasta valikosta " Copy”). Vamiin kuvan muokkaaminen onnistuu vain tavallisilla Acti-
veX-kuwvilla EG:ssd (HTML ja RTF) ja Internet Explorerissa (HTML). Huomaa, etta
muokkaaminen e onnistu muiden ohella ActiveX image (SASV9) -kuvatyypilla. ActiveX
image (SASV9) -kuvatyyppi on kuitenkin usein kayttokel poinen, koska sen avulla saadaan
hyva aatui sena tulostuvia kuvia. Tulostuslaatuun voi vaikuttaa myos suurentamalla kuvien
pikselimaaréa (" Tools” -> " Options’ -> " Graph”).

Tulostuskohteen paasee valitsemaan klikkaamalla” Tools” -> " Options” -> " Results Gene-
ral”. Valittavana on HTML (oletus), PDF, RTF, SAS Report ja Text Output (= perinteinen
SAS-tulostus, jota e voida kayttéa kuville). ”"Viewer”-vdilehdelld voi valita ohjelman,
johon tulostus automaattisesti aukeaa, ja kunkin tulostuskohteen omalla vélilehdella voi
tehda niihin liittyvia tarkempia méérityksia (muun muassa tulostustyylin méaritys).
"Graph”-vélilehdella ovat varsinaiset kuvan asetusten maaritykset:

Options
General Reszults > Graph
Project Views
Resultz Graphs
Results General Graph Format:
:I.?ni[ : hciivex s
i Options For Activest Tasta valitaan kuvatyyppi (ole-
545 Report Use these URLs for the codebase: tuk%na ACtIVE‘X) KaISO I|Sa'
SASE [hite /w2 sas com/codebasel -t et0a kappal eesta Tulostuksen
Stored Process SAS 3 | http: /w2 28z comdcodebasze| P : d< H h | | i
Data Pitp:/fumw2sas.com/codebasel g Proj ektin hallintaa.
Data General Testure maps location:
Performance ; -
Guery | C:4Program Files\5A5\Shared Files\mages Browese
(Huery
D ata
Tableandaraph T-- P -d -t e e -tt----
- &ss voidaan itse méarittaa
Tasks Gatiaral Diefault Gléph Dlmensmn.s kuvan pl k$| ien maara
Custorn Code (&) Best fit [let 545 decids)
Butput Libeary () Uze the following [in pisels);
SAS Programs
Security width; 3: Height: 3:
Administration
A it d 5
T:;Z?;ﬁ :;e Svel LCreate accezsible graphs when possible.
E-mail Settings | The: selection pane enables pou to select a category of options to view.
More [F1]...
Resst Al ok ][ cancel
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Asetusten maarittaminen ennen kuvan méérittelya e ole kuitenkaan ainoa tapa. Asetuksia
voidaan lisdksi muokata yksittéiselle jo méaritellylle tehtavasolmulle seuraavasti: klikataan
tehtavasolmua prosessidiagrammissa hiiren oikealla painikkeella, valitaan " Properties’ ja
vdilehti " Results’:

WALLELS Valitsemalla taméan kohdan voi ohittaa varsi-
naiset asetukset yksittai sessa tul ostuksessa.

General

Tulostustyylin

Parameters \4 valinta.
Surnmary Overmide the preferences set in Tool: -» Options /

Fesult Formats

Tulostus- T™~a HTHL Journal w
kOhteen [ ]EDF printer
valinta.

[JETF Rt

[(]545 Report Journal -
[ Teut

Graph Farmat; Activer V

Automatically direct resul)tévtn 545 Enterprize Guide

Kuvatyypin valinta. .
ezt Ophons

The zelection pane enables you to select a categon of options to view.

ki | More [F11...

k. ][ Cancel ]

Néiden valintojen jalkeen kyseinen tehtévasolmu pitda vield suorittaa uudelleen. Se onnis-
tuu klikkaamalla tehtévasol mua prosessidiagrammissa hiiren oikealla painikkeella ja valit-
semalla” Run tydkalun nimi”.

Y ksittéisen tulostusikkunaan tul ostetun kuvan voi myos tallentaa kuvatiedostoon tal siirtéa
sen leikepdydan kautta (" copy-paste”’) esimerkiksi wordiin. Kuvan tallentaminen *.jpeg-
tiedostoks onnistuu klikkaamalla valmista kuvaa tulostusikkunassa hiiren oikealla painik-
keella ja valitsemalla ” Save as’. Tall6in aukeaa ikkuna, jossa voidaan valita kansio ja tie-
doston nimi tallennettavalle kuvalle. Leikepdydan kautta kopioiminen puolestaan onnistuu
valitsemalla samasta valikosta” Copy” jaesmerkiksi Wordissa”Liitd’ tai " Paste”.

Vamiin tulostussolmun voi my@s avata toisessa ohjelmassa. Se onnistuu klikkaamalla

solmua hiiren oikealla painikkeella ja valitsemalla "Open With ohjelman nimi”.
Vaihtoehdot ovat HTML:lle Internet Explorer, RTF:lle Word ja PDF:lle Adobe Reader.
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9 Datan tarkastelu Describe- ja Analyze-valikoiden tyo-
kaluilla

Edelléa on kayty 18pi erilaisia kuvatyyppejd, joiden avulla voidaan tutkia ja vertailla aineis-
tossa olevien muuttujien jakaumia ja havainnollistaa muuttujien vélisia yhteyksia. Kuvat
ovat erinomaisia tulosten esittamisessa ja haluttaessa saada alustava kasitys aineistosta.
Tietoa aineistossa olevien muuttujien jakaumista ja muuttujien valisistd yhteyksista saa-
daan my0s erilaisten kuvailevien tunnuslukujen, taulukoiden ja datalistausten avulla. Téssa
esiteltdvien datan kuvailuun kaytettavien SAS Enterprise Guide -tyokalujen avulla pysty-
téén tunnuslukujen tai taulukoiden lisaksi tuottamaan myds joitain graafisia havainnollis-
tuksia muuttujien jakaumista ja yhteyksista.

Datan tarkastel usta kdydaan 14pi seuraavat Describe- ja Analyze-valikoiden tyokal ut:

Datan listaukset <@@P araph  Analyze  Add-In OLAP  Tools  Window  Help
5 Wizards P | = Summary Statistics... L
Tunnuslukuja 1
o B List Data.. [ Summary Tables...
Frekvenssitauluja \‘ T Summary Statistics. .
U, Diskribukion Anakysis, ;\ Jakaumatestit ja kuvat

Ristiintaulukointia e i :
3 Characterize Data. 4><_> Taulukointia

Khiin nelio -testi (-] Summary Tables.. q
\ 5| One-way Frequencies. .. ~~ Datan luonnehdinta

Table .ﬁ.nalysm )
Fill| / Korrel aatiot
/Si rontakuviot

F'.nal';.-'ze dd-In  OLAP Tools ‘Window  Help

AMOVA P | Maximize Warkspace
Regression 3
. — &
—| Multivariate b [l Correlations, S -
X
f Survival Analysis b | ¥ Canonical Correlation. ..

o Capability Analysis b % Principal Components. .. |

Contral Charks p | [ Eactor Analysis...
a i Pareto Chart... Cluster Analysis, ..
I Time Series ; “  Discriminant &nalysis. ..

i,
= £ Mode| Scoring. .

el

9.1 Datan listaukset

Y ksinkertaisin tapa tarkastella dataa on tulostaa koko data tai osia siité. Listausta voidaan
my®s muokata lukijaystavallisesmmaksi. Listaukseen voidaan valita vain osa muuttujista ja
suorittaa erilaista datan jarjestamista ja ryhmittelya. Listaus tuotetaan valitsemalla ” Desc-
ribe’ -> "List Data”, jolloin aukeaa " Task Roles’ -vélilehti. "List variables’ -kohdassa
luetellaan muuttujat, joiden arvot halutaan tulostaa. " Group analysis by” -kohtaan puoles-
taan laitetaan sellainen muuttuja tai sellaiset muuttujat, joiden mukaan tulostus halutaan
jarjestééd osaryhmiin. Taléin kukin osaryhma tulostuu omana taulukkonaan. Jos halutaan
kayttéa osaryhmiin jakoa, mutta tulostaa kaikki rivit silti samaan yhteen taulukkoon, ryh-
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mitteleva muuttuja tai muuttujat laitetaan ” Grouping analysis by” -kohdan liséks " ldenti-
fying label” -kohtaan.

Klikkaamalla” Options’ paastéan maarittel emaén tul ostusta tarkemmin:

Task Roles Options

Titles Fiows o list Heading direction

|l ows vl @Deffault Tasta voidaan maa
85::?;6?6' rittds, tulostetaanko

_ rivin numero jamilla
otsikolla se tuloste-
taan.

Cal idth
[ Printt the: row rumbey CHLITTIFY

(%) Default
[Fonnumber ]/ Qpul
|Jse variable Jabels as column headings O Minimum
) Unifarm
[ Privt riumber of rowes & Uil
[ Round values before summing
Divide page into sections [ho effect on HThL
DL-,Ilpul]p g [ [ 5piit labels at:

The zelechon pane enables pou to chooze different sets of options for the task.

Bun ” Save ] [ Cahicel ] [ Help

SAS Enterprise Guide - EG41

File Edt View Code Data Describe Graph  Analyze Add-In OLAF  Took  Window  Help

E -3 0G| o0 0y L X | sy oM | L | oo Project Designer [ Maximize Workspace 57 TackStatus

WILI2006_MUCK (Viljelija 2006) | @,
& < [x]| rt | @@ HTML-BarChatt | /& HTML-LinePlot | /& HTML -Pie Chait | & HTML -Bar Chat | ) RTF - Bar Chart Fleport | %] Fleport Snapshot | & HTML-ListData | « b >
HTHL - Line Plat ~ a
5y Distibute | 3
i SaS. | svererse cuen.
by inis
Vilelifa 2006
=89 Vilielja2006 xls [taul1$] The Power to Know..
=7 Impont Data ..
= Il:asl Subritted Cade Report Listing
og
[ KIRwvILI2008
73 KIRVILI2006 tuotsuun=1
=] E% Queary for KIR YILI2006
[£] Last Submitted Code A . ) N ) ) N n
Lo tulot id nimi sukup peltoa nautoja metsaa paino pituus ika ajanmuk tulevais
q
VILI2008_MUCK
= [ VILI2006 MUOK 92000 1 Jorma 1 247 0 120 112 178 | 54 2 1
(=i Seatter Plot =
[2] Last Submitted Code 25000 2 Tommi 1 110 0 70 90 195 31 3 2
Log
\_E HTML - Scatter Plat 16000 4 Jari 1 20 0 30 75| 175 33 4 2
=l Line Plat
Last Subritted Code 28000 6 Jarmo 1 112 0 24 68 181 | 35 1 2
Log
MBBEJML Chshlet 86000 7  sSampsa 1 210 50 &4 94 192 | 27 2 1
=] ar Chart
(R TR 21000 8 Antero 1 42 0 36 82 178 64 4 3
0g
%HTML GEEE 27000 9 |sSirpa 2] 22 0 47 61 158 61 s 3
FDF - Bar Chart
4&] 545 Report - Bar Chart 3
18] R1F 4 Chan 37900 11 Ossi 1 167 18 1s 83 182 | 49 1 1
-1 BoPlot
27 Lowt Subrited Codie 31000 14 EKalerve 1 94 0 115 73| 186 43 1 2
Log
& HTNL-BoxPla 37120 15  EKullervo 1 137 25 37 74 188 43 1 1
=& Piz Chart .
[2] Last Subritted Code 8500 16 Maire 2 12 5 1 43| 159 19 5 2
Log N
& HIML -Pie Chan 26700 17 Nico 1 77 0 s2 67 184 21 3 2
= @4 Bar Chart
%Q Last Submitted Code i 38000 18  Timo 1 13 0 10 94 172 | 27 4 2
Log
& WTHL - Bar Chat 21800 19 Seppo 1 60 0 15 52 189 35 2 1
= €5 Pis Chart
[2] Last Submited Code 25800 20 | Paivi 2 69 8 87 53| 152 |31 2 1
Log
{8 HTML - Pie Chart 13800 22 | Jonne 1 27 is is 58 179 34 3 3 v
=8 ListData
[£] Last Submitted Code |
= Task Status Quewe Server
{8 HTHWL - List Dt
= FE Flim bVl A0S KA IR )
|
Ready 1 [Unknown] connected ta locakhost
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Tulostusta voitaisiin vielé hioa esimerkiksi méarittelemalla dataan seliteteksteja muuttujille
ja formaatteja muuttujien arvoille kdyttéen samaa tekniikkaa kuin Datan muokkaus -lu-
vussa.

Tehtava: Tee Viljelija 2006 -aineistosta (vilj2006_muok) listaus, jossa tulostetaan viljeli-
jan nimi seka tiedot kunkin viljelijan peltohehtaareista, metsdhehtaareista, nautojen luku-
maéarasta jatul oista.

9.2 Datan luonnehdinta -ty6kalu (Characterize Data)

Datan luonnehdinta -tyokalun avulla saadaan helposti yleiskuva aineiston muuttujista. Tyo-
kalu tulostaa kategorisille muuttujille frekvenssitauluja seké pylvaskuvioita. Numeerisille
muuttujille puolestaan voidaan tulostaa tunnuslukuja seké histogrammeja. Kaikki tulostus
e ole valttdmétta mielekastd, mutta yleiskuvan muuttujien jakaumista téla tyokalulla saa
nopeasti. Tyokalu saadaan kayttoon valitsemalla data aktiiviseks prosessidiagrammista ja
valitsemalla” Decribe” -> " Characterize Data” . Ensmmaisella sivulla voi vaikuttaa kay-
tettdvaan dataan. Toisella sivulla tehddan térkeimmét valinnat:

¥ Characterize Data for YILJ2006_MUOK

2ofi Selectthe report options. J%S'
Output Types

Sy At Talasvulla valitaan tulostetaanko HTML -

. muotoisia frekvenssitauluja ja tunnusluku-

taulukoita (" Summary Report”), pylvésku-
via ("Graphs’) vai frekvenssitauluja ja
545 server Local tunnUSIUkUja SAS'datat|edOStO|h|n (”SAS
Litrary: KIR: Data Setsﬂ ) .

[ata set: FREOCHARFH

1545 Data Sets

545 server Local
Library: KIR
Data sef: UNMCHARUNMARIATEFORWILIZO0_ 0000

[ ¢ Back ]l Mest » H Finizh H Cancel H Help ]

Viimeisella sivulla voi viela valita, montako kategorisen muuttujan luokkaa huomioidaan
maksimissaan erillisind luokkina. Lopuksi painetaan " Finish”.

72



9.3 Jatkuvan muuttujan jakauman tarkastelu

Datassa olevan jatkuvan muuttujan jakauman tarkastelua varten esitelléan kolme varsi-
naista SAS Enterprise Guiden tyokalua seka tunnuslukujen taulukointiin kytettévissa ole-
vat wizard-tyokal ut.

9.3.1 Distribution Analysis -tyokalu

Y hden jatkuvan muuttujan jakauman tarkastelua on kéteva tehda " Distribution Analysis’
tyokalulla, jolla saadaan tulostetuks listauksia jakaumaa kuvaavista tunnusluvuista. Li-
séks voidaan testata, onko havaittu otos peréisin jostakin teoreettisesta jakaumasta, esi-
merkiksi normaalijakaumasta. Myo6s erilaisia jakaumia havainnollistavia kuvia saa
tulostettua katevasti. Alkuun paéstéan valitsemalla kéaytettéava data aktiiviseks ja klikkaa-
malla " Describe” -> "Distribution Analysis’. Taloin aukeaa "Task Roles’ -vélilehti,
jossa tarkasteltava jatkuva muuttuja tai jatkuvat muuttujat sijoitetaan kohtaan ”Analysis
variables’. Jos haluttaisiin tarkastella yhden jatkuvan muuttujan jakaumaa jonkin kategori-
sen muuttujan eri luokissa, sijoitettaisiin kategorinen muuttuja kohtaan ”Group analysis
by”. Védilehdella " Summary” puolestaan voidaan mééritella testit, joilla tutkitaan ovatko
havaitut muuttujan arvot otos jostakin tunnetusta jakaumasta:

i Distribution Analysis for VILJ2006_MUOK

Task Roles Distnibutions > Summary

fasle di / Taman avulla tutkitaan, voiko otos €li ha-
fraletle dsigion vaittu jakauma olla persisin normaalija-

[ Hormal kaumasta. Tilastollisesti merkitseva p-arvo
[ Lognormal ilmaisee, ettd normaalijakaumaoletus ei ole
Evporeriid reaistinen. Samalla periaatteella otosta
voidaan verrata muihin tunnettuihin ja
kaumiin.

Distributions

Summary

Marmal

Lognormal
Exponential
Woeibul
Beta
Garmma
Kernel

Plats
Appearance
Inzet

Tables

Titles

[Jkemel

Oletuksena testattavaan teoreettiseen jakaumaan, esimerkiksi
normaalijakaumaan, lasketaan tarvittavat parametrit aineistosta.
Jakaumien nimi&a kantavilla vélilehdill&a voidaan kuitenkin myds
madritella testattavan jakauman parametrit etukateen (esimerkiksi
normaalijakaumalla keskiarvo ja varianss).

o o
[ Bun ” Save ] [ Cahicel ] [ Help

73



"Plots” -> " Appearance’-vélilehdella voidaan puolestaan maaritella muuttujan jakaumaa
havainnollistavat kuvat:

Jli; Distribution Analysis for VILJ2006_MUOK

Task Bales Plotz > Appearance
Diztributions
Summary Mote: Insets are valid on histograrn, probability Az Background — Axis width:
Mormal and quantile-quantile plotz only. color: color:
Lagnarmal
Exponential . » . y - . . »
Wbl g Pt Probability Plot” ja "Quantiles Plot
pee i kuvaavat samaa asiaa. Molemmissa ver-
e e rataan muuttujan havaittua jakaumaa
otz . . .
_ samaan (mutta eri tavoin esitettyyn) teo-
|t Huantiles plat . .
b reettiseen jakaumaan.
Titles B plat .
"Text based plots’ tuottaa tekstimuodos-
Test based plots sa muun muassa runko-lehtiesityksen ja
| aatikko-janakuvion.
The selection pane enables you to chooze different zets of optiohs far the task.
e o

Bun H Save ] [ Cancel ] [ Help

"Tables’-véalilehdella puol estaan maaritetdan tul ostettavat tunnuslukutaul ut:

VTS———————— 5

Tosk fes Tables ("Basic measures’), lisda tunnusiukuja
Summary 7 3 7 / (”l\/loments"), aan mma'%t arvot (" Ext-
i : B agic confidence intervals . . .
oima Basic measures reme values’) ja normaalisuustestit
Lognormall Tests for location - eom :
Exponential Edrome rows (" Tests for normality”). Normaalisuustes-
prep e tit voidaan diis valita ”Summary”-
Beta Frequencies . . e s N esnpgat
Gamma Modes vdlilehden lisdksi myds téalta.
Kemel v Moments
Plots Quantiles
Appearance Robust measures of scals
Insst A Tests for nomalty Tulostus voidaan tallentaa tiedostoon
Trirmed reans )
Titles Winzorized means

v

[ 5ave output statistics to a data zet

O Suppress descriphive stahistics and
capability indices tables

Dizplays a table that showes the measures of location and the measures of varability.
oE =B
T T | |

Lopuksi valitaan " Run”.
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Tehtava: Tutki Viljelija 2006 -aineistosta (vilj2006_muok) ik&muuttujan (ika) jakaumaa.
Tarkastele sijaintia, hgjontaa, muotoa ja poikkeavia havaintoja.

9.3.2 Summary Statistics -tyokalu

Enterprise Guiden Summary Statistics -tyokalulla on mahdollista tulostaa jatkuvan muut-
tujan jakaumaa kuvaavia tunnusliukuja taulukkomuodossa. Tama on erityisen kateva tyo-
kalu, jos halutaan laskea tunnuslukuja erikseen yhden tai useamman kategorisen muuttujan
luokissa. Tyokalu saadaan kayttdon valitsemalla kaytettdva data aktiiviseks prosessidia
grammista ja klikkaamalla " Describe” -> " Summary statistics’, jolloin aukesa " Task
Roles” -ikkuna:

Summary Statistics for VILJ2006_MUOK

<k Roles Task Roles . . .
Statisics w—— o Muuttuja, jonka jar
Basic aniables to assign: ask roleg: - .
Percentiles Mame Apalyziz varﬂ)le‘( kaumaa haval nnOI l |S.te'
addions | | @ ig . @ pius taan tunnuslukujen
Plots . Clagsification variables
Fiesults %:::up @ tuotsuun avulla
Titles @ i Frequency count [Ngit: 1
- oa. Relative weight [Limit;
% naL:to|a @ Copy variables
metzaa : H H
@ tuetsuen B e Kategoriset ~ muuttujat,
@ paino joiden eri luokissa vas-
g;‘a temuuttujan  jakaumaa
@ tulat tarkastellaan.
@ EE
@ tulereais
The zelechon pane enables pou to chooze different sets of options for the task.
g Bl
Bun ] [ Save ] [ Cahicel ] [ Help
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Laskettavat tilastolliset tunnusluvut ja testit valitaan "Basic”-, " Percentiles’- ja " Addi-
tional”-vélilehdilla Ohessa”Basic’-vdlilehti:

Summary Statistics for VILJ2006_MUOK E|
T ask Foles Statistics > Basic
Statistics
Basic statistics
Percertiles Mean Marimum decimal places:
Additional Standard deviation Best fit ~
:leoizlts A Sta.ndald ernor
Tites ﬁa"fn”c: "Maximum decimal places’ -kohdassa
Magimum voidaan vaikuttaa tulostettavien tunnuslu-
(] Range kujen desimaalien mddréén. Huomaa, etta
[ 8um sama asetus patee pasasiassa kaikkiin tun-
nuslukuihin. Jos kéayttga haluaa vaikuttaa

Mumber of obzervations

Mumber of missing values ykSI ttal sen tunnUSI uvun de'Sl maal | en maa'
raan, kannattaa taman tyokalun sjasta
kéyttéa” Summary Tables’ -tyokalua.

The zelection pane enables you to choose different sets of options for the task.
O =B
[ fn [ swe ) [ cowe J[_ren ]

"Plots’-vdlilehdella voidaan maaréta piirrettavaks histogrammi ja boxplot-kuva. Tul ostuk-
sen gjaminen SAS-dataks voidaan méaritella” Results’-vélilehdell&:

Summary Statistics for VILJ2006_MUOK Tassa Valltaan tUlOg:US datakSI Seka
Tk ks Results tuloksena syntyvan SAS

Basic [7] Save statistcs to data set datatiedoston sijainti ja nimi. Téta \

A . . o

ﬁzrd..;t?;n? LocatKIR. TUNNUSLUKLJA kohtaa tarvitaan esimerkiksi SI”O.In’ L
Plots kun halutaan laskea osaryhmien
Ti . [¥] Shows statistics keSklarVOt Ja kayttaa n”ta ha.Va' n-

toina jatkoanal yysei ssa.

Cambinationz of classification variables: Meway anly \v

Té&sta voidaan valita, lasketaan-
ko vain osaryhmien tunnusluvut
va myos esimerkiksi koko da
tan keskiarvo. "N-way” laskee
tunnusluvut vain osaryhmille.

The zelechion pane enables pou to chooge different etz of optionz for the task.
O =B
T T | |
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Tulostuksena saadaan seuraava taul ukko:

& SAS Enterprise Guide - EG41_kurssi_Project

Fie Edt Wew Code Data Describe Graph  Analyze Add-In OLAP  Tools  Window  Help

95 HGELDAE X DO 2 . - BogProject Designer [ Maximize Workspace G Task Status

Summary Statistics for KIR WILIZ006_ ~ _ © | @
B < [x]| %) Report Snapshot | @ HTML-ListData | & HTML- Characterize Data | [ VILI200E_MUOK (1ead-only) 8 HTML - Distribution Analpsic | # HTML- Summary Statistics | 4 b X
T 1

E'{!‘Sﬂ‘ ” | f H abl , )Sas. | Enterprise Guides ”Group Charts by”
| " Classification  variables el tuottaa  muttujan

2 Plat
[uokille erilliset tau-

e tyottaa erilliset luokat sa- Summary Statistics

™| maan taulukkoon. i lukot
ra The MEANS Proceduy :
HTHL - Bar Chart

POF - Bar Chart

sukup=1
545 Repart - Bar Chart
RTF - Bar Chart
 Plot Analysis Variable : pituus pituus
Last Submitted Code
Lo tuotsuun N Obs Mean Std Dev Mini Maximum N N Miss
HTML - Box Plot
Chart
Last Submitted Code A 1 30| 181.7333333|68.2082101 | 163.0000000 205.0000000 30 1]
Log
e 2 12 | 180.1666667 | 7.2467339 1690000000 190.0000000 | 12 0
Chart »*

Last Subitted Code: _
= sukup=2
HTHL - Bar Chart
Chart

Last Submitted Code:
Log

HTHL - Pie Chart
Dats

Last Submitted Code 1 6| 161.1666667  6.0470378 152.0000000 168.0000000 € 0
Log
HTML - List Data 2 5 | 168.8000000  6.0991803  161.0000000 177.0000000 5 ]
wacterze Data

Last Submitted Code:
Lo Generated by the SAS System (Local, XP_PROQO) on 14.2.-07 at 2:28 PM
HTHL - Characterize Data =

ribution Analysis

Last Submitted Code:

Log

Listing - Distribution Analysis
HTHL - Distribution Analysis
nmary Statistics

Last Submited Code: 3
Log r @
Summary Statistics for KIR VILI2006_MUIDK. Task Status Queus Server

HTHL - Summary Statistics
W1 19008 WALIOK

<

Analysis Variable : pituus pituus

tuotsuun N Obs Mean Std Dev Minimum Maximum N N Miss

v
>

Ready [ [Urknown] cornected to lacalhast

Tehtava: Tutki Viljelija 2006 -aineistosta (vilj2006_muok) pituus-muuttujan jakaumaa
sukupuolen ja tuotantosuunnan eri luokkakombinaatioissa. Kayta tdhan tarkasteluun tilas-
tollisia tunnuslukuja ja mahdollisesti my6s kuvia.

9.3.3 Summary Tables -tyokalu

Kolmas tapa laskea tunnuslukuja on kayttaa taulukointitytkalua Summary Tables. Tama
tyokalu saadaan kayttoon valitsemalla kaytettdva data aktiiviseks ja klikkaamalla ” Desc-
ribe’” ->” Summary Tables’. Sitten annetaan " Task Roles’ -vélilehdella muuttujat, joiden
jakaumaa tarkastellaan (" Analysis variables’), sekd ryhmittelevat muuttujat (" Classifica
tion variables’).
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V arsinai seen taulukon méaérittelyyn paéstéén ” Summary Tables’ -vélilehdella:

IE Summary Tables for VILJ2006_MUOK

T ask Roles Summary Tables
Surnmary Tables
Results Aivailable variables: Preview: K7 E E
Titles 4% aLL funiversal.,. .
@paino Box Area @ pane
A sukup il Mean | StdDev | Median a1 fox]
49 tuotsuun |
&P tuotsuun
Muuttuj at £ sukup
| 4P tuotsuun
Avalable stalitics: Luokittelevien muuttujien, analysoitavan muuttujan
2 ;emf-“ ja tunnuslukujen sijainti lopullisessa taulukossa mééa-
'ckSum epork . way nnan . . .
Probt  2-taled . rétédn raahaamalla ne vasemmalla nakyvistd muuttu-
= e ja ja tunnuslukulaatikoista taulukon haluttuihin
Tunnusluvut kohtiin.
RepPct... Report. o . . s el
2 | e Jos tunnusluku tal muuttuja halutaan mégrittéa esi-
The selection pane enablesye] MEFKIKS toisen muuttujan alle (kuten tuotsuun yll8),
. B e pi_téé raahata tauluk__os&a __tiettyyn _gvai_nk(_)_htaan.
Tallaiset avainkohdat |6ytyvét yleensa rgaviivojen u
TEVIEW Code
- = tuntumasta. —

Tunnuslukuihin voi tehda lisamaérityksia valikosta, joka aukeaa klikkaamalla hiiren oike-
alla ngppdimell& taulukkoon lisdtyn tunnusluvun paélla Talldin voidaan valita esimerkiksi
"Data Value Properties’, jossa voidaan ”Format” -valilehdella yhdistda tunnuslukuun for-
maetti w.d, jonka avulla saadaan vaihdettua desimaalien maéraa tul ostuksessa.

Tuloksena syntyy seuraava taulukko (RTF-kohteeseen ohjattuna):

paino

StdDe
N | Mean v Median Q1 Q3

sukup [tuotsuun

1 1 30 83.07| 15.58| 8250, 73.00/ 92.00
2 12| 84.08| 17.15/ 80.50| 76.50| 92.50

2 1 6/ 5433 995 57.00f 43.00/ 63.00
2 5/ 73.80 15.75| 80.00/ 64.00f 81.00
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RTF-taulukko on siirretty Wordiin EG:n tulostusikkunasta valitsemalla se aktiiviseks ja
kopioimalla ja liittamall& leikepdydan kautta. Samalla tekniikalla voidaan siirtdd muitakin
EG:n RTF-tulostusobjekteja Wordiin. Talldin taulukkoa paastéan vielda muokkaamaan
Wordissa muun muassa siirtaméalla sarakkeiden rgjoja ja muuttamalla fonttia. Taulukosta
saadaan Wordissa muokattua esimerkiksi seuraavanlainen:

Paino (kg)
Keski- Ala MES
N | Keskiarvo | hgjonta | Mediaani | kvartiili | kvartiili

Sukupuoli | Tuotantosuunta
Mies Peltoviljely 30 83.1] 15.58 82.5 73 92

Kotieldimet 12 841 17.15 80.5 76.5 92
Nainen Peltoviljely 6 54.3 9.95 57 43 63

Kotieldimet 5 73.8 1575 80 64 81

Taustavarit saa poistettua Wordissa esimerkiks valitsemalla koko taulukon aktiiviseksi
(klikkaamalla vasemmassa yl&kulmassa toisinaan nakyvaa laatikkoa), klikkaamalla hiiren
oikeaa nappéinta ja valitsemalla” Reunat ja sdvytys’. Aukeavassa ikkunassa mennaan ” S&
vytys’-vélilehdelle ja valitaan " Tayttokuvio”-kohdassa " Ei tayttod” .

Tehtava: Tee Viljelija 2006 -aineistosta (vilj2006_muok) taulukko, jossa ika-muuttujalle
on laskettu soveltuvia tunnuslukuja sukupuolen ja tuotantosuunnan eri luokkakombinaa-
tioissa. Vie taulukko myds Wordiin tai muuhun tekstinkasittelyohjelmaan ja harjoittele
taulukon muokkaamista siell&

9.3.4 Tunnuslukujen taulukointi wizard-ty6kaluilla

Samoin kuin kuvien myo6s jatkuvan muuttujan jakauman tarkasteluun [6ytyy Enterprise
Guiden versiosta 4.1 muutama wizard-tyokalu. Naiden tyokalujen tarkoituksena on tarjota
entistéa helppokayttdisempi, vaihtoehtoinen tapa tunnuslukujen taulukointiin. Wizardissa
maédrittelyt on jaettu useammalle sivulle, joiden |8pi edetdan jarjestyksesss, ja lopuks va
litaan "Finish”. Seuraavassa esitellééan lyhyesti EG:sta [6ytyvéa ”Summary Statistics’- ja
"Summary Tables” -wizard-tyokalut. Nama vastaavat samannimisia tavallisia EG-tyoka-
luja.

Summary Statistics wizard

Tarkastellaan ensin ”Summary Statistics” -tyokalua, joka saadaan kaytt6on, kun valitaan
aktiiviseks kaytettéava data prosessidiagrammista ja klikataan ” Describe’ -> " Wizards® -

> "Summary Statistics’. Ensmméisella sivulla voidaan tarkistaa, etta aktiivisena oli
varmasti oikea data. Toiselle valilehdelle paastéén klikkaamalla” Next”.

79



Toisdllavélilehdella maaritellédn muuttujien roolit:

Summary Statistics for VILJ2006_MUOK E|
2 of4 Assign variables to roles J%S'
Available variable Tahan . |aat|kkoon |a'|tetaan El Summary statistics of [Analpsiz variable):
@id muuttuja, josta lasketaan | @«a
o tunnusluvut. e
@ pelon
@ hautoja b
@ metgaa
@ luollsuun Tahan Ialtetmn ryhmlttel eva ‘8| For each value of (Classification variable]:
i@ paino . .
@ pius muuttuja, jonka halutaan | @ tuotsuun
%itklat jakavan ryhmét eri riveille | | *
@ swnu | SAMasSA taul ukossa " Advanced”-valinnan |
@ wievais ata l6ytyvad muut
E Separate tables for wal mahd0| | | %t I’OO| |t,
Tahan tulee ryhmitteleva [— SN Jol h.' : _mmuuttupa vol
o B yhdistéa
muuttuja, jonka halutaan
jakavan ryhméa erillisiin
taulukoihin.

[ ¢ Back ] I Mest » ] ’ Finizh ] [ Cancel ] ’ Help ]
Kolmannella sivulla valitaan mita tul ostusta hal utaan:

Summary Statistics for VILJ2006_MUOK E|
3of4 Specify statistics and results J%S'
Statistics: MEAN: STD: MIN; Mas: N Vadittavana on tunnuslukutaulukko

("Show dtatistics’), histogrammi
Aosuite ("Histogram”), laatikko-janakuvio
- / ("Box and whisker”) ja tunnusl uku-
St sl jen talentaminen SAS-dataks
(] Histogram (" Save statistics to data set”).
[1Box and whisker . )
S e Tulostettavat tunnusluvut voi valita
e L | painamalla painiketta” Edit” .
Librar: . KIR
[ata sek: MEAM SummaryStats' I LI2006 W LDk
¢ Back ] ’ Mest » ] ’ Finizh ] [ Cancel ] ’ Help ]
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Viimeisella sivulla voi vaihtaa kuvaan liittyvét otsikot ja alaviitteet. Lopuksi painetaan
"Finish”, jolloin saadaan samanlainen tulostus kuin vastaavilla valinnoilla tavallista
”Summary Statistics” -tyokal ua kayttaen:

@ SAS Enterprise Guide - EG41_kurssi_Project CEX)

Fie Edt View Code Data Desorbe Graph  Analyze Addn  OLAP  Tools Window Help

S 5 B oes O X 9 o |0, - BegProject Designer [ Maximize Workspace B Task Status
vilielia2008 s (caul1$) (vijelia 200~ © @

ProjectExplorer < [X]

cterize D ata [ VILJ2006_MUOK [read-only) & HTML - Distibution Analysis {8 HTML - Summary Statistics ) ATF - Summary Tables \ (€ HTML - Summary Stalistics jir %
-~

og
8 HTML - Line Piot

= il Bar Chart N
[2] Last Submitted Code )SaS. | Enterprise Guides

Log
7 HTHL - Bar Chat The Power toKnow.
PDF - Bar Chat

% SRR T Summary Statistics
- Bar Chait

5Bl Box Pl Results
[£) Last Submitted Code
Log
& HTHL -Box Plot The MEANS Procedure
=25 Pie Chart
[£] Last Submitted Cade sukup=1
Log
& HTHL - Pie Chart
=9 E:' Ehans et o Analysis Variable : ika ika
=] Last Subrmitted Code
Log

B HTHL -3 Cran tuotsuun N Obs Mean Std Dev Minimum Maximum N

E‘WEL:E::(tSmeI“EdCUde 1 30 | 39.6333333 11.357766€1 16.0000000  64.0000000 | 30
=)

L
%H;QML,%EM“ 2 12 | 44.3333333 12.8511289 26.0000000 €0.0000000 12
=18 List Data
[£] Last Submitted Code
Log
& HTHL - List Data

Charact Dat: : . . .
=] Eﬁmar;fgiimii;cme Analysis Variable : ika ika
=

L o .
@H%L_Eha,amaﬂmna,a tuotsuun N Obs Mean Std Dev Minimum Maximum N
=4l Distribution Analysis
[2] Last Subritted Code 1 6 [34.5000000 14.4741148 19.0000000 6€1.0000000 &
2] Log
[ Listing - Distribution Analysis 2 5 | 38.6000000 16.9351705 23.0000000 67.0000000 5
8 HTHL - Distibution Analysis

= E Summary Statistics

E%—?Laﬂﬁuhmi"édﬁﬂde Generated by the SAS System (Local, XP_PROQ) on 14.2.-07 at 3:29 PM

sukup=2

Log
5 Summary Statistics for KIRMVLY
& HTML - Summary Statistics
= [ Summary Tables
[£] Last Submitted Code
] Log
B0 RTF - Summary Tables
S T Summary Statistics =
[£] Last Submitted Code =al
2] Log Task Status Queus Server
{8 HTML - Summary Statistics
S S rornarn Tablar

> < >

Ready [ [Urknown] cornected to lacalhast

Tehtava: Tutki Viljelija 2006 -aineistosta (vilj2006_muok) ika-muuttujan jakaumaa suku-
puolen ja tuotantosuunnan eri luokkakombinaatioissa. Laske tarvittavat tilastolliset tun-
nusluvut Summary Statistics wizard -tyokalulla.

Summary Tableswizard
Toinen taulukointia tekeva wizard-tyokalu saadaan kayttoon valitsemalla kaytettdva data

aktiiviseks jaklikkaamalla” Describe’ ->"Wizards’ -> " Summary Tables’. Ensimmai-
sellé sivulla voidaan taas vahvistaa, ettd kdyttssa on haluttu data.
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Toisella sivulla puolestaan méaritellédn muuttuja tai muuttujat, joiden arvoista lasketaan
tunnuslukuja, seka laskettavat tunnusluvut:

IE Summary Tables for VILJ2006_MUOK

2 ok

Select analysis wariables and statistics

[T Analysis varisbles:

Add b

Wariable
@ paing
@ paino

Statistics labels:

Analysiz vanable labels:

Statistic
Average

Standard Deviatian

| in columns w |

| in columns v |

»SdS.
Tehtdessa valintoja tyo-
Previenw: 5 =% i
_ : kalu nayttaé esikatselun

paino | paino / muodostettavasta taulu-
Mean | StdDey

kosta
933 333

Muuttujan saa lisditya listaan klikkaamalla
"Add”.

Laskettavan tunnusluvun saa puolestaan valit-
tua alasveto-valikosta muuttujan kohdalta. Tas-
s tyokalussa on vdhemman tunnusiukuja
valittavana kuin varsinaisessa ” Summary Tab-
les” -tyOkalussa. Liséks kullekin muuttujalle
saa listassa valittua vain yhden tunnusiuvun,
joten sama muuttuja pitda lisita listaan use-
amman kerran, jos halutaan laskea useampi
tunnusluku.

l EacK J l THERT J l ETAETT J l

T ancET J l HElp

Kolmannella sivulla méaritelldan ryhmittelevdt muuttujat:

IE Summary Tables for VILJ2006_MUOK

ta ta taulukoita. Téssa ryhmittelevdt muuttujat on
sijoitettu rivimuuttujiksi, koska analysoitava muuttu-

3oik Select classification wariables )Sas.
[ Calumns: Add Freview:
paino paino
Mean | StdDey
939 935
Zal tuiatsLUn

[ Bows: dd ) 939 939

i sukup e 939 499

@ tuatzsLun tuiatsLUn e e
* Tatal 959 333

() Pages: Add [] . .o . .

- “=| Ryhmittelevét muuttujat voi sijoittaa sarakemuuttu-
jiksi ("Columns’), rivimuuttujiks ("Rows’) tai si-
vumuuttujiks ("Pages’), jolloin muuttujien tasoista
tulee valinnan mukaan joko erillisia rivejd, sarakkei-

jaon oletusasetuksilla sarakemuuttujana.

[ <Back | [ Mews ][ Firish

=]

Help

|
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Neljannella sivulla voi méaritelld, lasketaanko tunnuslukuja taulukkoon yli osaryhmien:

IE Summary Tables for VILJ2006_MUOK

4 of6  Specify totals J%S'
Presvigw:
paino painio
M StdD
Bows: 2 ean ey
933 939
tuatzuun
933 939
sukup
933 939
tuotsuun
933 939

Tassa tapauksessa voitaisiin laskea tunnuslu-
Label for totals: Total kuja taulukkoon yli osaryhmien €li yli rivien
("Rows’). "None”-vaihtoehdolla on kuiten-
kin mééritetty, etta tunnuslukuja el lasketa
yli osaryhmien.

’ < Back ]l MNest » H Finizh ” Cancel H Help ]

Viidennella sivulla voitaisiin vield hal uttaessa tallentaa tunnusluvut SA S-datatiedostoon, ja
kuudennella sivulla méarittaa tulostuksen otsikoita ja alaviitteitd. Lopuks painetaan ”Fi-
nish”, jolloin saadaan tulostus, joka vastaa tavalisen " Summary Tables’ -tydkalun tulos-
tusta samoilla asetuksilla.

Tehtava: Tutki Viljelija 2006 -aineistosta (vilj2006_muok) paino-muuttujan jakaumaa
sukupuolen ja tuotantosuunnan eri luokkakombinaatioissa. Laske tarvittavat tilastolliset
tunnusluvut Summary Tables wizard -tyokalulla.

9.4 Kategorisen muuttujan jakauman tarkastelu

Kategorisen muuttujan jakaumaa voidaan tarkastella Enterprise Guidessa valitsemalla kay-
tettdva data aktiiviseks prosessidiagrammissa ja klikkaamalla ” Describe” -> " One-Way
Frequencies’. Tarkasteltava kategorinen muuttujatal kategoriset muuttujat laitetaan “ Task
Roles’ -vdlilehdella kohtaan " Analysis variables’. Jos halutaan erilliset frekvenssitaulut
jonkin toisen muuttujan tai toisten muuttujien eri luokissa, kyseinen muuttuja tai muuttujat
laitetaan ” Group analysis by” -kohtaan.
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" Statistics’ -valilehdella maaritel18an frekvenssijakauman tarkasteluun liittyvia asetuksia:

One-Way Frequencies for VILJ2006_MUOK

Valitaan, mita tulostetaan kuvaamaan
Statist ) . .

e kategorisen muuttujan  jakaumaa
G Frequency tabls options Binormial proportions Vaihtoehtona on erilaisia yhdistelmia
I Include: i . . . .
- . ClAemptotc e seuraavista: frekvenssit eli luokkien

:quencies and [] Exact p-values . . e .
Szt esiintymisten lukumaarat, kumulatii-

- Freauencies and viset frekvenssit, prosenttiosuudet ja
cumulative frequencies P .
oo kumulatiiviset prosenttiosuudet.

® Frequencies and
percentages

() Frequencies anly

Mizzing values Chi-zquare goodness of fit
Show frequencies [ ssymptotic test

/ [ Inciude in calculations [] Exact p-values

Puuttuvien arvojen kasittely. Jos valintoja ei tehdd, frekvenssitaulun alle
tulee maninta puuttuvien havaintojen maarésta. ”Show frequencies’ -
valinnalla puuttuvista havainnoista tulee oma rivinsa varsinaiseen frek-
venssitauluun. "Include in calculations’ -valinnalla puolestaan luokkien
prosenttiosuuksien laskemisessa puuttuvia havaintoja pidetéén omana
luokkanaan ja puuttuvien osuudeksi |asketaan osa sadasta prosentista.

B b |

"Plots’-vélilehdella voidaan méritella tulostettavaks pylvaskuvio ja "Results’-vélileh-
della maéritella, ettd frekvenssijakauma tulostetaan SA S-datatiedostoon. Samalla voidaan
madritellg, ettaruudulle el tulosteta mitdan. Kun painetaan ” Run”, saadaan tul ostus:

&: SAS Enterprise Guide - EG41_Kurssi_Project. E]gl

File Edit View Code Data Desuibe Graph  Analyze AddIn  OLAP  Tooks ‘Window Help

B-2- T adLrhE X5 . - BogProfect Designer [5] Maximize Workspace  E57 Task Status
testiz (Vifjelijs 2008) ik @,
[ [ | E— ] RTF - Summan Tables | @ HTML - Summany Statistics | @8 HTML - Summany Tables | & HTML - Summary Tables | {3 HTML-One-Way Frequencies | [ 4 b X
] RTF - Summary Tables ~ -~
i Summary Statistics tulevais

[£] Last Submitted Code

% t{t'l[gl\AL—Summalyﬁlanslics TU| a/al SUUdennakymat tulevais  Frequency Percent

& Summary Tables 1 18 35.85

[£] Last Submitted Code - ” PRl -
8 1="Hyvat 2 2 415t Tulostukseen ol

/B HTML - Summary Tables

[ Summary Tables 2 =" OK” 3 12 22.64 Val IttU

[£] Last Submitted Code

=" § A
3 ="Huonot N~

s System (Local, XP_PRQ) on 14.2
| — 1) frekvenssi-

b Duery for VILI200E_MUOK

% \[astﬁuhmitled Code 0ne-Way Frequencies J akauma
2] Log

‘rEa\rcH;vT\lfﬁangnsiMUDK Plots 2) pyIV | uv|0

(=] Last Submitted Code

= Log .
5 e _TiEDOT ey

1 VILI_TIEDOT

 Guery forVILL_TIEDOT K
(=] Last Submitted Code
=] Log
5 VILI_MIES

b Query for VILJ_TIEDOT
[£] Last Submitted Code
=] Leg
55 VILI_NAINEN

1 VILI_MIES
% Append Table

[£] Last Submitted Code

=) Log
5] VIL)_MOLEMMAT
YILIZHAINEN
YILI_MOLEMMAT
TILA_TIEDOT

L

] for VILI_MOLEMMAT
g

ey

] Last Submited Code

] Log

T3 Ouery_for_VILI_MOLEMMAT
i2

E=]

] test

OneWay Frequencies .
[2] Last Submitted Code 1 e

2] Log Task Status Queue Server

/B HTML - OneWay Frequencies
nnnnnnnnn

Fieady 11 [Unknown] connected talocalhost
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Tehtava: Kayta Viljelija 2006 -aineistoa (vilj2006_muok) ja tutki muuttujan "tilan gjan-
mukaisuus’ (=gjanmuk) jakaumaa.

9.5 Kahden muuttujan yhteyden tarkastelu

Kahden muuttujan yhteytta on jo tarkasteltu aiemmin sirontakuvioiden avulla, mutta nyt
otetaan kayttoon kuvien lisaks tilastolliset tunnusluvut.

Tarkasteltaessa muuttujien valisia yhteyksia seuraavassa esitettévien menetelmien avulla,
on hyvin oledllista etté kaikkia havaintoja voidaan pitda riippumattomina. Jos havaintojen
vdlilla esiintyy riippuvuuksia, muuttujien yhteyksien tarkastelut tulee tehda osaryhmittéin
siten, etté havainnot ovat osaryhman sisdllé riippumattomia. Esimerkkina toisistaan riippu-
vista havainnoista on tilanne, jossa kymmenelta lehmalta on mitattu sama ominaisuus ensin
tammikuussa ja sitten uudelleen helmikuussa. Néiden kahdenkymmenen havainnon kasit-
tely riippumattomina olisi virheellistd, koska molempina gjankohtina mittaukset on tehty
samoista eldimistéd. Niinpa yhteyden tarkastelu muuttujien ”X” ja”Y” vélilla tulee tehda
erikseen kummallekin kuukaudelle, koska kuukauden sisélla havainnot ovat peréisin eri
elamisté ja sen vuoksi niitd yleensa voidaan pitéa riippumattomina. On olemassa tilastolli-
sia menetelmid, joiden avulla voidaan ottaa huomioon riippuvuudet ja siten analysoida
koko aineisto yhdessa. Kyseisia menetelmid el kuitenkaan kasitell& tassi oppaassa.

9.5.1 Kahden numeerisen muuttujan valinen yhteys

Kahden numeerisen muuttujan valista yhteytta voidaan luonnehtia korrelaatiokertoimen
avulla. Tavallinen eli Pearsonin korrelaatiokerroin on kahden muuttujan lineaarisen yhtey-
den voimakkuuden ja suunnan mitta. Oletuksena Pearsonin korrelaatiokertoimen kaytolle
on se, ettd tarkasteltavien muuttujien yhteigakauma on kaksiulotteinen normaalijakauma
eli kdytéanndssa yhteyden lineaarisuus. Oletuksen voimassaoloa on kéteva tarkastella si-
rontakuvioiden avulla. Sirontakuviossa pisteparven tulee asettua ympyran tai litistyvan
ellipsin muotoon, jotta kaksiulotteinen normaalijakaumaoletus olis voimassa. Pitéa muis-
taa myods havaintojen riippumattomuusoletus €li sirontakuviot tulee piirtéa ja korrelaa-
tiokertoimet laskea erikseen riippumattomien havaintojen muodostamille osaryhmille. Jos
kaksiulotteinen normaalijakaumaoletus e ole realistinen, voidaan kayttéa epdparametrista
Spearmanin jarjestyskorrel aatiokerrointa, joka soveltuu myos jarjestysasteikollisten muut-
tujien yhteyden tutkimiseen. Riippumattomuusoletuksen liséksi korrelaatiokertoimia kay-
tettdessé on kuvasta syyta tarkastella poikkeavia havaintoja, jotka saattavat vaikuttaa
merkittévasti korrel aatiokertoimen suuruuteen.

Korrel aatiokertoimet saadaan Enterprise Guidesta valitsemalla kaytettava data aktiiviseksi
prosessidiagrammissa ja klikkaamalla ” Analyze” -> ”"Multivariate” -> " Correlations’,
jossa "Task Roles’ -vélilehdella méaritelléén muuttujien tehtavét. "Analysis variables’ -
kohtaan laitetaan muuttujat, joiden valista yhteytta tutkitaan. Vaihtoehtoisesti voidaan aset-
taa joku muuttuja” Analysis variables’ -kohtaan ja toiset ” Correlate with” -kohtaan. Muut-
tujat, jotka maarittelevat riippumattomia havaintoja siséltéavat osaryhmét, laitetaan kohtaan
"Group analysis by”.
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"Options’-valilehdella puolestaan mééritellaan kaytettavat korrelaatiokertoimet ja tehdadn
niihin liittyvia lisamaarityksi&
3

Correlations for VILJ2006_MUOK

Task Foles Options

Comelation tpes Pearson comelation options

Resultz

QOutput Data Pearson [] Cranbachk's coefficient alpha
Titles [ Hoefiding [ Covariances
[ Kendall [ Sums of squares and cross products

W
Spearman [ Carected sums of squares and cross products

[ Suppress Pearson comelations from results

Divizor for wanance:

Valittavana ovat muun mu-
assa Pearsonin ja Spearma
nin korrel aatiokertoimet.

| Degrees of freedom -

[ Oimwit rawes with missing values for variables being comelated

The zelection pane enables you to choose different sets of options for the task.

AN B
Bun ” Save ] ’ Cancel ] [ Help

"Results’-valilehdell& voidaan valita muun muassa sirontakuviot mukaan tul ostukseen:

X

Correlations for VILJ2006_MUOK

Task Roles Results
Optiar
sults Plots Results to display
QOutput Data Shaow statistics for 2ach variable
Titles Show zignificance probabilities associated with comrelations

Create & scatter plot for sach [ Show comelations in decreasing order of magnitude

relation pair

_ Valitaan sirontakuviot tulos-
Summary of comelations to calculate .
tettavaksi.

Murnber of variables to comelate:

Total corelations to be calculated:

Tama on olennaista, jos muut-
tujien yhteigakaumaa e ole
tutkittu aiemmin.

MHumber of plots to generate:;

The zelection pane enables you to choose different sets of options for the task.

AN B
Bun ” Save ] ’ Cancel ] [ Help
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"Output Data” -valilehdella voidaan valita tulokset tulostettavaksi SAS-dataksi. Kun pai-
netaan lopuks "Run”, saadaan tuloksena sukupuolittain seuraavat sirontakuviot (kopioitu
leikepbydan kautta Wordiin):

"Miehet”:
paino
130 1
120 *
1104
100
90 1
80 1
70 Havaintojen  voi-
daan gjatella sijoit-
B0 o
tuvan elipsin
£ 4 sisdle molemmilla
T T T T sukupuolilla, joten
160 170 180 190 Pearsonin  Korre-
pituus | aatiokertoimen
aineistoa koskevat
"Naiset”: oletukset tayttyvat.
paino
100
90 1
a0
70
B0
ol
40
| | | | I | |
150 155 160 165 170 175 180
pituus
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K orrel aatiokerroin miehille:

Pearson Correlation Coefficients, N = 42
Prob > |r| under HO: Rho=0
paino pituus
paino 1.00000 0.40783
paino 0.0073
pituus 0.40783 1.00000
pituus 0.0073

Korrelaatiokerroin naisille:

Pearson Correlation Coefficients, N = 11
Prob > |r| under HO: Rho=0

paino pituus
paino 1.00000 0.64712
paino 0.0314
pituus 0.64712 1.00000
pituus 0.0314

Painon ja pituuden vailla nayttda odotetusti olevan positiivinen lineaarinen yhteys kum-
mallakin sukupuolella. Y hteyden suunta (positiivinen tai negatiivinen) ndhdaéan korrelaa-
tiokertoimen etumerkistéd. Luku korrelaatiokertoimen alla taulukossa on p-arvo testille,
jonka nollahypoteesi on, ettd korrelaatiokerroin on nolla. Pieni p-arvo tarkoittaa, etta kor-
relaatiokerroin poikkeaa tilastollisesti merkitsevasti nollasta. Yla olevista tuloksista nékee,
miten paljon havaintom&&ré vaikuttaa p-arvoon. Miesten ryhmalla korrelaatiokerroin on
pienempi kuin naisilla, mutta silti p-arvo on selvasti pienempi. Tama johtuu siita, etté mie-
hilla havaintoja on selvasti enemman. Korrelaatiokerroin vaihtelee miinus yhdesta plus
yhteen. Korrelaatiokertoimen ollessa -1 kaikki havainnot ovat laskevalla suoralla ja ker-
toimen ollessa 1 havainnot ovat nousevalla suoralla. Korrelaatiokertoimen itseisarvo pie-
nenee sitd mukaa, kun havaintojen poikkeama suoralta kasvaa. Kertoimen suuruuden
k&ytannon merkittavyyden tulkintaan ei ole olemassa selkedtd sdant6d. Tulkinta vaihtelee
ilmién mukaan, ja eri asioissa kaytetdankin erisuuruisia raja-arvoja merkittévalle korrelaa-
tiolle.

Jos haluttaisiin esimerkiksi tietdd, kuinka paljon kymmenen sentin lisdys pituudessa kes-
kim&&rin nostaa painoa, vastaus saataisiin sovittamalla aineistoon suora ja maéraamalla sen
kulmakerroin. Tahan asiaan e siis saada vastausta korrel aatiokertoimen avulla. My6s suo-
ran ja yleissmmin regressiomallien sovitus onnistuu Enterprise Guidella. Lisdtietoa asiasta
|6ytyy muun muassa kirjasta Helenius & Katgjisto (2005).

Tehtdva: Kayta Viljelija 2006 -aineistoa (vilj2006_muok) tutkiaksesi painon ja pituuden
yhteytta sukupuolittain.

88



9.5.2 Kahden kategorisen muuttujan valinen yhteys

Kahden kategorisen muuttujan vélista yhteytté voidaan tarkastella muun muassa ristiin-
taulukoinnin ja Khiin neli6 -testin avulla. Samoin kuin korrel aatiokertoimien maérittami-
nen Khiin neli¢ -testi edellyttda kaikkien havaintojen riippumattomuutta. Liséks Khiin
nelio -testin vaatimukset otoskoon suhteen ovat seuraavat: 1) korkeintaan 20 % odotetuista
solufrekvensseisté saa olla pienempia kuin viis ja 2) kaikkien odotettujen solufrekvenssien
pitéa olla suurempia kuin yksi. Jos oletukset otoskoon suhteen eivét ole aineistossa voi-
massa, EG tulostaa automaattisesti varoituksen tulostusikkunaan. Téallaisessa tilanteessa
voidaan yhdistéa luokkia tai korvata suurten otosten Khiin nelid -testi niin sanotulla tar-
kalla (exact) testilla.

SAS Enterprise Guiden tyokalu ristiintaulukointiin ja Khiin nelio -testin tekemiseen |6ytyy
klikkaamalla " Describe” -> " Table Analysis’, jolloin ensin aukesa " Task Roles’” -véli-
lehti. Kategoriset muuttujat, joiden yhteytta ollaan tutkimassa, sijoitetaan kohtaan " Table
variables’ ja mahdollinen aineiston osaryhmiin jakava muuttuja sijoitetaan kohtaan ” Group
analysis by”. " Tables’-vdlilehdella tehdaan tarkempi taulukon méérittely:

&= Table Analysis for VILJ2006_MUOK

Task Roles Tables
Cell Statistics Wariables pemmitted in table: Presvigw:
Table Statistics
Azzociation tulevais
Agreement K
Ordered Differences Kaytetta\/|$aol evat muut-
Trend Test . .. .. e
Computation Optiong tUJat nakyvat tm . kun =
Resls e niita el ole viela sijoitettu g
Table Stat Results taul UkkOOﬂ ®
Titles
Tables ta be generated: f
ajanmuk by tule _' - N = -
| Syplecttobeat Myuttujat raahataan hiirella paikalleen vasemmalla ole-
vasta laatikosta tdhén taulukkoon. "Table variables’ -
muuttujia voi olla kolmekin. Taléin kolmannen muuttu-

jan tasoille tulevat erilliset taulut, samanlaiset kuin kayt-
tamalla yhtd muuttujista kohdassa " Group analysis by”.
Jos kuitenkin halutaan tutkia kolmen muuttujan yhteytta

Tastd klikkaamalla
voit madrittda uuden [..J

taulun. tilastollisella testill, kaikkien muuttujien pitaa olla” Table
variables’ -kohdassa.
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Ristiintaulukon soluihin tul ostettavat luvut valitaan ” Cell Statistics’ -valilehdell&:

Table Analysis for YILJ2006_MUOK

Task Roles
Tables

Computation Optiong
Results

Cell Stat Results

Table Stat Results
Titles

Cell Statistics

Ayailable statistics

Cell frequencies

[] Cell percentages

Mizzing walue frequencies

[ Cell contribution to Pearson chi-zquare

[ Cell frequency devistion from expected

Table Staisti s o
3 ;SSDZI;:EZ [ Cumnulative column percentages Tassa on Va| Ittu-
Agreement Row percentages - riviprosentit
Ordered Differences [ Colurnn percentages - solufrekvenssit
Trend Test

puuttuvien havaintojen lu-

kumaara
odotetut solufrekvenssit

Expected cell frequency

[ Include percentages in the data set

The zelection pane enables pou to chooze different zetz of optionz for the task.

B ][ ]|

Cahicel ] [ Help

Erilaisiatilastollisatesteja voidaan valita” Association”-vélilehdell&:

able Analysis for VILJ2006_MUOK

Table Statistics > Association

Tazk Roles

Tables

Cell Statistics Tests of azsociation Measures of agzociation

Table Statistics ) Measur .. ..
o Cifspee st Oiredn - Syyrten otosten Khiin nelié -

a . t [Including Pearzon, likelihood ratio and <_Lahlesl_
greemen

tantel-Haenszel chi-square tests and
Fizher's exact best for 212 tables)

testit

Ordered Differehces

Trend Test
Computation Optiong Exact p-values Edel I T
= isiin tarkat p-arvot
Results . [ Risk dif p
Cell Stat Results Fisher's exact test for r # ¢ tables
Table Stat Resuls lativg

Tiles Fisherin tarkkatesti (rxc taulut)

Cochran-tantel-H aenszel statistics

Uze the Compotaton Ophone page o

[C] CMH statistics - ;
Set a time limit on the computation of exact

Score type: Table p-values

Select the score tppe for ChH statistics

The zelection pane enables pou to chooze different zetz of optionz for the task.

B ][ ]|

Cahicel ] [ Help
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"Resultsin” alla olevilla védlilehdilla puolestaan voidaan valita ristiintaulukko ja tilastollis-
ten testien tulokset gjettavaks SAS-dataksi. Painamalla” Run” saadaan tulostus:

Table of ajanmuk by tulevais

Ristiintaulukko ajanmuk (ajanmuk) tulevais(tulevais)
Frequen
Expectedcy\
Row Pct 1 2 3| Total
'S
6 3 0 9
%.2264 3.7358| 2.0377
66.67| 33.33| 0.00

4.6604 | 5.3962 | 2.9434
76.92| 23.08| 0.00

4.6604 | 5.3962 | 2.9434
7.69| 69.23| 23.08

5.0189| 5.8113| 3.1698
7.14| 42.86| 50.00

1.434| 1.6604 | 0.9057
25.00f 25.00| 50.00

Total 19 22 12 53

Suurten  otosten

Khiin nelic -testit. Statistics for Table of ajanmuk by tulevais

DF Value Praob
Chi-Square 8 29.5438 0.0003
Likelihood Ratio Chi-Square 8 33.8016 <.0001
Mantel-Haenszel Chi-Square 1 18.5257 <.0001
Phi Coefficient 0.7466
Contingency Coefficient 0.5983
Cramer'sV 0.5279
WARNING: 73% of the cells have expected countslessthan 5.
< (Asymptotic) Chi-Square may not be a valid test.
/ Pear son Chi-Square Test
Suurten otosten | |chi-Square 29.5438
testien otoskoko-
. DF 8
oletukset  eivét
s Exact Pr>=Chisq 1.190E-04 \
Fisher's Exact Test Tarkat testit
” e
Table Probability (P) 3.035E-10
Pr<=P 6.012E-05

Tehtdva: Tutki Viljelija 2006 -aineistosta (vilj2006_muok) tilan gjanmukaisuuden (gjan-
muk) ja tulevaisuudenndkymien (tulevais) yhteytta ristiintaulukoinnin jatestien avulla.
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10 SAS-koodin kayttaminen

Erityisesti kokeneet SAS-kayttgjdt saattavat kokea hyodylliseksi mahdollisuuden kayttda
SAS-koodia Enterprise Guidessa valikkotoimintojen lisdksi. Myds uusille kayttgjille joi-
denkin toimintojen suorittaminen voi olla katevinta koodin avulla. Enterprise Guiden va
likkok&aytdssd on myds omat rajoituksensa, joten tavalisen SASin monipuolisempien
ominaisuuksien hyddyntaminen Enterprise Guidessa voi edellyttéd koodin kéyttoa.

Koodin kayttoon liittyvia asetuksia voidaan muokata valitsemalla " Tools” -> " Options’ ->
"SAS Programs’.

10.1 Koodin Kkirjoittaminen Enterprise Guidessa tai tuominen
muualta

Koodin kirjoittaminen onnistuu EG:ssa koodi-ikkunassa. Uuden koodi-ikkunan saa avattua
valitsemalla” File” -> "New” -> " Code”. Koodi-ikkunat tulevat projektiin irrallisiksi ik-
kunoiksi, joissa esimerkiksi datoihin viitataan kirjastoviitteen avulla samoin kuin tavalli-
sessa SASissa. Koodi-ikkuna tallentuu automaattisesti projektin sisdlle, mutta jos se halu-
taan tallentaa erillisena tiedostona, tallennus onnistuu klikkaamalla hiiren oikealla
painikkeella koodisolmua prosessidiagrammissa ja valitsemalla ” Properties’. Avautuvassa
ikkunassa valitaan ” Save As’.

Vamis, essmerkiks tavallisessa SASissa tehty kooditiedosto (*.sas) voidaan myds avata
Enterprise Guideen. Tama onnistuu valitsemalla ” File” -> " Open” -> " Code” -> " L ocal
Computer” ja valitsemalla SAS-kooditiedosto tietokoneen jostakin hakemistosta. Koodi-
tiedosto e kuitenkaan automaattisesti tallennu projektin sisélle, vaan tietokoneen kansiossa
olevaan kooditiedostoon avataan nakyma (pikakuvake). Jos koodi halutaan sisallyttda pro-
jektiin, voidaan klikata koodisolmua hiiren oikealla painikkeella ja valita " Properties’.
Avautuvassa ikkunassa valitaan " Embed”.

SAS-koodia voi myds kétevasti liikutella leikepdydan kautta esimerkiks tavallisen SASin,
EG:n jaWordin valilla Tama onnistuu maalaamalla ensin kopioitava koodinpétka hiirella
javalitsemalla " Edit”/”Muokkaa’ -> " Copy”/”Kopioi”, mink& jalkeen menndan kohdeoh-
jelmaan javalitaan sielld” Edit”/”Muokkaa’ -> " Paste” /" Liitd".

Jos Enterprise Guidessa tehdaén kuvia koodin avulla, saattaa vastaan tulla tilanne, jossa
koodissa tehtévat asetukset eivét valttamatta vaikuta valmiiseen kuvaan. Tahdn saattaa
auttaa kuvatyypin vaihtaminen joksikin muuks kuin oletuksena oleva ActiveX. Esimer-
kiksi symbol-lausetta kaytettdessa ActiveX ohittaa koodissa annetut maarittelyt.

10.2 Koodin generoiminen Enterprise Guidessa

Kaikki Enterprise Guiden tyokalut luovat koodia samalla, kun hiirella tehdéén valintoja
Enterprise Guide |8hettéd automaattisesti koodit SASIn suoritettavaksi, ja tulokset ndyte-
téén Enterprise Guidessa. Kaikki toiminnot EG:ssa perustuvat siis pohjimmiltaan SAS-
koodeihin, joita voidaan tarkastella ja muokata omiin tarkoituksiin.

Vamiista tehtdvasolmusta saa sen luoman SAS-koodin tarkasteltavaks klikkaamalla sol-
mua hiiren oikealla painikkeella ja valitsemalla ” Open Last Submitted Code”. Talldin ruu-
dulle aukeaa SASista tuttu koodieditori, josta 16ytyy tehtdvan kayttama SAS-koodi. Jos
koodia yrittéd muokata, EG ilmoittaa, ettd koodi on suojattu ja editointia varten pitda tehda
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kopio koodista. "Kyll&’-valinnalla koodi aukeaa uuteen editori-ikkunaan, jossa sité voi-
daan muokata. Vaihtoehtoisesti voidaan valita ”Open Last Submitted Code” -vaihtoehdon
sijaan "Add as Code Template’, jolloin EG tekee koodista suoraan muokattavan kopion.
Taman ominaisuuden avulla voidaan esimerkiks luoda koodipohjia ja kéyttéa niita tavalli-
sessa SASissa.

Koodia voidaan my0s tarkastella tehtdvan méérittelyn ollessa viela kesken. Useimmissa
tehtavanmaarittelyikkunoissa 16ytyy vasemmasta alakulmasta ruutu " Preview code”. Téta
klikkaamalla saadaan siihen asti tehdyill& valinnoilla generoitu koodi esikatseluikkunaan.
Klikkaamalla "Insert code” paasee koodin muokkaustilaan. EG tarjoaa mahdollisuuden
lisaté tiettyihin kohtiin omia koodinpétki&d. Koko koodia ei kuitenkaan padase talla keinolla
muokkaamaan.

Koodin tarkastelu jalkikéateen tai esikatselun avulla on kéyttokelpoista myos silloin, jos
halutaan varmistaa, milla menetelmilla EG toteuttaa jonkin toimenpiteen. Koodista voi
tarkistaa EG:n kayttdman menetelman tai valinnan (eli avainsanan koodissa) ja hakea "ta-
vallisen” SASIin manuaalista tarkemman selityksen kyseiselle asialle. Tahdn manuaaliin
padasee kasiksi muun muassa Enterprise Guiden ohjeen haku-toiminnolla.

10.3 Koodin tallentaminen SAS-kooditiedostoon

SAS-kooditiedosto voidaan tallentaa tietokoneelle omana tiedostonaan klikkaamalla koo-
disolmua hiiren oikealla painikkeella ja valitsemalla ” Export” -> " Export Code For tehta-
van _nimi” tai "Save Code For tehtavan _nimi As’. Erona nadiden tallennustapojen vdlilla
on, ettd "Export”-tavalla projektiin sisallytetty koodisolmu (embedded) séilyy sisdllytet-
tyna tallennuksen jalkeenkin, kun taas ”Save AS’ -tavalla koodisolmu muuttuu viittauk-
seksi tietokoneen kansioon tallennettuun kooditiedostoon. Jos EG:ssa luotua koodia el
tallenneta erikseen, se tallentuu kuitenkin projektin mukana. Silloin siitd e kuitenkaan tule
erillistd SAS-kooditiedostoa

Jos halutaan tallentaa samanaikaisesti useamman koodi-ikkunan sisdltéma tai tehtavien
luoma koodi samaan SA S-kooditiedostoon, se onnistuu valitsemalla” File” -> " Export” -
> " Export All Code”. Tall6in aukeaa seuraava ikkuna:

& Export All Code

Export to file:
CADocuments and Settingshlst100%0mat tiedostot\EG41_kurssi_Project. sas
Lode available for expart: Code preview:
Azzign Library Preview &l Selected  Preview of One-way Frequencies |
[rata Set Attributes =
Import Data /F e
Query for KIRGOMEZ_DATAS Code exported from SAS Enter
Buery for GOMEZ_MUDK DAETE: T
V] Impart Dat et . . .
o rrosscT{ Tassa ikkunassa voidaan siis valita
|mponnata FROJECT | yseampia koodi-ikkunoita tai tehta
Create Format [lohkof - Locall | | @ ———————1 . . .
Stack Columns vien luomia koodeja tallennettavak-
Query for Stacked ECLIBOOO.KETUTD g samaan kOOdltl ajogoon Llﬁks
Line Plat X . "
Line Flot /+ cond{ koodgja voi tarkastella esikatse-
< > /* It ti Juikkunassa ja tehda lisamaarityk-
¢ da
Include headers
Include generated wiapper code
Include cugtom 545 code from the Tools --» Options
dialog E=port ] [ Cancel ] [ Help
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11 Tulostuksen ja projektin hallintaa

Tassa kappaleessa on esitetty yleisia asioita, jotka patevét Enterprise Guideen ja sen mo-
niin eri tyokaluihin. Esitystapa on hieman erilainen kuin aiemmissa kappaleissa. Asiat on
pyritty ilmaisemaan hieman tiiviimmin ja listamaisemmin kuin aiemmin, jotta kappal eesta
olis helppo hakea ratkai suja Enterprise Guiden yleiskdytdssa ilmeneviin ongelmiin.

11.1 Tulostusasetukset

Monia asioita, mukaan lukien erilaisia tulostukseen liittyvia méaérityksid, voidaan EG:ssa
séddella asetusvalikosta. Asetuksiin pdasee kasiks valitsemalla " Tools” -> " Options’.
Asetukset voidaan palauttaa ol etusasetuksiks klikkaamalla” Tools” -> " Options’ ja” Reset
All”.

11.1.1 Tulostuskohteen valinta

Tulostuskohteella tarkoitetaan tul ostusdokumentin tiedostomuotoa. Tulostus voidaan tehda
HTML-, RTF-, PDF-, SAS Report- ja Text-muodossa. HTML on tiedosto, joka voidaan
avata internet-selaimella. RTF aukeaa Wordissa, PDF Acrobat Readerilla ja Text on teks-
timuotoista tulostusta, jonka voi avata vaikka Notepadilla (Muistio). Yksittéisistd SAS Re-
port -tulosteista puolestaan voi koota oman SAS raportin ("File” -> "New” -> "Report”).
RTF:lla tehtya tulostetta on melko kéeva muokata Wordissa. PDF-tul ostetta sen sijaan ei
pédse kovin helposti muokkaamaan, mika saattaa olla etu joissakin tilanteissa. Kaikki tu-
lostuskohteet aukeavat tietysti Enterprise Guidessa. Tulostuskohdetta paéasee vaihtamaan
klikkaamalla " Tools” -> " Options’ -> " Results General”. Tulostus voidaan ohjata yh-
teen tai useampaan kohteeseen. Ohjelma, jolla tulostus avataan, voidaan puolestaan valita
"Viewer”-vélilehdelta

Kuvien tulostus ohjautuu samalla tavala johonkin edelld mainituista tulostuskohteista
(paits "Text”, joka e kay kuville), mutta liséksi voidaan valita kuvatyyppi. Kuva siis tal-
lentuu jollain kuvatyypill&a jonkin edella mainitun tallennuskohteen tyyppiseen tiedostoon.
Kuvatyyppid pédsee vaihtamaan valitsemalla "Tools’ -> "Options’ -> ”Graph”, jolloin
"Graph Format” -valikosta voidaan valita joku seuraavista tyypeista:

- ActiveX (oletus)
- Java
- GIF
- JPEG
- ActiveX image (SASV9)
- Javaimage (SASV9)
- SASEMF (SASVY9)
Yleensa kannattaa kayttéd oletuksena olevaa ActiveX-kuvatyyppid, jolloin kéytdssa ovat

monipuoliset kuvan muokkausominaisuudet. Esimerkiksi paperille tulostettaessa myos
ActiveX image (SASV9) -kuvatyyppi on kuitenkin kayttokel poinen.

11.1.2 Tulostustyylin valinta

Tulostustyylilla tarkoitetaan tulosteen taulujen ja taustan graafista ulkoasua. Tulostustyy-
lilla voidaan vaikuttaa tulosteen vareihin, fontteihin ja asetteluun. Tulostustyyli perustuu
aina johonkin tyylipohjaan, joita EG:sta 10ytyy useita. Oman tyylipohjan voi tehda helpoi-
ten muokkaamalla jotakin EG:n valmista pohjaa. Muokatulla tyylipohjalla voi luoda kuvia
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tai taulukoita, jotka ovat ulkoasun puolesta sellaisenaan kelvollisia esimerkiks julkaisui-
hin.

Oletuksena olevan tulostustyylin voi vaihtaa toiseksi valitsemalla” Tools” -> " Options’ ja
kaytossa olevan tulostuskohteen mukaan "HTML”-, "RTF” -, "PDF” - tai " SAS Report”
-vélilehden. " Text” -tul ostuskohteen tyylié sen sijaan e pysty muokkaamaan. Kaikista néis-
ta vélilehdista 10ytyy kohta " Style”, josta tulostustyylin voi vaihtaa. Hyvia vaihtoehtoisia

tulostustyyleja (mustavalkoisia) ovat ainakin " printer”, ”journal” ja” minimal”.

Oman tyylin p&dsee luomaan valitsemalla” Tools" -> " Style Manager”, jolloin aukeaa seu-
raavaikkuna:

o Style Manager B]

Style List: Presview of EGDefault: . veas

i : Uuden tyylin paasee luo-
& Locaon | URL___ A maan valitsemalla "Add",
i@ AMODefault  Built-in Style C:\Program F . . .
'-@'Anal_l,lsis Built-in Style C:\Prograrn F Jsas. ‘ En JOl lOI n OhJ el ma kysyy’ l UO-
T Astronarny Bvilt-in Style C:\Program F i daanko kokonaan uusi tyyl |
Q’ Barker Euilt-in Shyle C:5Program F va kayte[aanko olemassa
# BarrettzsBlue Built-in Style C:\Prograr F | | C h
¥ beige Built-in Style C:5Program F Olevaa tyy 1a ponjana
T blockPrint Built-in Style C:5Program F SA S
T brick Built-in Style C:AProgram F 7
@ brown Built-in Style C:\Program F- SAS Procedure Title
Tj,v Curve Built-in Style C:\Prograrn F
T d3d Built-in Style C:5Program F
T default Built-in Style C:5Proagram F Column 1 lumn 2 Column 3
xj’ Education Builtin Style C:\Program F Row ¥Data (Num) Data (Char)
B EG_Etalo tdy Style C:ADocumen . . s
EEG_Htalo My Style C:ADocumen Roy/2Data | Painamalla " Edit” paa-
,,i_'q Eg_miinilnka my gty:e E::gocumen see muokkaamaan valit-
B EG_Mikked y Style ADocumen GRA .
EEr Pikkin kA Shile L8 D acirnetn tua omaa tyyl I a

(vamiitatyylegja el pysty

Taalla voi myos valita oletus-
muokkaamaan).

tyylin painamalla ” Set as De-
fault”.

_

[ ak, ] [ Cancel ] [ Help
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Varsinainen tyylipohjan muokkaustytkalu (joka aukeaa " Edit”-valinnalla) nayttda seuraa-

vata

4 Style Editor

Click to zelect an element;

SAS System Title
SAS Procedure Title

1
Data Data .
(Mum) (Char)
Data Data
(Num) (Char)

GRAPH
RESULTS

SAS System Footnote

Active element:

Attributes for Bodw

Test | Borders | Images | Custom|

Selected fonts:

anial helvetica, zans-serif | Browse...
Tent zize: Tt shyle:

| -small w iHeguIal v |

Test color Background colaor:

. [ (%) Colar: L
Harizantal alignment:

E Diefault " () Transparent Background
Yertical alignment;

!Default w

[ Apply to Other Elements....

Prewiew of Baody:

[Body

[ eg ][ oeee |

Body J

Tadla voi muokata tyylipohjan ominaisuuksia, kuten

fonttia, fonttikokoa, tekstityylid, vérgjd, yms.

| Moare [F1]...

ok ] [ Cancel

)

A

11.1.3 Muut tulostusasetukset

Tulostukseen tulee oletusasetuksilla aina alaviite: ” Generated by the SAS System...”. T&
man alaviitteen voi vaihtaatoiseks tai poistaa kokonaan valitsemalla“Tools” -> “Options’
-> “Tasks’ -> “Tasks General” jamuuttamallasielta” Default footnote text for task output”
-kohtaa. Samalta vélilehdelta [6ytyy myds kohta, josta voi lisdta pysyvan otsikon tul ostuk-

seen.

Tyokaujen kayttdmien SAS-proseduurien nimet saa poistettua tulostuksesta. Tama onnis-
tuu myds “Tools” -> “Options” -> “Tasks’ -> “Tasks General” -vélilehdellg kun poiste-
taan merkintd kohdasta” Include SAS procedure titlesin results’.

96



11.2 Yksittaisen tulosteen hallinta ja jatkokaytto

Enterprise Guidessa voidaan muuttaa yleisasetusten lisaksi monia yksittéisen tulosteen
asetuksia. Tulosteita voidaan helposti my6s muokata ja siirtéd toisiin ohjelmiin. Seuraa-

11.2.1 Kohteen ja tyylin vaihtaminen yksittaiselle tulosteelle

Y ksittéiselle tulosteelle voidaan vaihtaa tul ostuskohdetta ja tulostustyylid, kun tulostuksen
tekeva tehtdvasolmu on jo olemassa prosessidiagrammissa. Asetuksia padstédn muokkaa-
maan painamalla tul ostuksen tuottavaa tehtévasol mua prosessidiagrammissa hiiren oikealla
painikkeellajavalitsemalla” Properties’ jasieltd” Results’:

Properties for Line Plot Laittamalla merkin tahan paésee muok-

kaamaan tulostuskohdetta, tulostustyy-
lidja kuvamuotoa.

Results

General

Farameters
Summary Oweride the preferences et in Toolz -» Oplions
Fezult Formats
HTHL Journal L
LIPDF pliter w
BTF Ritf w
[]545 Report Journal v
[]Text
Graph Format: Achive e’
Autornatically direct results back to SA5 Enterprize Guide
Tasté voidaan valita yks tai use- Reset Dptions

ampi tulostuskohde ja kullekin
niistd oma tulostustyyli. Lisaks
voidaan valita kuvamuoto.

at. “r'ou can alzo select a style fram the drop-down list.
The ztyle will be applied to the POF results for this task.

A | i Mare [F1]...

Ok, H Cancel ]

Taman jalkeen painetaan ”OK”. Tehtévasolmu pitéa suorittaa vield uudelleen, jotta muu-
tokset menevét tulosteeseen asti. Tdma onnistuu klikkaamalla tehtdvasolmua prosessidia-
grammissa hiiren oikealla painikkeellaja valitsemalla” Run tehtavan nimi”.
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11.2.2 Yksittaisen tulosteen tallentaminen tiedostoon

Y ksittéinen tuloste voidaan tallentaa tiedostoon klikkaamalla tulosteen kuvaketta hiiren
oikealla painikkeella prosessidiagrammissa ja valitsemalla " Export” -> "Export tulostus-
muoto — tyokalun nimi” -> "Local Computer”. Tall6in aukeaa ikkuna, josta voidaan valita
tallennettavalle tulostetiedostolle kansio ja nimi. Eri tulostuskohteet tallentuvat pédasiassa
Seuraavan tyyppisina tiedostoina:

HTML -> HTML-tiedosto (*.html)

RTF -> Rich Text Format -tiedosto (*.rtf)

PDF -> Portable Document Format -tiedosto (*.pdf)
SAS Report -> SAS Report -tiedosto (*.srx)

Text -> List-tiedosto (*.Ist) tai tekstitiedosto (*.txt)

Liséks on mahdollista tallentaa tuloste kayttden muita tiedostotyyppeja kuin yllamainitut.
Esimerkikss HTML-tulostus voidaan tallentaa Excel-tiedostoksi kirjoittamalla tiedoston
linen tapa, ja saattaa aiheuttaa ongelmia. Tulostus voi ndyttéa Exceliin avattuna erilaiselta
kuin EG:ss4, jamy0s desimaaliluvut voivat aiheuttaa ongelmia.

Klikattaessa tulostussolmua hiiren oikealla painikkeella " Export”-kohdasta 16ytyy myos
vaihtoehto ” Export tulostusmuoto — tydkalun nimi As A Step In Project”. Taman vaihtoeh-
don avulla tulosteen tallentaminen tiedostoksi saadaan pysyvaksi vaiheeks prosessi-
diagrammiin, jolloin se voidaan milloin tahansa toteuttaa helposti suorittamalla kyseinen
"Export File’ -tehtavasolmu.

Kuvan voi tallentaa joko edelld mainitulla tavalla koko tulosteen mukana tai yksittdisena
kuvatiedostona. Jalkimmainen tapa onnistuu siten, etté ensin avataan tyétilaan tuloste, jos-
sa kuva sijaitsee ja klikataan kuvan paall& hiiren oikealla painikkeella. Sen jakeen valitaan
"Save as’ ja aukeavasta ikkunasta tallennuskansio ja annetaan kuvatiedostolle nimi. Kay-
tettdvissa olevat tiedostomuodot maardytyvat sen mukaan, mika on valittu kuvatyypiksi
"Tools” ->"Options’ -> " Graph” -vélilehdella

11.2.3 Tulosteen tai datan siirtaminen toiseen ohjelmaan

Ensimmainen tapa siirtda tul ostus toiseen ohjelmaan (essim. Wordiin), on avata EG:ssé tal-
lennettu tiedosto (esim. *.rtf) kyseisessi ohjelmassa. Kuvatiedostoina tallennetut kuvat
puolestaan voidaan lisdta Wordiin kéyttéen Wordin toimintoa "Lisdd” -> "Kuva’ -> "Tie-
dostosta’.

Toisaalta Enterprise Guiden tulostus voidaan joko ohjata lahtokohtaisesti toiseen ohjel-
maan (" Tools” — "Options’ -> "Results’ -> "Viewer”) tai avata yksittéinen EG:ssa oleva
tulostussolmu muulla ohjelmalla. Y ksittdinen tulostussolmu voidaan avata toiseen ohjel-
maan klikkaamalla tulostussolmua hiiren oikealla painikkeella ja valitsemalla ” Open With
ohjelman nimi”. RTF-solmuissa téssa lukee yleensa (tietokoneen oletusohjelmista riip-
puen) “Microsoft Office Word”, PDF-solmuissa “Acrobat Reader” ja HTML-solmuissa
" Internet Explorer”.

Nopein tapa siirtéa datoja tai tulosteita toiseen ohjelmaan on klikata kyseista solmua hiiren
oikealla painikkeellajavalita” Send To”, minka jalkeen valitaan kohde. Y ks vaihtoehto on
"E-mail Recipient”, jolloin tuloste tai data menee suoraan uuden sdhkopostiviestin liitetie-
dostoksi. Tama toimii ainakin Outlook Expressin kanssa. ”Microsoft Word” ja ” Microsoft
Excel” -vaihtoehdot puolestaan avaavat kohteen Wordissa tai Excelissa. Tama”Send To” -
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toiminto toimii parhaiten datoilla. Tulosteilla kaikki kolme edella mainittua vaihtoehtoa
eivét ole aina valittavissa. Neljantena vaihtoehtona on ”E-mail Recipient as a Step in Pro-
ject”, jonka avulla sahkopostin lahetys saadaan pysyvaksi osaks projektikokonaisuutta.
Téata vaihtoehtoa kaytettéessa pitda sdhkopostiasetusten olla méaritettyna Enterprise Gui-
dessa.

Yksittadisia kuvia tai tulostustauluja voidaan myds siirtda toiseen ohjelmaan leikepdydan
kautta (" copy-paste’). Tama onnistuu joko klikkaamalla kohdetta hiiren oikealla painik-
keella EG:ssé ja valitsemalla "Copy” tai valitsemalla kohde aktiiviseksi ja klikkaamalla
"Edit -> "Copy”. Sen jalkeen mennaan toiseen ohjelmaan, jossa laitetaan kohdistin paik-
kaan, johon kopioitava objekti halutaan liittéa, ja valitaan "Muokkaa’ -> "Liitd" (tai " Edit”
-> "Paste). Erittéin kayttokelpoinen tapa siirtéa tulostusta Exceliin onkin yksinkertai sesti
kopioida RTF-muotoon tul ostettu yksittéinen taulukko leitkepdydan kautta Exceliin.

11.2.4 Valmiin kuvan muokkaaminen

EG:lla piirrettyd kuvaa voidaan muokata monin tavoin piirtdmisen jalkeen. Valikko muok-
kaustoi menpitei sta saadaan, kun klikataan kuvaa hiiren oikealla painikkeella:

iaraph Properties
iaraph Toolbar

Chark Type »
Data Options., ..
Skyle Editor. ..

Titles b=

Save fs..,

Copy L
Prink. ..

WA Y W

Wi k
Help 3

Suurin osa toimenpiteista 10ytyy " Graph Properties’ -kohdan alta, mutta muualtakin saat-
taa |0ytya tutustumisen arvoisia toimenpiteitad. ” Graph Properties’-kohdasta voidaan muun
muassa vaihtaa kuvan taustan tyylia kohdassa ” Style”. Talla voi tehda esimerkiks esityk-
siin nayttavia kuvia. Oikealla painikkeella aukeava valikko voi hieman vaihdella kuvan
mukaan. Kannattaa kuitenkin huomioida, ettd muokattaessa yllamainitun valikon kautta
valmista kuvaa, muutokset eivét tallennu projektin mukana. Muokattu kuva kannattaa siis
joko talentaa omaks kuvatiedostokseen (valitsemalla ylla olevassa kuvassa ndkyvasta
valikosta” Save As’) tai kopioida leikepdydan kautta talteen esimerkikst Wordiin (valitse-
malla yll& olevassa kuvassa nékyvasta valikosta " Copy”). Jos kuvatyyppina on ActiveX,
ylla ndkyva valikko aukeaa myds Internet Explorerissa klikattaessa kuvaa hiiren oikealla

edes EG:ta tai SASia. ActiveX-kuvaa voidaan editoida Internet Explorerissa koneella, jos-
sa on kayttojarjestelmana Windows. Java-kuvaa voidaan puolestaan muokata kaikissa in-
ternet-selaimissa, jotka tukevat Javaa.
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11.2.5 Selitetekstien ja formaattien lisddminen yksittaiselle tulosteelle

Tulosteessa esiintyville muuttujien nimille voidaan méaérittda selitetekstegja ja muuttujien
arvoille formaatteja liséamatta niité varsinaiseen kaytettdvaan dataan. Tama onnistuu tu-
losteen tuottavan tehtavan médrittelyssa. " Task Roles’ -vdlilehdell& klikataan kasiteltavan
muuttujan nimea hiiren oikealla painikkeella ja valitaan " Properties’. Tal6in aukeaa ik-
kuna, jossa voidaan méadarittéd kyseiselle muuttujalle seliteteksti ("Label”) tai formaatti
("Format” -> "Change”). Nain voidaan esimerkiksi formaatin avulla séédella desimaalien
méaréa tul osteessa.

11.2.6 Otsikoiden ja alaviitteiden muokkaaminen

Otsikoiden ja alaviitteiden muokkaaminen toimii samalla tavalla kaikissa EG:n teht&
vasolmuissa, jotka tuottavat tulosteita. Tehtévia muokatessa on mahdollista valita” Titles’-
vdlilehti, joka ndyttéa seuraavalta:

Line Plot for KETUT_NUM

Line Plat | Titles Poistamalla tama
Task Roles 1 A
Appearance Section: et fw merkl nta1 paaS'
Plots LBt L& 0etault text taan muokkaa-
|rterpalation: T
Axes and Ticks J Footfiote maan i
General oletustekstia.
Horizontal Auis o |
Vettical dis Tasta vditaan se
Wertical Right Auiz .
Horecrtalap, ok tulosteen 0519, Tekstin muokkaus tehdéén tassa
‘ertical Major Ticks J Onka tekstej a
Wertical Right Major Ticks ruudussa.
Horizontal Minor Ticks mUOkataan.
Wertical Minor Ticks
Wertical Right Minor Ticks
Reference Lines
General Feference Lines
Harizontal Lines
Vertical Lines
Horizontal Lines [Right dwis)
Legend
Chart Area Checked sections will be aenerated
bazed on cument tazk setingz.
B J( see [ cuen J[ e
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11.3 Yksittaisten tulosten kokoaminen yhteen

11.3.1 HTML dokumentti

Erillisista tulostussolmuista on helppoa koota yksi yhteinen www-dokumentti kayttamalla
Document Builderia. Document Builderin saa auki klikkaamalla " Tools’ -> ” Create
HTML Document”, jolloin aukeaa seuraava ikkuna:

‘8 Document Builder Dokumentin nimi

Create web documents thgk-€ontain only The results pou warl 10 zee. Select bdd' button to begin
building the document,

HTHL Title: "Add’-painikkeella saadaan liséttya
Dooument yksittaisia tulosteita dokumenttiin,

jolloin ne nakyvat oheisessa listassa. \
Document content: Nuolipainikkeen kautta dokumenttiin
Data Set attibutes (G voi |is8t& myds muistiinpanosolmuja fdd B
Line Plot [Generated o "Note” linkkeid ulkoisii dok
B ar Chart [Generated d ( oe. )_’ INKKEa ulkoisiin dol l.J'
Box Plot (Generated of mentteihin  ("Other documents’) ja

Pie Chart [Generated o erottimia (u Separator”).

Up

"Options’-kohdassa voi- "Remove’-painikkeella saadaan
daan vaihtaa tulostustyylia poistettua yksittdisd tulosteita
ja luoda dokumentille listasta. "Up’- ja “Down’-
sisdllysluettelo. painikkeilla ssadaan vaihdettua
tulosteiden jarjestystd muodostet-

tavassa dokumentissa.

Options
Document SE | G oefault

Table of Contents: | 5ide by side docurment A

Preview H ] H Cancel H Help

b
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Painettaessa " OK” dokumentista tulee projektiin oma kuvake (prosessidiagrammin omalle
"HTML Documents” -vélilehdelle), jota voidaan joko esikatsella (" Preview”) tai joka voi-
daan tallentaa HTM L -tiedostoksi (" Export”):

"=’ Publish...

Send To »

Delete

Rename

|+] Properties

11.3.2 SAS Raportti

portin, jossa voidaan yhdistella tulosteita, tekstid, ulkopuolelta tuotavia kuvia ja otsikoita
haluttuun muotoon. Uusi raporttipohja saadaan auki klikkaamalla " File” -> " New” ->
"Report”:

B Edit Report Contents g|
Select SAS items Report layout:
fll Bar Chart ~
& Summary Tables
|~ Line Plat A
Tassa nakyvat SAS Re- Tamé& an harjoitusraportki
port -muotoon tehdyt
tulosteet, joita voidaan = Reporttiin laitetta:
kayttaa raportissa. TP
Y ® - " vat objektit sijoi-
tellaan tahan
Naista pai- ruudukkoon. Ruu-
nikkeista Voi tuja voi yhdls_t_éé
tiin  lisata ylimmassa ruudus-
viksi sa nakyvistd neli-
tekstiobjekte- oista.
ja_ja_ulko
puolisia v
kuvia kuva- »
T T
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K oottua raporttia paésee tarkastelemaan painamalla” OK”:

| g@ Project Designer [& Report®

R = B PR "Page View” -painikkeella p&see
T tarkastelemaan raporttia sivutettu- _
i:z:: ;::;B Line Plot na. Bar C
Remove &l Page Bresks w0 T
0T N "Header & Footer” -painikkeella
. | Tasta valikosta voi poistaa sivun- p?(aksee _rnuc;lkka_irgt?{anséiport!ll_tot-

vaihdot raportista painamalla SIKKoa Jal‘(.. taelz\t/!'l" k‘.".l E'E[/t"'lstse 7
"Remove All Page Breaks’. Vali- {n?a; b'aéykt' aanko yt 'Slk ".",: en =
kon saa esille klikkaamalla " Edit |— ;0..33%,,1 'er;. omia otsikoita Jja

| Report” -painikkeen vieress ole- |o | aviltterta raportissa.

h | vaanuolenp&ta :

Edelliseen ikkunaan paasee takai- 7

sin painamalla " Edit Report Con- 1

tents’ tai suoraan ”Edit Report” - o — _

painiketta. T T Kuvia vol pienentad ja
5aTS | suurentea  ottamalla

: kulmasta kiinni ja ve-
. T = | tamdla

S y Table
paino

N Mean StdDev Median Q1 Q3
subiup tuotauun
1 1 30 83.07 1558 82.580 73.00 9200

Vamiin raportin voi tulostaa paperille tai 1ahettéé toiselle Enterprise Guiden kayttgjédlle
tiedostona. Wordiin ja Exceliin nédita raportteja saa siirrettyé ainoastaan kopioimalla leike-
pOydan kautta. Prosessidiagrammiin raportit tulevat kuvakkeina omalle SAS Reports -va

lilehdelle.

11.4 Projektin hallinta

Enterprise Guidessa kaikki tyo tallennetaan projekteina. Projekti koostuu toisiinsa liitty-
vistd datoista, toimenpiteistd, tulosteista, koodeista, log-tiedostoista ja muistiinpanoista.
Projektin avulla kokonaisuus pysyy jarjestyksessa, vaikka kaytettéisiin useita eri datoja eri
tehtavissa. Niinpa jalkikdteen pystyy katevasti esimerkiks selvittdmaan tarkalleen, mita
dataa on kaytetty mihinkin analyysiin. Projekteja voi olla auki kerrallaan vain yksi, mutta
samaan projektiin voidaan tehda useita prosessidiagrammin vélilehtia.

11.4.1 Projektin perustoiminnot
Uuden projektin luominen onnistuu valitsemalla” File” ->"New” -> " Project”.

Vanhan projektin avaaminen puolestaan onnistuu valitsemalla "File” -> "Open” -> " Pro-
ject” ->"Loca Computer” ja hakemalla projektitiedoston tietokoneelta.

Projekti tallennetaan valitsemalla "File” -> "Save Project As’ -> "Loca Computer” tai
"File” -> " Save Project”.
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Projektipuuhun (" Project Explorer -ikkuna’) tulostuu automaattisesti kaikista suoritetuista
tehtavista log-tiedostot ja kooditiedostot. Niinpa koodeja ja log-tiedostoja on kéteva tar-
kastella projektipuusta, vaikka muuten kayttdisi padasiassa prosessidiagrammia (" Project
Designer”). My0s prosessidiagrammiin on mahdollista valita kooditiedostojen ja log-tie-
dostojen tallennus muokkaamalla asetuksia " Tools” -> "Options” -> "Project Views’ -va
lilehdella.

Enterprise Guide -istunnon lopettaminen tehddan normaalisti klikkaamalla oikean ylakul-
man ruksipainiketta tai valitsemalla”File” -> "Exit”. Jos projektia ei ole tallennettu ennen
sulkemista, EG kysyy tallentamisesta suljettaessa. Jos taas projektissa on tehty véliaikaisa
SAS-datoja, EG varoittaa asiasta seuraavallailmoituksel la:

Close Project With Temporary Data

O Do you want to continue o cloze EGAT_kurzsi_Project?

Thiz project haz references to termporary data. “When the project iz saved and clozed, all references to tempaorary
data are zaved, but the temparary data will be deleted from the 545 Server. Click Show Detailz for more
inforrnation.

[] Show Details [ ] ] I Cancel I

Véliaikaiset SAS-datat havidvét tietokoneelta, kun EG suljetaan, ja edelld kuvattu varmis-
tus mahdollistaa palaamisen projektiin ja datojen tallentamisen pysyviks datoiks. Yleensa
véliaikaisia datoja el valttdmétta tarvitse tallentaa pysyvina datoina, jos ne on helppo luoda
takaisin kayttdon seuraavassa EG istunnossa suorittamalla tietyt tehtéavasolmut uudelleen.

11.4.2 Projektin pitaminen jarjestyksesséa

Prosessidiagrammissa on muutamia kaytannollisid ominaisuuksia projektin jarjestelmalli-
seen hallintaan. Ensinndkin prosessidiagrammissa voidaan solmuja jakaa useammalla eri
vdilehdelle. Uuden vélilehden saa avatuksi valitsemalla "File” -> "New” -> "Process
Flow”. Erillisille valilehdille on k&teva ryhmitella essimerkiks samaan projektiin kuuluvien
erillisten datojen analyysit. Lisdtyn véalilehden nimeé saa vaihdetuksi klikkaamalla sen ole-
tusnimen kohdalla hiiren oikealla painikkeella ja valitsemalla” Rename”.

Jarjestyksen yll&pitoa prosessidiagrammissa auttaa ennen kaikkea sinne tulostuvien kuvak-
keiden eli solmujen organisoiminen loogiseen jarjestykseen. Oletuksena Enterprise Gui-
prosessidiagrammissa. " Autoarrange” -toiminnon saa pois kaytosta klikkaamalla prosessi-
diagrammin tyhjassa kohdassa hiiren oikealla painikkeella ja klikkaamalla ” Autoarrange”,
jos sen kohdalla ndkyy valintamerkki. Taman jalkeen solmuja saa siirreltya ottamalla niista
hiirella kiinni ja raahaamalla ne uuteen paikkaan. Solmujen vdlilla olevat yhdysviivat ve-
nyvét sirrettéessa.

Prosessidiagrammin selkeyden kannalta on myos térkeétd, etta luotaessa SAS-datoja tehté
vasolmuissa, kiinnitetéan huomiota nimien valintaan ja tallennuskohteeseen. Kannattaa siis
tarkistaa, onko oletuskirjastoviitteen osoittama kansio hyvé kohde tallennukselle, ja tarvit-
taessa vaihtaa kirjastoviitettd. Samoin kannattaa aina valita luotavalle datalle looginen ni-
mi.

Joskus prosessidiagrammin j&sentamista helpottaa ylimaaréisten yhdysviivojen vetaminen
sellaisten diagrammissa olevien solmujen vdlille, joiden valilla yhdysviivaa e muuten ole.
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Tallainen linkitys onnistuu klikkaamalla ensimmaista linkitettdvaa solmua hiiren oikealla
painikkeella ja valitsemalla ”"Link solmun_nimi to”. Talloin aukeaa ikkuna, josta voidaan
valita toinen solmu, johon yhdysviiva vedetéan. Linkittaminen on kéyttokel poista esimer-
kiks SAS-koodisolmuja kaytettédessa, jolloin voidaan linkittda koodit niiden kayttémiin
SAS-datoihin (téllaisia linkkgja el automaattisesti synny). Toisaalta yhdysviivojen avulla
voidaan myo6s pakottaa solmut suoritettavaks tietyssa jarjestyksessa.

Prosessidiagrammin ndkymaa voi myos ”zoomata”’ eli 1dhentda tai loitontaa. Tama onnis-
tuu klikkaamalla prosessidiagrammin tyhj&a kohtaa hiiren oikealla painikkeella ja valitse-
malla” Zoom” -kohdasta pienennys- tai suurennusprosentin.

Projektin dokumentoinnissa kayttokelpoinen tytkalu on muistiinpano-solmu. Muistiin-
panosolmun saa lisdttya klikkaamalla”File” -> "New” -> "Note”. Jos samalla on valittuna
esimerkiksi joku tehtéavasolmu, muistiinpanosolmu yhdistyy siihen yhdysviivalla. Muis-
tiinpanosolmut voivat kuitenkin olla myds irrallisina projektissa. Muistiinpanosolmuun voi
Kirjoittaa mité vain, ja solmut tallentuvat projektin mukana pysyviksi muistiinpanoiksi pro-
jektista. Tata ominaisuutta kayttamalla projektiin palaaminen pitkdn gjan kuluttua hel-
pottuu.

Enterprise Guiden versiossa 4.1 on uutena ominaisuutena mahdollisuus keréta kaikki pro-
jektin logit yhdeks kokonaisuudeksi. Tama ominaisuus vastaa tavallisen SASin log-ikku-
naa, johon kertyy tieto kaikista suoritetuista koodeista seka niiden suoritukseen liittyvista
ilmoituksista mukaan lukien virheilmoitukset. Enterprise Guidessa ikkunaan kertyy tieto
kaikkien suoritettujen tehtéavasolmujen taustalla olevista SAS-koodeista ja niihin liittyvista
ilmoituksista seka tietysti vastaavat tiedot tavallisen SAS-koodin suorittamisesta. Enter-
prise Guidessa koodin kerryttaminen log-ikkunaan pitéa kuitenkin ensin kytkea toi mintaan.
Tama padastdan tekemaan klikkaamalla hiiren oikealla painikkeella projektipuussa (" Project
Explorer”) ylimmaisena olevaa projektikuvaketta ja aukeavasta valikosta ” Properties’ ->
"Project Log”. Tall6in aukeaa seuraava ikkuna:

& Properties for EG41_kurssi_Project . -
e oP = == Logien kerryttéminen kyt-

ketddn padlle laittamalla
merkki kohtaan "Maintain
project log”.

Surmmary Project Log

Securty

[ Clear Log ]

[ Export Log ]

Logien kerryttdminen
voidaan my6s nollata
("Clear Log”) tai ker-
tyneet logit voidaan
tallentaa tekstitiedos-
toks ("Export Log”).

[ (]9 l[ Cancel ]
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Logien tallentamisen lisdksi niita voidaan tarkastella myds log-ikkunasta, joka saadaan
auki klikkaamalla "View” -> "Project Log”. Talo6in tydtilaan aukeaa oma Project Log -
vdlilehti, johon kertyy tietoa tehtdvasolmujen tai koodien suorittamisesta.

11.4.3 Tehtavasolmujen kasittely

Projektissa olevan tehtavasolmun voi suorittaa klikkaamalla sitd hiiren oikealla painik-
keella ja valitsemalla ”Run This Task”. Tehtéavan suoritus onnistuu myos valitsemalla ky-
seinen solmu aktiiviseksi prosessidiagrammissa ja klikkaamalla tydkalurivissa olevaa
vihreda " Play-nappulaa’. Kolmas vaihtoehto on tuplaklikata tehtévasolmu muokkaustilaan
ja suorittaa se kuten uudet tehtéavasolmut. Tehtévan suorituksen pysayttdminen puolestaan
onnistuu klikkaamalla tyokalurivissa olevaa punaista ” Stop-nappulaa’. Edell& mainittujen
tapojen lisaksi tehtévien suorittaminen ja suorituksen pysayttaminen onnistuu myds ” Co-
de”-valikon kautta. Virhe tehtavasolmun suorittamisessa ndkyy siten, etta prosessidia-
grammissa olevaan tehtévakuvakkeeseen tulee pieni punainen ruks ja tehtavaan liittyva
log-ikkuna aukeaa. Log-ikkunasta 16ytyy télloin punaisella merkitty virhellmoitus, josta
yleensd |6ytyy virheen syy. Pienemmista rikkeista tehtavasolmun kuvakkeeseen tulee kel-
taisella pohjala oleva huutomerkki. Nama huutomerkit eivét yleensa viittaa mihinkaan
merkittavadn virheeseen, mutta ainakin jos tehtévan tulos e ole looginen, asia kannattaa
tarkistaa logista (esim. projektipuun kautta).

Y ksittéisten tehtéavasolmujen suorittamisen lisdksi voidaan suorittaa my®s useampi tehté-
vasolmu kerrallaan. Kayttga voi suorittaa kaikki samalla prosessidiagrammin vélilehdella
olevat tehtavasolmut klikkaamalla hiiren oikealla painikkeella jossakin tyhjéssa prosessi-
tietyn tehtavasolmun ja kaikki sen perdan yhdysviivoilla yhdistetyt tehtavasolmut klikkaa-
malla ensimmaéista solmua hiiren oikealla painikkeella ja valitsemalla " Run Branch From
tehtavasolmun nimi”.

Kuten edelld jo mainittiin, projektissa jo olevia valmiita tehtévasolmuja paasee muokkaa-
maan jalkikateen tuplaklikkaamalla solmua (tehtéavan suorittavaa solmua, ei tulostussol-
mua) prosessidiagrammissa tai klikkaamalla solmua hiiren oikealla painikkeella ja
valitsemalla "Open”. Muokkausten jalkeen solmun voi suorittaa uudelleen valitsemalla
"Run”. Taloin EG kysyy, halutaanko korvata edellisen suorituksen tulokset. Jos vastataan
"Kyll&’", tehdyt muutokset j8avét tehtévasolmuun ja uudet tulokset ajetaan vanhojen pélle.
Jos taas vastataan "Ei”, EG tekee uuden teht&vésolmun ja uuden tulostussolmun, jolloin
vanhat tehtévéa- ja tulostussolmut javét koskemattomiksi.

MyGs tehtdvasolmun kayttdmaa dataa voidaan vaihtaa. Tama on tarpeellista esimerkiksi
silloin, kun tuodaan kokonaan uusi data projektiin ja sille halutaan tehda monia toiselle
datalle aiemmin mé&ariteltyja toimenpiteitd. Taloin data ikdan kuin asetetaan "ketjun al-
kuun”. Datan vaihtaminen onnistuu klikkaamalla hiiren oikealla painikkeella tehtévasol-
mua, jolle halutaan uus data k&yttoon, ja valitsemalla ” Select Input Data” ja siita haluttu,
projektissa mukana oleva data. Query Builder -tehtdvasolmuille dataa e voi vaihtaa téla
keinolla.

Tehtdvasolmun nimea voi myds muuttaa. Tasta voi olla apua projektin dokumentoinnissa
tulevaa kayttoa varten. Solmun nimeé paésee muokkaamaan klikkaamalla solmua hitaasti
kahdesti tai klikkaamalla solmua hiiren oikealla painikkeellajavalitsemalla” Rename”.

Turhan tehtdvasolmun voi poistaa. Tama onnistuu valitsemalla solmu aktiiviseks ja pai-
namalla " Delete”-ndppéinta tai klikkaamalla solmua hiiren oikealla painikkeella ja valit-
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semalla” Delete”. Kun solmu poistetaan, samalla poistuu sen peréssa olevia, siihen liittyvia
muita solmuja. Kun esimerkiksi poistetaan sirontakuvion tuottava tehtévasolmu, samalla
poistuu siihen liittyvét tulostussolmu, koodisolmu jalog-solmu.

Koko projekti voidaan myos maarata suoritettavaks ajastuksen avulla. Ajastustyokalu 16y-
tyy klikkaamalla "Tools” -> ”Schedule Project”. ”"Create Ordered List” -tydkalulla voi
puolestaan suorittaa useamman projektissa olevan tehtévasolmun halutussa jérjestyksessa.
Tyokalussa valitaan projektissa olevia tehtavia listaan ja tuloksena syntyy " Ordered List” -
tehtavasolmu. Listaan valitut tehtavédt voidaan taman jalkeen suorittaa helposti sarjassa
suorittamalla kyseinen ”"Ordered List” -tehtdvasolmu. Téman tytkalun saa kayttéon klik-
kaamalla”Tools’ -> " Create Ordered List”.

11.5 Makromuuttujat (Parameters)

Makromuuttujien avulla pystytaan liséémaan uusia ulottuvuuksia Enterprise Guiden tehté
vasolmujen kayttdmiseen. Esimerkiks osaryhmittdin keskiarvoja laskevassa tehtévasol-
mussa Vvoitaisiin  korvata seka analysoitava muuttuja ettd ryhmitteleva muuttuja
vasolmun suorituksen yhteydessd. Talloin kerran méaritellylla tehtavasolmulla saataisiin
laskettua keskiarvoja kdyttden monia eri muuttujia. Suoritettaessa makromuuttujia siséltéva
jan médrittelyn yhteydessa antama kysymys ja annetaan tietyt vastausvaihtoehdot, jotka
ovat makromuuttujan mahdollisia arvoja. Arvot voivat olla essimerkiksi muuttujien nimia,
doista valitsemalla arvolla. Makromuuttujien avulla voidaan siis rakentaa eréanlaisia ali-
ohjelmia, jolloin yhdella tehtavasolmulla saadaan suoritetuks useita tehtavia
Makromuuttujia voidaan kayttéd muun muassa jonkin tehtavasolmun kayttamien muuttu-
jien magrittelyyn tai Query Builderissa aineiston osa-aineistoiks jakavan ehdon méadritte-
lyyn.

11.5.1 Makromuuttujien maarittely

Makromuuttujia pdastéan maarittelemaan valitsemalla " Tools” -> " Parameter (Macro
Variable) Manager”. Tall6in aukeaa seuraava ikkuna

&3 Parameters (Macro Variables) Manager @

SAS Mame Dizplay Mame Data Type Default alue Uszed By

Tassd ikkunassa nékyy lista méaritetyista
makromuuttujista.

Uutta makromuuttujaa pédsee méaritte-
lemd&&n klikkaamalla "Add’. Vanhaa
makromuuttujaa voi muokata valitsemal-
lasen aktiiviseks jaklikkaamalla” Edit”.

Add.. Cosze | [ Hep |
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Klikkaamalla” Add” paéstéén seuraavaan ikkunaan:

@ Add New Parameter &_]

General | Data Type and Yalues

Dizplay name:

|"-.-"a|it$e luokitteleva muuttuja

SAS code name:

| Ik rriat

"Display name” -kohtaan laitetaan kysymys tai
kehotus, joka tulee ruudulle, kun kayttgjalta ky-
sytdan makromuuttujan arvoa.

"SAS code name” -kohtaan puolestaan laitetaan
makromuuttujan nimi. Nimeen pétevat samat

rajoitukset kuin tavallisten muuttujien nimiin.

Description:

Walitaan luokitteleva muuttuja, kun ollaan fadeastalan

pakollinen).

Ahbalng OOE  oheoiob IToenz '

pirbimsn!! i ml |

"Description”-kohdassa voi antaa lisaselitysta
makromuuttuj asta.

Drata type:

String

String

Integer

Float

Date

D ate-Time
Time

“anable name

"Data type” -kohdassa méaritelld8n makromuuttujan mahdollisten arvojen
tyyppi. Valittavana ovat merkkijonot (" String”), kokonaisluvut (”Integer”),

desimaaliluvut ("Float”), erilaiset aika- ja pdivamaardarvot sekd muuttujien
nimet (”Variable name”).

[ Add and Mew ] [ Add and Cloge l [ Cancel ] [ Help ]

Edell& tehtyjen méaritysten liséks el ole pakko tehda muita méérityksia mutta jos makro-
muuttujalle halutaan méaérittda lista mahdollisia arvoja tai jokin mahdollisten arvojen vali,
se voidaan tehda vélilehdella " Data Type and Values’. Arvojen listatal arvovéli kannattaa
useimmiten maérittdd, koska se hel pottaa makromuuttujan mydhempaa kéyttoa.
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"Data Type and Values’ -vdlilehti ndyttéa seuraavalta:

"Data value type” -kohdassa on oletuksena valit- B3

tuna vaihtoehto, joka salii minka tahansa arvon
General | Data Type and "v"alu?(

makromuuttujale. Kun arvot ovat muuttujien ni-
D ata bype: mi&, vaihtoehtona on myds arvojen lista ("A list of

| Yariable name val ues”). ZI

D ata value tpe: /

A lizt of values

i ligk af walues

Anw vanable name value iz allowed

zukup [ Default swalue:
tuokzuun |
ajannik,
tulevaiz . .
< Click here to enter values » Wariable type:
1 H - . Fo
Projektissa olevasta datasta voidaan hakea muuttuji- ), Character

en nimia tahan mahdollisten arvojen listaan. Ensin | & Numeric

pitdd kuitenkin valita haettavien muuttujien tyyppi g?:ﬁ:
oheisesta”Variable type” -ikkunasta. Taman jalkeen &¥ Cunency
klikataan "Load Values' -> "Project” ja valitaan & Geography

aukeavasta ikkunasta data, jonka muuttujat halutaan
listaan. Taman jélkeen kannattaa poistaa mahdolliset
turhat muuttujien nimet listasta. Toinen vaihtoehto
antaa mahdollisia arvoja on klikata "Click here to
enter values’ -kohtaa ja sy6ttda arvot kasin.

p 4 Load Values-

[ Add and Mew ] [ Add and Cloge l [ Cancel ] [ Help ]

Lopuks painetaan "Add and Close” ja "Close”. Jos halutaan méarittéa heti uusi makro-
muuttuja, yll&a olevassa ikkunassa voidaan valita myos ” Add and New”.
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Kun makromuuttuja on méaéritelty, se on valmis kéaytettavaksi jossakin tehtavasolmussa tai
SAS-koodissa. Katsotaan kuitenkin ensin, miten numeroarvojen méaarittely makromuuttu-
jalle eroaa edella 1apikdydysta muuttujan nimi -arvojen maarittelysta. Liikkeelle léhdetdan
ihan samalla tavalla eli avataan Parameters Manager ja aletaan méaritella uutta makro-
muuttujaa. Uuden makromuuttujan méarittelyssa ” Genera” -vélilehdella toimitaan samoin
kuin edell&, mutta valitaan vain " Data type” -kohtaan esimerkiksi " Integer” eli kokonaislu-
vut makromuuttujan mahdollisks arvoiksi. Taloin "Data Type and Values’ -vdilehti
ndyttéa seuraavalta:

LR BRI » General”-valilehdell on mégritelty, eftd mak-

General| Data Type and Yalues | FOMuuttujan arvon valintaikkunassa pyydetaan
antamaan raja-arvo tuloille euroina. T&man mak-
Data type: romuuttujan avulla voidaan siis esimerkiksi méaa-
Integer rittéa tiettyd rgaa parempituloiset mukaan v
tutkittavaan dataan.

Drata value bype:

& range of value Lukuarvoilla on muut- e
tujan nimi -arvoihin

Walue range: oo Optians:
N verrattuna  lisavaih-
[+] Minimurn value; toehtona "A range of [#] Default values:

8000 values’, di niille voi- 30000

daan mérittda arvojen
M i+ alue: vali, jolta kayttgan [ ] A value iz beguired at runtime

valitsema arvo kel puu-
200000 tetaon makromuEttu- Prompt for value
Step: jan arvoksi.
1000

My6s oletusarvon
>\ voi vaita.

Kun on valittu ”A range of values’, téssa voi-
daan antaa arvovdlille minimi, maksimi ja por-

ainoastaan minimi- ja maksimiarvojen vdlilta.
Porrasarvo nakyy siten, ettd kayttgan tehdessa
valintaa makromuuttujan arvon valintaikkunassa,
nuolilla tehtavét lisdykset ja vahennykset ovat
porrasarvon suuruisia.

[ Save and Cloze ] [ Cancel ] [ Help ]

Lopuksi painetaan ” Save and Close” ja” Close’.

11.5.2 Makromuuttujien kayttaminen

Edella on kayty 18pi muutaman erilaisen makromuuttujan muodostaminen. Vamiita mak-
romuuttujia voidaan kayttdd muun muassa erilaisissa tulostusta tuottavissa tehtévasol-
muissa muuttujien valinnassa sekd Query Builderin "Filter Data’ -vdlilehdella osa
aineiston valintaan liittyvissa ehtolauseissa. Myds SAS-koodissa voidaan kayttéa makro-
muuttujia.
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Ensin kdydaan 18pi tilanne, jossa valitaan ryhmittelevd muuttuja makromuuttujan avulla.
Tata varten avataan ensin ” Summary Statistics’ -tyokalu siten, ettd Viljelija 2006 -aineisto
on aktiivisena:

Summary Statistics for VILJ2006_MUOK X

Task Roles
Statistics
Basic Yariables to assign: Taszk roles: Clags level lkmuut
Percentiles Mame Apalpsiz wariables Sort bu:
Additional : ika
Plats % Ir::mi & l%%Elssificatinn riables | Hrformated val.es hi |
Fiesults &5 Tkmuut
. @ sukup = .. .
Titles @ ) Frequency couly [tk Sort order:
- oa. Relative weight [Nt 1 |!—‘«scending v|
@ nautoja @ Copy variables
g tmeltsaa @ Group analysis by Mizsing values:
@ paing | Exclude “ |
@ !:ituus
%mt L aitetaan analysoitavaksi muuttu-
@ aiarmuk jaks tavalinen ika-muuttuja. Sen
gfs'e"atis sijaan ryhmittelevaks muuttujak-
\ s laitetaan nyt makromuuttuja
. o [kmuut, jonka mahdollisiks ar-
w;}ﬂ:lr: Sf;t\ienwei stl Ogarl:ﬁf voiks on edella maaritelty muu-
tuiien lisiks mves kéviet tamat ryhmitteleviks muuttujiksi
jren’ YOS Kayt soveltuvat aineiston muuttujat.
tavissa olevat W
an o makromuuttujat.
Bun ” Save ] [ Cahicel ] [ Help ]

Kun painetaan "Run”, aukeaa valintaikkuna, jossa pitéa valita mita makromuuttujan mah-
dollisista arvoista tassa tilanteessa kaytetaan:

Ei Select values for these parameters

%]

Walitze luokitteleva muuthuja

sukLp

tuatzuun

ajanmik.
tulevals

littain.

Valitaan esimerkiksi sukup ja painetaan ”"Run”, jol-
loin EG laskee ika-muuttujan tunnusluvut sukupuo-
Makromuuttujaa kayttava tehtévasolmu
voidaan suorittaa mychemmin uudelleen, ja makro-
muuttujalle voidaan valita jokaisella kerralla eri ar-
VO.

ySds.

[* denaotes required parameter]
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Toinen tilanne, jossa makromuuttujat ovat kayttokelpoisia, liittyy osa-aineiston valintaan.
Avataan ensin Query Builder siten, ettd kéytettava data on aktiivisena ja mennaan " Filter
Data’ -vélilehdelle. Raahataan " Filter Data” -vélilehdelle muuttuja, jonka arvoihin liittyva
makromuuttuja on aiemmin méaéritelty. Aukeavassa ikkunassa valitaan ensin ” Operator” -
kohdassa ehto eli esimerkiksi ” Greater than or equal to” ja sitten klikataan " Value’ -kohdan
padssa olevaa nuolta. Taloin aukeaa seuraava ikkuna, jonka ”Parameters’-vdlilehdella
voidaan méaarittéd makromuuttuja kaytettavaks ehtolauseessa:

Values Enlumns| Parameters |

Rkt

Ikkunassa nékyvéat kaikki pro-
jektissa maaritetyt makromuut-
tujat.

e |

Kun listasta valitaan makromuuttuja, EG palaa edelliseen ikkunaan, jossa nakyy makro-
muuttujan avulla mééritetty ehtolause:

i Edit Filter

Colurmn: WILJ2006_bUOE. tulot
Operatar: | [Greater than or equal o w |
Yalue: | &tuloraja |B

Ehtolauseessa méaritetédan
mukaan otettaviksi kaikki
Filter definition ne viljelijat (eli datan ri-
VILJ2006_MUOK. tulat >= &tulorsia | Vit), joiden tulot ovat suu-
rempiatal yhta suuriakuin

tuksen yhteydessa antama
[ | Enclose values in quotes tul oraj a

’ ] ” Cancel ” Help ]
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Lopuksi painetaan "OK” ja suoritetaan Query Builder normaalisti. Suorituksen yhteydessa
aukeaa seuraava ikkuna:

EX Select values for these parameters §|

Anna tulaille raja-arvo euroina |3EIEIEIEI :I

V astauskenttaan voi joko kirjoittaa haluamansa
rgja-arvon tai valita ragja-arvon kayttéen kentéan
jaljessa olevia nuolia. Painamalla "Run”, tu-
loksena saadaan SAS-data, johon on valittu
alkuperdisesta aineistosta ne rivit, joissa tulo-
muuttujan arvo on suurempi tai yhta suuri kuin
30000.

Jsas [ Bun H Cancel ]Aﬂ

SAS-koodia kaytettdessd makromuuttujiin viitataan niiden nimella silla lisdyksella, etta
nimen eteen tulee makromuuttujiin viittaava & -merkki. Samassa tehtévassa tai SAS-koo-
dissa voi myds kayttéd useampia makromuuttujia. Alla on esimerkki SAS-koodista, jossa
on kaytetty molempia edella maariteltyja makromuuttujia

Beo Project Designer | £33 VILJ2006_MUQK. [read-only] ] Code2”

“PROC MEANS DATA=kir.viljzZ006 muok;
WHERE tulot>x=&tuloraja;
CLASS &1kmuut;
VAR 1kas

RUN;

Ennen koodin suorittamista makromuuttujat pitda viela erikseen yhdistéa tahan koodiin,
koska ne on méaritelty muualla kuin tassi koodissa. Tama onnistuu klikkaamalla koo-
disolmua prosessidiagrammissa hiiren oikealla painikkeella ja valitsemalla " Properties’.
Taman jdlkeen menndan ” Parameters’-vdlilehdelle, klikataan " Add” ja valitaan kaytettavat
makromuuttujat. Kun muuttujat on valittu, ne nékyvét seuraavassa ikkunassa:
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& Properties for Code2 @

General Parameters
Results
Farameters i
Froject parameters uzed:
Summary
/m e Display Mame Data Type
[k rraLaat Walitze luokittelewa muuttuja W ariable name
tularaja Anna tulaille raja-area euroina |nteger
~
< |
Add... Parameter Manager... ]
Digzplayz the SA5 name, dizplay name, and data type of each parameter that you
have defined in the project.
<« | ] More [F1]...

ak. H Cancel ]

Sitten painetaan "OK” ja suoritetaan koodi, jolloin aukeaa makromuuttujien arvojen va-
lintaikkuna:

K4 Select values for these parameters

Walitze luokittelewa muutuja | A - | =

Anna tulaille raja-arvo euroina |35EIEIEI :I

Tala kertaa vaintaikkunassa on valittavana
kahden makromuuttujan arvo. Painamalla
"Run”, tuloksena saadaan tunnuslukutaulu,
joka on laskettu ehdon mukaan valituista ha-
vainnoista tuotantosuunnittain.

JSBSL [ Run H Cancel ] A
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11.6 Virhetilanteet

1) Enterprise Guiden selittamattomissa virhetilanteissa auttaa useimmiten ohjelman
sulkeminen ja uudelleenkdynnistaminen. Joskus taytyy kaynnistdd uudelleen koko
tietokone. Ennen sulkemista kannattaa tallentaa projektiin tehdyt muutokset, ja uu-
delleenkaynnistyksen jalkeen pitdd yhdistéa tarvittavat kirjastoviitteet uudelleen.

2) Apua Enterprise Guide -ongelmiin |6ytyy myds SASin teknisesta tuesta. Kannattaa
hakea apua http://support.sas.com -sivujen hakutoiminnolla

3) Asennuksen jalkeen kannattaa asentaa Enterprise Guiden uusin hotfix eli korjaus-
paketti, jonka saa SASIn teknisen tuen internet-sivuilta
(http://ftp.sas.com/techsup/download/hotfix/ent_guide.html). Tama paketti korjaa
monia perustoimenpiteissékin esiintyvia ohjelmavirheita

4) Téassa oppaassa mahdollisesti havaituista virheista voi 18hettéa palautetta kirjoitta-
jalle esimerkiksi séhkopostilla osoitteeseen timo.hurme@mitt.fi.
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